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Model 8180/81A

General Information

SECTION 1

GENERAL INFORMATION

I-1 INTRODUCTICN

This Operating Manual contains information
required to install, operate and test the Hewlett-
Packard Models 8180A and 8181A. (Service
related information 1s located in the correspond-
ing sections of the complete manual set).

Figures 1-1, 1-2, and 1~3 show the two main-
frames, the accessories supplied with each and
those available. This section covers instrument
identification, description, options, accessories,
specifications and other basic information.

1-2 SPECIFICATIONS

Instrument specifications for both the 8180A
and the B181A are listed in Table 1-2. These
specifications are the performance standards or
limits against which the instruments are tested.

1-3 SAFETY CONSIDERATIONS

The Models 81 80A and 8181 A are Safety Class
i ipstruments (instruments with an exposed
metal chassis that is directly connected to earth
via the power supply cablel.

Before operation, the instruments and manual,
including the red safety page, should be reviewed
for safety markings and instructions. These must
then be followed to ensure safe operation and to
maintain the instruments in a safe condition.

i-4 INSTRUMENTS COVERED BY THE

MANUAL

Attached to the rear of each instrument is a
serial number plate (Figure 1-4). The first four
digits of the serial number only change when
there is a significant change to the instrument.
The last five digits are assigned to instruments
sequentially. The contents of this manual apply
directly to the instrument serial number quoted
on the title page {or to all instruments if stated).
For instruments with higher serial numbers,
refer to the Manual Change sheets supplied with
this manual. In addition to change information,
the Manual Change sheets may contain informa-
tion for correcting any errors in the manual

To keep this manual as up-to-date and accurate
as possible, Hewlett~Packard recommends that
you periodically request the latest Manual
Change supplement. The supplement for this
manual is identified by a print date and part
number, both of which appear on title page.
Complimentary copies of the supplement are
available from Hewlett~-Packard.

HEWLETT- PACKARD GmbH

1536G 00062

BOBLINGEN ... .. ..

Figure 1-4. Serial Number Plate
1-5 DESCRIPTION

The 8180A/8181A is a modular, high speed
(50MHz) programmable data generator for the
stimulation of multi-channel digital circuits
The 8180A is a stand-alone data generator with
the cabability of controlling up to two 8181A
Data Generator Extenders. By combining the
8180A/8181A with the 3182A Data Analyzer a
complete  stimulus/response system for ac-

parametric hardware analysis of digital ICs -

boards and modules 15 realised. The 3180A/
8181A has an operating concept based around a
CRT and softkeys which is designed to simplify
operation. Programming over the HP-IB* is
straightforward since every parameter can be
directly accessed,

*Hewlett~Packard Interface Bus, Hewlett-
Packard’s implementation of IEEE Standard 488
"Standard Digital Interface for Programmable
Instrumentation.

-1
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General Information

A summary of the 8180A/8181A features is as
follows:

1Hz-50MHz data rate.
8~-64 NRZ~channels.

up to & RZ-channels and two clocks, all
with 100ps resolution for delay and width.

1 kbit memory/channel, non~-volatile

-2V to +17V into open (-2V to +5.5V into
50 Ohm with 10 mV resolution)

<3.5 ns transition times for TTL, typically
1.5 ns for ECL.

comfortable data pattern editing; con-
venient softkey operation

full HP-IB programmability.
Possible 8180A/8181A configurations:

The 8180A Data Generator contains up to 16
data channels. A data channel extension pos~
sibility is provided by adding up to two 8181A
Dats Generator Extenders. Each exfender con-
tains up to 24 data channels. The complete data
generator configuration is controlled via the
8180A and contains up to 64 parallel data
channels in total. Alsotwo 8180A Data Genera-—
tors can be synchronized, allowing the con-
figuration to be expanded up to 128 channels

i-6 OPTIONS
8180A Options

The standard 8120A Data Generator contains 8
parallel NRZ data channels, 1 strobe channel
and 2 clock outputs.

Option 001 features ¢4 additional NRZ data
channels(includes 15423A and 154124)

Option 802 features 4 additional RZ data chan-
nels (includes 15423A and 15412A). The delay
and width are individually programmable for
each channel. Also, WRZ mode is selectable; delay
remains active,

-2

Model 8180/81A

Possible configurations for the 81 20A:

8180A standard {8 x NRZ)

8180A + 1 x#001(12xNRZ)

8180A + 2 x# 001 (16 x NRZ)

8180A + 1 x#002(8x NRZ + 4 x RZ)
8180A+2x#002(8xNRZ+ &xRZ7)
8180A + 1 x # 001 + 1 x # 002 (12 x
NRZ + 4 x RZ)

8180A Options (Continued):

907 Front Handle Kit (Part No. 5061~
0o%0)

908 Rack Flange Kit (Part No. 5061~0078)

909 Rack Flange and Front Handle Com-~-
bination (Part No., 5061-0084)

910 Additional Complete Manual Set (in-
cludes 8181A Data Generator Extender
information; Part No. 08130-90000)

916 Additional Operating Manual (includes
8181A Data Generator Extender informa-
tion; Part No. 08]180-90006; sub-set of
Opt. 910)

Retrofit Options:

81801A 4 NRZ data channels (includes
installation at HP service office; 1 x
15423A and 1 x 15412A)

81802A 4 RZ data channels (includes
installation at HP service office; 1 x
15423A and 1 x15412A)

8181A Options

The standard 8181A Data Generator Extender
contains 8 NRZ data channels. The number of
channels can be incremented with multiples of
Option 006 up to 24 channels (8181A + 4 x #
001). (RZ data channels cannot be installed in
the 8181A)

061 Additional 4 NRZ data channels (in-
cludes 1 x 15423A and 1 x 15412A)
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Model 8180/81A

9067 Front Handle Kit (Part No. 5061-
0090}

908 Rack Flange Kit (Part No. 5061-~0078)

909 Rack Flange and Front Handle Com-
bination (Part No. 5061-0084}

Retrofit Options;
81801A 4 NRZ data channels (includes
installation at HP service office; 1 x
15423A and 1 x [5412A)

1~7 ACCESSORIES SUPPLIED

8180 Accessories

The &180A is supplied complete with the fol-
lowing items (see Figure 1-2)

ITEM HP PART NUMBER
5A fuse for 230V operation 2110-0010

one fitted and one supplied
10A fuse for 115V operation 2110-0051
1A fuse (250V) 2110-0007
(see Figure 2~2)

Power Cable

i x Cable-set for Clock |,

Clock 2 and strobe output 15422A
2 x Cable~set for 4 data
channels 15423A
1 x set of 20 solder~in
receptacles 15412A
See figure helow for
details of drilling
clearances required etc. 15412A
i(—Smm..g]‘
O O (5 O “T‘”
6. 4mm

c O O O—-’L-

%FPM dlameter 0-Emm.

Figure 1~4. 1 5412A Dimension Details

General Information

8181 A accessories (see Figure 1-1)

The 8181A is supplied with the same items as
the 8180A {apart from no 15422A cable}, plus
the interconnecting items as shown.

1-8 ACCESSORIES AVAILABLE
Electrical Accessories

In addition to the cable sets supplied with the
instruments, various other connector and probe
accessories are available for use with each of
them.

These are illustrated in Figure 1-3 and (includ-
ing those supplied as standard) are:

ITEM HP PART NUMBER
Set of § Plug-on grabbers

with ground leads 15408A
Set of § Plug~on BNC

adaptors 15409A
Set of 5 Plug-on SMB

adaptors 15410A
Set of § Plug-on coax open

end adaptors for fixed

wiring or use of custom

connector 15411A

Set of 5 plug-on miniprobes
which can be used in conjunction
with the HP 10024A Clip for easy
probing of dual-in line

packages. 15415A

Cable for parallel operation
of 2 8180A’s. Ensures synchronous
operation of setups with up
to 128 channels. 15421A

Mechanical Accessories (see Figure 1-5)

[-3
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General Information

Model 8180/81A

Front handle
Order Option 907

— s+%5  Rack flange
T i
‘ % " Order Option 908
- ;;:E {H.P. Part No.
<7’E§w”y 5061-0078)

Rack flange with front handle
Order Option 809

{H.P. Part No. {H.P. Part No.
5061—-0090} 5061 —~0084)
Figure 1-5.  Available Rack  Mounting Accessories
ITEM HP PART NUMBER 1-9 RECOMMENDED TEST EQUIPMENT
Rack Flange Kit 5061-0078 Equipment required to maintain the 8180A/
8181A is given in Table 1-1  Alternative
Rack Flange and Front equipment may be substituted, provided that it
Handle Combination 5061-0684 meets or exceeds the critical specifications listed
it the table.
Front Handle Kit 5061-009%0

Table 1 -1 Recommended Test Equipment

INSTRUMENT RECOMMENDED REQUIRED USE
MODEL CHARACTERISTIC

Universal Counter HP 53335A Time Interval A to B; AP

> 50MHz
Plug-on BNC Adapter HP 15409A APT
Clock and Strobe HP 15422A APT
Cable Set
Oscilloscope HP 1725A 275 MHz Bandwidth APT
Probes x 2 HP 10017A i ns/ Div.
Data Cable Set HP 15423A APT
Time Mark Generator Time Mark 2ns AP
Digital Voltmeter HP 3456A I mV Resolution APT
AC Current Amplifier 1111A AT

1-4
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Model 8180/81A

Table 1~1 Recommended Test Equipment Continued

General Information

INSTRUMENT RECOMMENDED REQUIRED USE
MODEL CHARACTERISTIC

Current Probe 1110B AT

BNC to dual banana plug PN 1251-2277 AP

Signature Multimeter HP 5005A PT

Pulse Generator HFP 80078 50 MHz/10 Hz Variable AP

Transition Times

BNC-Tee (2 ea) P.N. 1250-0781 AP

BNC to BNC Cable HP 11170C 50 0hm, 122 ¢cm AP

Assy (2 ea) :

BNC (f) to BNC PN 1250-0080 AP

{f) Adapter

BNC to BNC Cable HP 11170A 50 Ohm, 30 ¢m AP

Assy {2 ea)

Sampling Oscilloscope TEK 7603 with PT

with Accessories 7T11 and S-3A

HP 85F T

Delay Line 08130-61636 A

Removal Tool 1251-2170 T

Adjustments Cover 08180-04103 A

Extender Boards: 08180-66551/52 AT
08180-66553/54/56 T

I-5
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General Information
8180A DATA GENERATOR SPECIFICATIONS

Specifications are valid at the end of the supplied 1.5 m long
cables and for the operating temperature range from 0°C to
500C.

Memory Size

The memory depth is 1024 bit per channel. The memory width
is B channels for the 8180A standard. It can be increased up 1o
16 channeis by adding channel expansion options.

The first and last address, between which data will be read out,
are settable without restrictions within the memory.

Outputs

The instrument has B to 16 data ocutputs {depending on
cptions}, 2 clock outputs and 1 strobe output. Clock pulses
are generated with each period. One clock can be selected to
remain active in breakstate. The strobe output can be selected
to be the instrument’s reference clock, or to be a separate data
channel useful for external device triggering and as an internal
break signal. The output impedance for all outputs is 50 Ohm.
All outputs can be enabled or disabled in common. Selection
of normal or complement is possible for each output indepen-
dently.

Data and Clock Ouiputs

Model 8180/81A
Strobe Cutput

The strobe output can be selected to be a NRZ data channel
or to be the reference clock.

TTL and ECL levels are selectable.

Levels apply when driving intc 50 Ohm load.
{voltages double, if no load connected)

TTL setting:
High level > =24 V
Low level <=02V

ECL setting:
High level > =-09 V
Low level<=—1.8V

Pulse width in clock mode: 10ns £ 3 ns

4 pairs of programmable high and low levels can be set up. Any high/low level paircan be assigned to any output. 50 Ohm and

high impedance load condition is selectable in common.

Programmed load
condition

High level range
Low level range
Resolution
Amplitude range

Level accuracy after

Level accuracy after

Transition time (10 % — 90 %)

Typical transition time for
ECL levels (20 % — 80 %}

Preshoot, Overshoot, Ringing

from 50 Ohm into 50 Ohm
{voltages double, if no load
connected)

~156Vwo+ths vV
—20Vto+5.0V

3 digits {best case 10 mV)
05Vwb5V

20 ns settling time

+0b5%oflevel 3%
of amplitude £ 30 mV

{add £ 30 mV for
amplitudes < 0.7 V)

1 ms settling time

+ 0.5 % of level
+30mv

{add +-30 mV for
amplitudes < 0.7 V}

< 3.0 ns + | amplitude | x 0.2 ns

1.5 ns

< £ 10 % of amplitude

from 50 Ohm into high
impedance
{>>= 10 kOhm)

~-10Vto+i70V

~20Vito+160V

3 digits (best case 20 mV)
10Vt l17.0V

40 ns settling time
+05%oflevel 3%
of amplitude * 60 mV

fadd + 80 mV for
amplitudes < 1.5 V)

T ms settiing time
0.5 % of level
+ 60 mvV

{add + 60 mV for
amplitudes << 1.8 V)

<30 ns+ | amplitude | x 0.5 ns

< %10 % of amplitude

1-6



https://www.manualsplus.com/

Model 8180/81A
inputs

The instrument has a RUN (GATE}, BREAK, STOP and
EXTERNAL CLOCK input. All inputs are edge triggered and
can be enabled or disabled independently. Positive or negative
slope is independently selectable.

Input impedance: 50 Ohm or 100 kOhm selectable.
Thrashold range: ~10.0 Vto +10.0V

Threshold resolution: 100 mV

Threshold accuracy: £ 3 % of programmed value £ 50 mV

Threshold overdrive: > =100 mV

Max input voltage: £ 10V into 50 Ohm, £ 20 V into 100 kOhem

Min amplitude: 250 mVpp
Min pulse width at threshold: 8 ns

Timing
Timing specifications are valid for operation into 50 Ohm.

Skew and deiay specifications are valid for the 50 % points of
a signal with 2.5 V amplitude. For different amplitudes:
h 0.2 ns x {amplitude —2.5 V}
v
0.2 ns x | amplitude —2.5 V|

v

Delay changes wit

Skew increases with

Delay is measured with respect to the strobe output {clock
mode), TTL setting, 50 % point of amplitude.

General Information

Clock and Data Frequency

Range: 1.05 Mz to 50 MHz {20 ns to 950 ms)
Resolution: 3 digits

Agcuracy: £ 5 % of progr. value
Repeatability: Factor 4 better than accuracy
Max jitter: 0.2 % + 100 ps

Skew: < = 2 ns for NRZ data channels and RZ data
channels progr. for zero delay.

For Clocks and Option 002 {RZ data channels).

Delay
Range: 0.0 ns to 950 ms

Resolution: 3 digits (best case 100 ps}
{exception: 80.0 ns to 100 ns and 990 ns to 1.00 us,
2 digits}
Accuracy: b % of programmed vaiue £ 1 ns
Repeatability: Factor 4 betier than accuracy
Max jitter: 0.2 % + 150 ps
Max delay: 90 % of period —~18 ns

Width

Range: 10.0 ns 10 950 ms

Resoluticn: 3 digits (best case 100 ps}
Accuracy: * 5% of programmed value X 1 ns
Repeatability: Factor 4 better than accuracy
Max jitter: 0.2 % + 180 ps

Max width: 80 % of period —8 ns

MEMORY CONTENT 1 a 1 1 a8 1]
REFERENCE CLOCK
{STROBE) M B 1 1 !
DELAY
/
g180A CLOCK 1 ’ \ I_‘ 'r‘—'l I""
WIITH
DELAY
818CA CLOCK 2 ] i - 7 ] \ /——--\ [
WEGTH
bt |
B1B0A NAZ* DATA
DELAY
81B0A RZ** DATA 7 J \
WiDTH
818tA NRZ* DATA — BELAY
{EXTENDER 1) M:f:{ | WA R
AY
F181A NRZ* DATA L DE‘“
{EXTENDER 2} \.________.__:j | U R
* NHZ: Non-Return-to-Zero
e R7: Reti?n-:orzrero & Timing capabilities of the 8180A Data Ganerator and two 81814 Data Generator Extenders

17
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General Information

8181A DATA GENERATOR EXTENDER
SPECIFICATIONS

The 8181A Data Generator Extender is controlled via the
8180A Data Generator. The instrument state, the cycle mode,
the clock rate, the clock source, the output state (enable/
disable}, the first and last address are the same as in the
8180A.

Memory Size

The memory depth is 1024 bit per channel. The memory

width is 8 channels for the 8181A standard. It can be increased

up to 24 NRZ channels by adding channel expansion options.

Outputs

The instrument has 8 to 24 data outputs (depending on
options). The output impedance for all outputs is 50 Ohm,
Selection of normal or complement is possible for each output
independently. Output characteristics are the same as for the
8180A’s data outputs. The 8181A shares the high/low

level pairs with the 8180A.

Timing

The 8181A's NRZ format data channels can all be delayed in
common.

Skew: <=2ns
Delay specifications are as the 8180A RZ data channels.
Delay is measured between the 8180A’s strobe output (clock

mode} and the mid point between the 8181A’s NRZ data
channels skew.

PARALLEL OPERATION

Synchronous parallel operation of two 8180A Data Generators
s possible with the 15421A cable,

The skew measured across both 8180A's increases by 1 ns.

All other output and timing specifications remain as described
for 8180A and 81B1A.

For operating limitations, please refer to Section 3 -
Parallel Operation

1-8

Model 8180/81A

HP-1B CAPABILITY

The 8181A programming is performed via the 8180A’s HP-1B
interface.

All data, parameters and modes are programmable vig HP-1B.
interface functions implemented are:

SH1, AH1, L4, SR1, RL1, T6, PPO, DC1, DT, CO, E2

By means of a specific command, the display of the 8180A
may be used as a format free, general purpose alphanumeric
display.

Times are measured by programming with the HP 9826A
computer and remote message page of 8180A active,

Programming Times

{time for 8180A to receive, verify and execute message,
typical}.

Period: 45 ms

Delay, Width: 10 ms

Level: 12 ms

Transfer Times
{time for 8180A to receive message, typical)

Character transfer time for <= 285 charactars: < = 80 us/
character.

Number of characters per command: 4—6 for modes
6—11 for levels and timing

Data Memory Load Time
(time for 8180A to receive, verify and execute message,
typical).

a. formatted {HEX), 16 channels x 1024 bit: 10s
formatted {HEX), 54 channels x 1024 bit: 30 s

b. unformatted, 16 channels x 1024 bit: 400 ms
unformatted, 64 channels x 1024 bit: 9300 ms

Data, Parameters and Modes Storage Capability
{non-volatile}

1 active operating data/parameter/mode set
3 programmable parameter/mode sets

1 standard parameter/mode set

9 first/last address pair sets

After eight hours of continuous operation, batteries maintain
ail stored data, parameters and modes up to 3 weeks with
instrument switched off.
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Model 8180/81A

GENERAL (8180A and 8181A}

Recalibration period: 1 year
Warm-up time: 30 min.

Environmental:
Storage temperature; —40°C to 75°C
Operating temperature: 0°C to 50°C
Max operating humidity at 409C: 85 % R.H.

Video cutput: Composite video signal, negative SYNC
1.0 Vpp into 75 Ohm
{Recommended monitor HP 82813A)

Powaer:
8180A: 115/230 V rms +10 %, —22 %;
48--66 Hz; 800 VA max, 460 W max
8181A: 115/230 V rims +10 %, —22 %;
4866 Hz; 700 VA max, 410 W max

Weight:
8180A: Net 19.0 kg {42 ibs)
Shipping 26.0 kg (58 Ibs)
8181A: Net 18.5 kg (41 Ibs)
Shipping 23.5 kg (52 lbs)

Dimensions: 178 mm high, 426 mm wide, 500 mm deep
{7x16.8x 19.7 in}

General Information

1-9
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Model 8180/81A

Installation

SECTION 2

INSTALLATION

WARNING

The instruments weigh 19.0 kg (42 ibs) - 8180A
and 185 kg (41 lbs) -8181A. Care must be exer-
cised when lifting to avord persenal injury.

2~1 INTRODUCTION

This section provides installation instructions for
the 8180A and the 8181A and their accessories.
It also includes information about initial inspec-
tion and damage claims, preparation for use,
packaging, storage and shipment.

2-2 INITIAL INSPECTION

Inspect the shipping container for damage. If the
container or cushioning is damaged, it should be
kept until the contents of the shipment have
been checked for completeness, and the instru-
ment has been verified mechanically and electri-
cally. The contents of the shipment should be as
shown in Figures 1-{ and/or 1-2 plus any ac~
cessories that were ordered with the instru-
ment(s). Procedures for checking the electrical
operation are given in Section 3. If the contents
are incomplete, mechanical damage or defect is
apparent, or if an instrument does not pass the
operator’s checks, notify the nearest Hewlett~
Packard Office. Keep the shipping materials for
carriers inspection. The HP office will arrange
for repair or replacement without waiting for
settlement.

2-3 PREPARATION FOR USE
WARNING

To avoid hagardous electrical shock, do not
pevform electrical tests when there are signs of
shipping damage to any portion of the outer
enclosure {covers, panels, connectors etc),

2-4 Power Requirements

The instruments both require a power source of
115/230 V rms (+10% -22%) at a frequency of
48 - 66 Hz single phase. The maximum power
consumptions are: 8180A - 460 W {800 VA),
B181A - 410 W (700 VA).

2-5 Line Voltage Selection

CAUTION

BEFORE SWITCHING ON ANY OF THE IN-
STRUMENTS, make sure that they are sef to the
local line voltage.

Figure 2~1 provides information for line voltage
and fuse selection:

VOLTAGE 230V 115V

FUSE SA 10 A

s v

230 v |3

Figure 2-1 Switch settings for Line Voltages
2-6 Power Cable

In accordance with international safety stan-
dards, this instrument is equipped with a three-
wire power cable. When connected to an ap-
propriate  a.c. power receptacle, this cable
grounds the instrument cabinet. The type of
power cable shipped with each instrument
depends upon the country of destination. Refer
to Figure 2-2 for the part number of the power
cable available.

WARNING

To avoid the possibility of injury or death, the
following precautions must be followed before the
instrument is switched on.

aj If this instrument is to be energised vig an
autotransformer for voltage reduction, ensure
that the common fermingl is connected (0 the
grounded pole of the power source.
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b} The power cable plug shall only be inserted
into a socket outlet provided with a profective
ground contact. The protective action must not
be negated by the use of an extension cord with-
cut a protective conductor.

¢) Before switching on the instrument, the pro-~
fective ground terminal of the instrument must be
connected fo the profective conductor of the
power cable. This is verified by checking that the
resistance between the instrument chassis and the
frontpanel and the ground pin of the power cable
is zero OQhmes.

The following work should be carried out by a
gualified electrician and all local electrical codes
must be strictly observed,

If the plug on the cable does not fit the power
cutlet, or the cable is to be attached to a ter-
minal block, cut the cable at the plug end and
re~wire it. The colour coding used in the cable
will depend on the cable supplied {see Figure 2-
2.

NEMA TYPE ANSI 73,11,
HP Part No. B120~-1378

SCHUKO TYPE CEE 7
HP Part No. 8120~ 1689

LINE = BLACK
NEUTRAL = WHITE
GROUND = YELLOW/GREEN

LINE = BROWN
NEUTRAL = BLUE

- GROUND = YELLOW/GREEN

B.5.1363
HP Part No. 812G~1351

LINE = BROWN
NEUTRAL = BLUE
GROUND = YELLOW/GREEN

ASC 112
HP Part No. 8120-1369

LINE = BROWN
NEUTRAL = BLUE
GROUND = YELLOW/GREEN

Figure 2~2. Power
Identification

2-2

Cables Available: Plug

Model 8180/81A

If a new plug is to be connected, it should meet
local safety requirements and inciude the fol-
lowing features:

Adequate toad-carrying capacity (see table
of specifications in Section 1)

Ground connection.
Cable clamp.
2-7 HP-IB Connector

The rear panel HP-IB connector (Fig 2-3), is
compatible with the connector on Cable Assem-
blies 10833A B, C and D. If a cable is to be
locally manufactured, use comnector male, HP
part number 1251-0293.

2-§ HP-IB Logic Levels

The 81380A HP-IB lines use standard TTL logic,
the levels being as follows:

True = Low = digital ground or OV dc to
0.4V dc,

False = High = open or 2.5V dc to SV dc.

All HP-IB lines have LOW assertion states. High
states are held at 3.0V dc. by pull-ups within
the instrument. When a line functions as an
input, approximately 3.2mA of current is re-
quired to pull it low through a closure to digital
ground. When a line functions as an output, it
will sink up to 48mA in the low state and ap-
proximately 0.6mA in the high state.

CAUTION

NOTE: isolation, the HP-IB line screens are not
isolated from ground.
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Operation

SECTION 111

OPERATING

3-1 INTRODUCTION

This section explains the functions of controls,
connectors and display of the 8180A and pro-
vides operating and programming information.
Most of this information is also relevant to the
8181A, but additional data specific to its opera-
tion is included in a separate sub-section. Infor-
mation concerning parallel operation of two
8180A’s is also included,.

The operating information is presented under the
following main headings:

a) Operating Instructions. This includes a
general overview, basic description of
PAGES and "Getting Started" information,
descriptions of: memory features, operating
states, parallel operation, 8181A operation,
“on the fly" parameter changes and error
messages explanation.

b)  Quick Reference Information. This includes
a quick locator index for parameters and
operating modes (front panel operation), a
table of reset and Standard Parameter Set
conditions and values, a comprehensive
description of each PAGE'S features and a
list of all HP-1B commands and associated
information for programming purposes.

¢) Programming Information. This includes
address assignment, listener and talker
modes description, ASCII and binary data
transfers and simple programming examples
for individual PAGES. Also included is a
list of all HP-IB commands, mnemonics and
other related information.

' 3-2 SPECIAL OPERATING POINTS

The following steps must be taken before apply-
ing power to an 8180A or 8181A:

CAUTION

a) Read safety summary at the front of this
manual,

bj To avoid instument damage, ensure
that fthe VOLTAGE SELECTOR
switch is sef correctly for the local
line voltage. If it is necessary fo
change the sefting af any time, the
instrument must be switched off and
the power cable disconnected.

WARNING

If any change is made to the VOLTAGE
SELECTOR switch setting, the line fuse
must also be changed. Before changing
either of the rear panel fuses, switch the
instrument off and disconnect the power
cable,

& Maximum allowable external wvoltage at
output connectors: =10V - +18V,

3-3 CONTROLS, CONNECTORS AND
DISPLAY

A brief explanation of the function of the
8180A front and rear panel controls, connectors
and display is given in Figure 3~1, This should be
read prior to continuing with the following
paragraphs and also referred to as necessary
when reading the operating instructions. (Details
of the 8181A connectors are given at the end of
the main operating section).

3-1
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NOTE: Output Cables - Connector Identifica-
tion. The output cables supplied with the 8180A
falso applicable to the 8131A) have color and
number markings to identify each output signal.
They are explained as follows:

The four discrete connectors of output cable
15423A are coded: O/black, 1/red, 2/yellow and
3/blue respectively, to identify the correspond-
ing four channels. :

The three discrete connectors of cable 15422A
(8180A only) are coded: Cl/black, C2/red and
O/yellow (Strobe} to identify the clock and
strobe signals respectively.

3-4 OPERATING INSTRUCTIONS

All instrument settings can be sef either via the
front panel conirols (local operation}, or pro-
grammed wusing the HP-IB (remote operation)
Local operation is explained in the following
paragraphs. For remote operation, refer to the
"PROG /HP-TB" section (blue register). Within
the text, exact frontpanel legends e.g. "PAGE"
are used where helpful Also, these and
SOFTKEYS, are identified by bold typeface eg.
"Clock", where specific operation is described.

3~5 Operating Concept

The operating concept of the 8180A is based on
a "layered menu"” principle as illustrated in Fig-
ure 3-2. The instrument seitings (parameters,
operating conditions etc.) are itemised over seven
"PAGES" each of which is sub-divided or layered
(hence layered menu) and contains a group of
related items {e.gtiming related-TIMING
PAGE). A PAGE display comprises two main
areas: REPORT and SOFTKEY.

Model 8180/81A

The REPCORT can contain a combination of
parameter values, operating conditions or cutput

" data (logic code) depending on the PAGE.

The SOFTKEY area includes an entry field and
the current softkey labels or function identifiers.

The PAGES and settings are accessed wvia
"SOFTKEYS", these are 4 group of eight, front
panel mounted keys, whose functions are vari-
able (non-permanently defined). Following access
of the required setting, entry of the parameter
value, operating condition or data is made via
either the SOFTKEYS or DATA keys depending
on the type of setting.

3-6 Power Up and Initial Conditions

Press the LINE switch. Do not press any other
front panel key. After a few seconds’ delay
{during which the cooling fans start up and ON
indicator illuminates), note the initial condition
display. This is divided into two areas:

The upper one (above the the dividing line)
contains current status { and possibly error} data.
The lower, PAGE selection area contains the
SELECT PAGE prompt and the PAGES menu.
NOTE: If an error message is displayed, refer
to 3~8.

s | Apugupong J Guuh | et |

Select PAGE: e.g, TIMING

N

7t Ji
/L I

N\

v

L3 D
7%

Key Word e.g. Clock Timing

Item select e.g., Clock 2 Delay

Entry Level e.g., 50ns

Figure 3-2 HP 8180A Operating Concept

3-2
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Before making a PAGE selection note the details
within the upper area. These include, at the
extreme right-hand sidethe current 8&180A
operating status {at present "STOP"), space for the
microprocessor "busy" indication (a white square
whenever “busy"), and space for the data output
address. This at present empty zince data has not
yvet been cutput.

The flashing warning: "Outputs Off" occurs
because the 81 80A (or 8181A) outputs are auto-
matically disabled at instrument switch on.

3~7 OPERATORS CHECKS

During power-up, an automatic self test routine
is performed. Any failure detected will result in
an error message being displayed within the
central screen area. Also, a flashing "HARD-
WARE" message will be displaved in the upper
one. Deiails of the possible error messages are as
follows:

3-8 Error Messages on Power Up

1) EXTENDER POWER DOWN

2) FPARAMETER DESTROYED
STANDARD SET RECALLED

3) MODULE BOARD FAILED

4) TIMING BOARD FAILED

) CLOCK OSCILLATOR FAILED

6) ADDRESS COUNTER FAILED

7 STATUS CONTROL FAILED

8) ROM FAILED

%) RAM FAILED

10) DISPLAY RAM FAILED

I1)  XEYBOARD FAILED

12) INTERFACE FAILED

In the event of any of the above error mes-
sages.except (2) occurring, it is recommended that
the user contact the nearest Hewlett Packard
Sales/Service Office. However the following
points should first be noted:

a)  Error (1) is significant only if an 8181IA
Data Generator Extender is being used and
it may be due to the fact that although
connected, it is not switched on. If the
message occurs, a softkey - Continue - is
presented, this should be pressed if the user
wants to contine with PAGE selection.

Operation

b} FError (2) can be due to more than three
weeks non~use of the 21 30A (see specifica~-
tions and STORE/RECALL PAGE descrip~
tion). Error {2} can also be due to a LABEL
(see OUTPUT PAGE description) high level
having been set lower than the low level
when the 8180A was previously used.
Switching the instruinent off in this condi-
tion causes the current parameter set to be
destroyed.

¢} Error (11) can be due to a sticking front-
panel key (make a visual check) or if & key
was pressed during power up.

d)  Error {12) 18 significant only for HP-IB
operation.

The 81830A automatically recalls the compleie
parameter and datz set which was current at
switch off whenever power is re~enabled.

3-9 PAGE CONTROL

The PAGE MENU, as available either after
instrument power on (or by pressing the the
"PAGES" key), is indicated by softkey labels. A
brief description of the contents of each page
follows. Detailed descriptions are given in the
Quick Reference Information sub-section.

CONTROL - General instrumeni operational
settings including: First/Last Addresses, Cycle
Modes, Break Control, Clock Source, External
Inputs, Strobe Qutput, Output on/off.

TIMING - All timing related parameters in-~
cluding: Frequency, Period, for Clock and data
channels; Delay, Width for Clocks; and, for
2180A’s with Timing Options: Delay and Width
Channel Timing parameters.

OUTPUT - Outputs on/off, Labels~High/Low
level setting, Labels allocation, Channel Con-
figuration (for display purposes).

DATA ~ All data entry (logic code) and editing
features.

STORE /RECALL -Parameter sets and Address

sets storage and recall, also Standard Parameter
Set Access. '

3-3
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3-4

MISCELLANEQUS - Access to Autoexit and
Brightness settings and Report of these, informa-
tion on Remote (HP-1B Interface) and installed
Hardware-Data/Timing channels and installed
(active} connectors.

Model 8180/81A

MACRO DATA - A store of up to sixteen "lines"
of data, 8-64 bits long (depending on number of
instalied channels) user settable for copying to
the DATA PAGE as required.

3-10 GETTING STARTED

To select any page, press the appropriate softkey,
for example select the CONTROL page via the
top left-hand one. Note the display configura-
tion, this comprises the two areas already
described - REPORT and SOFTKEY - their
boundaries are as follows:

The REPORT area, headed by the page name (in
this case CONTROL) extends down to the "Select
Further" prompt and shows the current REPORT
items. Only those items which can currently be
assigned new values will be displayed.

The SOFTKEY area, extending from the "Select
Further" prompt down to the bottom of the
screen, includes the Entry Field area (at present
empty) and the current SOFTKEY labels. These
fabels show the first layer of the CONTROL
PAGE menu and are called the Key Words. A
close look at the labels and the REPORT content
will show the direct connection between them,
e.g, the top line of the REPORT includes First
and Last Address details, these correspond to the
first two SOFTKEY labels reading left to right
etc.

If you now want to practise making settings and
quickly get familiar with the operating concept,
a good way to start is by recalling the Standard
Parameter Set. You can then use these as the
basis for setting new parameter values, operating
conditions etc,

MWOTE: If, whilst practising, any type of flashing
error indication appears on the screen,
refer to: "OPERATOR ERRORS AND
WARNING MESSAGES", This is right at
the end of the Operating section fin front
of the QUICK LOCATOR)

To get started, press the following softkeys:

1) STORE/RECALL
2) Rel 5td Set
JEXECUTE

A complete set of known values has now been
allocated to all parameter and operating condi-
tions. (A table, listing all of these (Standard
Parameter Sef) values, i3 given in the Quck
Reference Information, page 3R-4)

The Standard Parameter Set can be recalled at
any time, if you want to get back to a known
starting point.

To recall the setjust press the following keys/
softkeys:

PAGES {front panel key)
STORE/RECALL

Rel Std Set

EXECUTE.

To continue with "GETTING STARTED', the
next step is to select the CONTROL page. To do
thig, press the following keys/softkeys:

PAGES
CONTROL

The CONTROL page defines general instrument
operating conditions. The conditions for standard
settings are as given in Figure 3-3 and Table 3-
I.
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Operation

Table 3~1 CONTROL PAGE Std Param Vals

Parameter or Setting

Title Parameter Set
Value
First Address 0040
Last Address 1023
Cycle Mode AUTO
Strobe breaks OFF
Clock Source INTERNAL
Clock 1 in Break OFF
Input Impedance 50 Chm
Input Threshold +G.00V
Run Input OFF
Stop Input OFF
Break Input OFF
Strobe Output DATA
Outputs OFF

Figure 3-3. Control Page (Standard Settings)

Standard

Practise changing some of the REPORT items by
pressing the corresponding softkeys. Asan exam-
ple, change the First Address (address where data
outputs will start when RUN initiated) to 0009,
by pressing softkeys:

1} First Address
1) INCREMENT, until 0009 appears in
the Data Entry (and

Report) areas.

You will have noticed that as soon as the value
reached (001, a DECREMENT softkey ap-
peared. 1t was missing before because First Ad-
dress lower than 0000 is not possible. Note alsg,
that the value can be incremented in single steps
or the softkey can be continuously pressed.

- Now change the First Address fo 0020 via the

front panel DATA keys.

Note that numeric values can be entered either
by INCREMENT/DECREMENT softkeys, or
via the front panel DATA keys.

Now press EXIT 1, the Control page keywords
will again be displayed. Practise changing some
of the other settings via their softkeys. You will
see that some keywords give access to further
selections. By pressing the EXIT softkey once for
each "arrowhead" indicated you will get back to
the keywords.

3-35
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By viewing the Strobe, and one or both Clock
outputs, on an oscilloscope, you can note the
effect of changing some of the cther parameters.
Figure 3~4 shows the relationship between some
8180A/81A output signals and associated set-
tings. It also shows which PAGE to access to
change the seti{ing’s value.

As a further example, call up the TIMING
PAGE by pressing

PAGES
TIMING

{front panel key)

Model 8180/81A

Note the various parameter values shown in the
Report area and practise changing some of them.
As an example, to change the Clock Frequency
from the standard value of 10 MHz to 12 MHz,
pressing the following keys/softheys:

Frequency
1and 2 {(DATA keys)
MEGAHERTZ '

Now press EXIT +

OUTPUT SIGMAL AND
PAGE TO ACCESS

0104
__MEMORY CONTENT = ¢

2102

ADDRESS {(FIRST AND LAST):CONTROL PAGE

0103 €104 2105
1

BATA o PE RO oty

1.

7

i

REFERENCE CLOCK
(STROBE )
CONTROL & TIMING

™

DELAY

LW LEVELS ,

e HIGH
s L QW

8180A CLOCK 1
TIMING & OUTPUT

8180A CLOCK 2
TIMING & QUTPUT

WIDTH

WIDTH S I

(LABEL A)

r“'HIGH

(LABE]L B)

‘B180A NRZ™ DATA
DATA

81804 NRz ¥ paTA
(TIMING CHANNEL)

DELAY

DATA & TIMING

DELAY

__<a1 80A rz¥¥para
DATA & TIMING

8181A NRZ¥ DATA
(EXTENDER 1)
DATA & TIMING

sig1a nNRZ¥ pata

WIDTH

DELAY

DELAY

T\ /i

{EXTENDER 2)
DATA & TIMING
Sy

Z2: Return~to-Zero

*NRZ= MNon-Returneto -Zero -

Figure 3-4. Examples of 81 80A/8181A Settings and associated PAGES.

3-6
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To change Clock 1 Delay to 2 ns, first press
softkeys:

Clock Timing
Clock 1 Delay

then, either:

INCREMENT until 02.0 ns reached,
or enter "2 via DATA keys and press units
softkey;

NANGSEC

Now press EXIT ™™ twice, to get back to the
keywords.

It is possible, that while practising making
TIMING PAGE value changes, you will attempt
a setting which causes an error indication.

- Either, determine the reason (see explanations at
end of Operating section) and set 4 new, valid
value or, recall the Standard Set. It is obviously
better if you are able to clear an error condition
by making a new "acceptable” setting.

Once you are familiar with the basic operating
concept, either continue reading the following
paragraphs or, turn to the Quick Reference
Information. The following paragraphs describe
8180A/81A operating states etc. The Quick
Reference Information provides more detailed
explanation of PAGE use and control. it also
includes descriptions of all PAGES' features.

3-11 MEMORY FEATURES

These include the ability to store and recall the
following via the STORE/ RECALL PAGE:

(a) 3 programmable parameter/mode sets
(b) 9 first/last address pair sets
{c) 1 standard parameter set.

The complete currently active parameter and
data set is automatically stored on 8180A switch
off and recalled on switch on. In addition to the
above, the MACRO DATA PAGE enables up to
16*%* complete "lines” of data (logic code) to be
operator set and stored for recall when entering
logic code on the DATA PAGE. It is used as part
of the line editing procedure for fast setting up
(or copying) of one or more lines of data to the
PAGE. * (8~64 bits long depending on number
of installed channels)

Operation

An example of the use of the STORE/RECALL
PAGE can be shown by selecting the CONTROL
PAGE and changing the First and Last Ad-
dresses. (This was described in the "GETTING
STARTED" section).

Now, press the (CALL) "SOFTKEYS" key fol-
lowed by: STORE/RECALL. Then, press Sto
Param and, to store the new set as Set 2, press
"2 (DATA KEYS) followed by EXECUTE,

By recalling the Standard Parameter Set, and
then Parameter Set 2, you can confirm that the
"new" sef has been stored. Do this by checking
the CONTROL PAGE REPORT details for gach
recall condition.

NOTE: Recall of any Parameter set {(including
Standard) causes the 8180A to go to the "STOP"
state with "Qutputs Off".

Standard Parameter Set

This can be used as the basis for setting up the
81 80A to output data. It is only necessary to set
actual data and the operating states if the other
values are acceptable. The contents of the set is
listed in the Quick
Reference Section together with additional
information concerning power up reset coandi-
tions etc,

3-12 INSTRUMENT STATES

The 8180A has three operating states - RUN,
STOP AND BREAK. They can be initiated either
via the corresponding front panel keys or exter-
nal control inputs and are operative for all cycle
modes except under the following "GATED"
cycle mode conditions:

(a) In either GATED mode, irrespective of
clock source, all BREAK related functions
are disabled including both methods of
BREAK control, and the front panel RUN
key is disabled.

{b} In either GATED mode, if the clock source
is INTERNAL or EXTERNAL, then only
the STOP key is active.

{c) 1In either GATED mode, if the clock source
is MANUAIL then only STOP and MAN-
UAL FWD keys are active,

3-7
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3-8

State

RUN
data is output {generated) after:

STOP

data generation is stopped with the last after:
word’s NRZ data remaining at the

outputs, and the RZ data returning to

logic false after the programmed delay

and width. When RUN is initiated after

stop, data generation begins from the First

Address. (If in either of the "INIT" modes,

it begins from Address zero)

BREAK
as for STOP except that when "RUN after:
initiated after BREAK, data generation
begins from current address this can have
been changed via "MAN CLOCK" FWD or
BACK keys.

Model 8180/81A

When operative

manual operation of RUN
external RUN signal
(HP~IB ~> Group Execute Trigger (GET)) v

power on
manual operation of STOP

external STOP signal

at end of SINGLE cycle

at end of GATED cycle

(HP-IB -> Device Clear (DCL,SDC))

manual operation of BREAK
external BREAK

internal BREAK from STROBE
channel if condition enabled (when a
"1" in STROBE channel, then
BREAK occurs).

NOTEf the FWD or BACK keys are operated then data at the outputs will change

State diagram Figure 3~5 shows the interaction between the three instrument states.

MANUAL
LLOCK

POWER ON

:

e

INTERNAL
CLOCK
EXTERANAL
CLOCK

=

BREAK

BREAK IN

FORWARD

BACKWARD

STROBE
BREAKS

RUNIN [ 1}
it RUN

STOP

SINGLE CYCLE
END OF
GATED CYCLE

END OF

1) Note: Only axternal RUN signat enables GATED CYCLE.
2} Note: BREAK commands are not active in GATED GYELE mods, / F-:I'léil:fg\l. ]

KEYBOARD

COMMAND
INTERNAL
CONTROL

fa)
END OF
SINGLE CYCLE

Figure 3-35. States Interaction
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Model 8180/81A

3-16 8181A DATA GENERATOR EXTENDER

3-17 General

Either one, or two, 8181A’s may be interfaced
with an 8180A Data Generator. The following
functions of the resulting system will then be
exactly as set for the 8180A and will automati-
cally apply to the 8181A {5) without operator
action:

State, cycle mode, clock rate, clock source,
output state and first and last addresses.

All other settings for the 8181A(s) are also made
via the 8180A but with their own values set as
required. Note, when switched off, an 81&1A
storezs only data (logic code), all of its other
parameters are stored by the controlling 81 80A.

The operating procedure for an S180A/8181A
system is very similar to that for the 81 80A. The
instruments must first be interconnected electri~
cally and, ideally, mechanically with the items
supplied with the 8!81A. They are shown in
Figure 1-1 and the interconnecting procedure is
as follows:

3-18 INTERCONNECTING PROCEDURE

It is recommended that each of the
instruments be  switched of f
whenever interconnecting or discon-
necting them.

NOTE:

Refer first to Figure 3-6 for a brief explanation
of the connectors and controls noting the output
connectors’ alpha-numeric identifiers and the
references to Extenders ! and 2. The cables
should be connected as shown in Figure 3-7. If
only one 8181A is to be fitted then ignore the
references to Extender 2.

Operation

3-19 OPERATION

Switch on the 8180A then the 8181A {s), the
system is now ready for use. Whenever an
&8181A is switched off {or on) during system
operation, a reset cycle is initiated and the
8180A display will revert to the "power up"
status. If an 8181A is switched off, an error
message (see paragraph 3-8} will be displayed
Press the Continue softkey to re-enable page
selection,

As mentioned above, their are no significant
differences for Extender operation. In effect you
now have an 8180A with an increased channel
count, each of the new 818!A channels can be
given a common delay value via the TIMING
PAGE. Reference to the DATA and QUTPUT
PAGES will enable the corresponding settings to
be made.

NOTE: If the Standard Parameter Set is recalled,
the Extender data channels are coded in
Hexadecimal to enable all channels to be dis-
played on the screen.

If two 8181 A’s are connected in the system,
then a reset cycle is initiated whenever
either of them is switched on. However,
only when both of them have been switched
off is a further reset cycle initiated.

311
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3-26 "ON THE FLY" CHANGES

This is of more significance for remote, (HP=IB)
rather than local operation, but is, in principle
also applicable to front panel operation.

When a parameter value (or operating condition
etc) is changed with the 8180A in RUN sta-
tusthere are slight differences in the subsequent
status depending on the type of change. The
following list details these differences under
their appropriate page titles

NOTE: An "on the fly" change is one wherebye,
when the change is made, it is executed on the
occurrence of the immediately following clock
cycle with no disruption of instrument status.
Even if the new wvalue or setting is the same as
the old one (ie., no change), it is still considered
to be a "change™

CONTROL PAGE

Parameter/Operating Effect of Change
Condition changed

First/Last Address 8180A goes to STOP irrespective of cycle modethen if (FA/L.A) in
AUTO or INIT+AUTO, RUN is automatically restarted
or address zero from either F.A. (for AUTO) or address zero (INIT+AUTO
Cycle Mode 8180A goes to STOP.
Strobe Breaks 1) if to OFF: no change.
2} if to ON: then 8180A goes to STOP.
Clock! in Break on the fly.
Clock Source data outputs "delayed" for short time then continued.
Input Impedance on the fly.
Input Threshold on the fly.
Run, Stop, and all three external inputs disabled for short time if
Break Inputs any one changed. (NOTE: change of active slope [pos/
negl] can change operating state).
Strobe Qutput on the fly.
QOutputs on/off on the fly.

3-12
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TIMING PAGE

Parameter/Operating Effect of Change
Condition changed

Frequency or Period 1) If no RZ=50% channels(or clock outputs) and no range
changes involved (see table below)then on the fly, however,
allow time for increase of period over a few clock cycles if
new frequency much lower than old. If range change, then
clock signals interrupted, data output signals terminated
and restart after short delay.

4| If RZ=50% outputs, then as for (1} but with possible range
change depending on value of period/2.

Delay or Width 1) ‘ If no range changes, then on the fly but with possible short
time lag (2 few clock cycles) for new width or delay to
slowly change.

2) If range changes then clock signals interrupted etc. as for
Frequency/Period above.

Format Clock interrupted and restarts from next address.

Table 3-1 Range Data {applicable to Clock and Data channels)

Delay Period/Width
0.0 - 899ns 10,0 ns ~ 99.9 ns
090 ns - 989 ns 100 ns - 999 ns
0.99 us ~ 998 us 1.00 us - 9.99 us
999 us - 99.9 us 10.0 us - 99.9 us

100 us - 999 us

1.00 ms - 9.99 ms
10.0 ms ~ 99.9 ms
100 ms - 999 ms

OUTPUT PAGE

L.oad Impedance outputs temporarily disabled then re-enabled with new values but as
clock not interrupted, address will have changed.

Levels (High or Low) on the fly with slow rise (or fall} to new value.

Labels as for Levels

3-13
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QUTPUT PAGE continued

Parameter/Operating Effect of Change
Condition changed

Polarity on the fly.
Channel Configuration no effect on status or outputs since this is a "display change".
DATA PAGE
any DATA change sequence is: (1) external I/Ps disabled, (2) BREAK initiated, (3) data

changed, (4) return to original state, (5) external I/Ps re—enabled.

STORE/RECALL PAGE
STORE ‘ no effect on status or outputs.
RECALL Parameter Set or Standard Set,:STOP plus outputs OFF.

Address Set: as for First or Last Address change.

MISCELLANEOUS PAGE

no effect on status or outputs.

MACRO DATA PAGE

no effect on output until data copied from PAGE, then as for DATA
PAGE
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3-21 OPERATOR ERRORS AND WARNING MESSAGES

It is possible that while practising entering values and operating modes, the operator may make a value
change which results in either a “flashing E" or 2 "VALUE OUT OF RANGE" error indication being
displayed. The significance of any such error messages and other warnings is explained as follows,

3-22 Ervor Indication
a} Flashing: "E” indication

This condition occurs when a value entry is made which either exceeds the maximum allowable value
{for maintenance of specifications) eg. Width or Delay too large for current Period, in the case of
timing related settings or, causes the specified maximum or minimum amplitude range to be exceeded
in the case of Label related settings. For either of these error conditions, as well as a flashing "E" ap-
pearing adjacent to the error value, a flashing “TIMING" (for Delay or Width) or "SWING" (for Labels)
warning will appear at the top of the report display area.

Examples of timing related error conditions:

1} If frequency = 10MHz (so period = 100 ns) and Clock! Width is set to 85 ns, then "E" will occur
since for period = 100 ns, width should not exceed 82 ns. {90% of Period - & ns according to
specifications) :

2)  For same frequency value, if Clock2 Delay is set to 74 ns then "E" will occcur since maximum
allowable value is 72 ns (90% of Period -18 ns)

Example of a Label related error condition: .
if Label A Low Level = -0.30 V and High Level is changed from +0.20 V to +0.19 V then "E" will
occur since minimum allowed amplitude is 0.5 V {from 50 Ohm into 50 Chm).

TENTER HEW

Labet A High

Note thatfor any "E" condition, the error value may appear at the output(s) but the associated
specification accuracy will no longer apply.
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b) "VALUE OUT OF RANGE"

This warning occurs when an attempt is made to set a value (via the data keys} outside its own specfied
range, e.g., Last Address greater than 1023 or Width less than 10 ns. This type of error can be avoided
by noting the range limits which are shown in the PAGE Entry Fields wherever a parameter "ENTER
NEW VALUE" condition is currently active. The screen display examples given within this section show
typical range limit values. Note that for this type of error condition, the 8180A will not accept the
new value (it retains the old one) and values exceeding specified maximum or minimum will not be
output. Examples of when this type of error condition will occur are: a Clock Width setting less than
10 ns or a Label Low Level less than ~2.0V, the resulting error displays would be as shown below.

TENTER HEW VAL

Hlock 1 i

TEHTER HEH VALUE e BYREE (B

- Label 8 Low Leusl

3-23 WARNING MESSAGES

Flashing: "Outputs Off"
This is a reminder that the outputs have been disabled either due to direct operator action or as part of
the 8180A power up sequence.

Flashing: "Clock" indication.
If an external clock source is being used and the resulting input frequency is too high (exceeds 50 MHz),
then a flashing warning "CLOCK" will appear in the top left-hand corner of the CRT display.

Flashing"Value exceeds Frequency Resolution" or "Value exceeds 28 mV Resolution”

If a period value is entered which would cause the frequency resolution of 3 digits to be exceeded, the
value will not be accepted. Similarly, if for a Load Impedance = OPENa voltage level is entered which
exceeds the allowable 20 mV resolutionit will not be accepted. For either case,a warning will be
displayed.

Fiashing: "Run Input Off"

If either of the "GATED" cycle modes is selected, the Run Input is off and the 8180A outputs are
enabled, then a flashing warning "Run Input Off" appears at the top of the display as a reminder that
the 81 80A cannot run.

Flashing: "Dupl Chnl in Segment” If, when making a change to the displayed Channel Configuration, a
channel is entered for a second (or further) time into a Segment, the warning "Dupl Chnl in Segment"
will flash. This warning will remain flashing until either, the channei(s) concerned are deleted or, the
cursor Is shifted to a new segment.

Flashing: "Display incomplete” This warning appears, at the top right~hand side of the DATA display, if
the complete display configuration cannot be accommodated within the availabie area, ie, one or more
columns of data are "hidden" from view at the extreme right-hand side. If data entry is in progress, it
is recommended that both of the above mentioned conditions are corrected prior to further entries to
avoid any confusing results later. :
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Model 8180/81A

Operation

PARAMETER AND OPERATING MODES QUICK LOCATOR

The following index enables any 8180A parameter, operating mode or setting , (REPORT item) to be
quickly located at the appropriate PAGE(S). This is done by cross-referencing it to a PAGE and KEY -

WORD. An example of this is shown below:

To change Clock 1 Delay:

I} Check under "Clock Related Settings”, Clock(l or 2} Delay is listed.
2) The appropriate PAGE is TIMING.
3) The required KEYWORD (to access the item} is Clock Timing.

ITEM
ADDRESS related

First Address
1.ast Address
Top Address
Limit Address
Address Code
Address Sets

TIMING related-General

{for Clock Timing see Clock related)
Frequency

Period

CLOCK related {including clock timing)

Clock {1 or 2} Delay

Clock {1 or 2} Width

Clock (1 or 1) Format

Clock Output (Level/Polarity)
Clock Source

Clock 1 in Break

TIMING rel_ated—Channels {Option 002)

Delay

Format

Width

All Channel Delay
All Channel Width
All Channel Format

TIMING related - Extenders

Delay (1 or 2)

PAGE

CONTROL
CONTROL
DATA

DATA

DATA
STORE/RECALL

TIMING
TIMING

TIMING
TIMING
TIMING
OUTPUT
CONTROL
CONTROL

TIMING
TIMING
TIMING
TIMING
TIMING
TIMING

TIMING

KEYWORD (if not as ITEM)

First Address

Last Adrress

Top Address

Edit {(then Line Edit)
Edit

Rcl/Sto Addresses

Frequency
Period

Clock Timing
Clock Timing
Clock Timing
Clock Output
Clock Source

Break Control

Chnl Timing

Extender 1 (2}

DISPLAY edit related - ali edit features (including "Data related") are available via "Edit" on the
DATA page, some are available on other pages also, e.g. Chnl Config - OUTPUT and MACRO DATA

pages.

R

1
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Operation

ITEM
DATA related

Clear all Data
Data

Clear Channel
Channel

STROBE related

Strobe OQutput {clk/data)
Strobe breaks (OFF/ON)
Strobe Level

Strobe Polarity

Clear Strobe {data)

QUTPUT related

Load Impedance (value)
Output on/off

Level (High/Low Label values)
Label {and polarity) allocation
ELabel {and polarity} allocation
EXTERNAL Inputs etc.

Run, Stop, Break
Threshold, Impedance

3R-2

PAGE

DATA
DATA

DATA
DATA

CONTROL
CONTROL
OUTPUT
OUTPUT
DATA

OUTPUT
OUTPUT
OUTPUT
OUTPUT
OUTPUT

CONTROL
CONTROL

Model 8180/81A

KEYWORD (if not as ITEM)

Edit (then Clear & Set) Set all
Edit i i

Edit (then Channe! Edit Set
Edit iE 13

Strobe Output

Break Control

Strobe Level

Strobe Polar

Edit (then Clear & Set)

Load Imp
Outp on/off
Level

Clock OQutput
Chnl Label

Inputs
Inputs
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Model 8180/81A Operation

RESET AND RECALL STANDARD SET CONDITIONS

Table 3-2 shows,for each PAGE in column {4}, the Standard Parameter Set values together with condi-
tions at 8180A switch on {3). It also shows which settings are stored as part of any parameter set (5).
Remember that the complete current parameter and data set is auto-stored at ywitch off. Reset cccurs
when for example, an 8181A which forms part of the system is switched off.

Table 3-2. Reset and Recall Standard Set Conditions

(1) (2} (3) (4) (5)
If Option/| At "Switch on" Part of
Parameter or Setting] Extender |or "Reset” Status Standard Parameter
Title relatad (as auto-stored Parameter Set Set ?
then: (YES) unless stated) Value Y = YES
CONTROL PAGE
First Address 0000 ¥
Last Address 1023 Y
Cycle Mode AUTC ¥
Strobe breaks OFF b4
Clock Source INTERNAL Y
Clock 1 in Break OFF Y
Input Impedance 50 Ohm Y
Input Threshold + 0.0V ¥
Run Input OFF b4
Stop Input OFF ¥
Break Input OFF ¥
Strobe Output DATA Y
Qutputs OFF OFF OFF for
any Param'
Set recall
TIMING PAGE
Clock Frequency 10.0 MHz Y
Clock Period 100 ns Y
Clock 1 Delay 00.0 ns Y
Clock 1 Format RZ b'd
Clock 1 Width 40.0 ns Y
Clock 2 Delay 50.0 ns Y
Clock 2 Format RZ Y
Clock 2 Width . 10.0 ns Y
Extender 1 Delay YES G0.0 ns Y
Extender 2 Delay YES 00.0 ns Y
Channel 0-0 Delay YES 00.0 ns Y
thru to '
Channel 1-3 Delay YES 00.0 ns Y
Channel 0-0 Format YES NRZ Y
thru te
Channel 1-3 Format YES NRZ ¥
Channel 0-0 Width YES 50.0 ns ¥
thru to
Channel 1-3 Width YES 50.0 ns Y

3R-3
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Operation

Table 3-2 Reset and Recall Standard Set Conditions continued

Model 8130/81A

(1) (3) {4) (5)
Part of
Parameter or Setting [At "Switch on or Reset" Standard Parameter
Title Status Parameter Set Set 7
(as auto-stored unless stated) Value Y = YES
OUTPUT PAGE
Load Impedance 50 ohm Y
Clock 1 Label LABEL A T
Clock 1 Polarity NORMAL Y
Clock 2 Label LABEL A ¥
Clock 2 Polarity NORMAL Y
Strobe Level ECL Y
Strobe Polarity NORMAL Y
Label A High Level +0. 25V Y
Label A Low Level -0.25V Y
Label B High Level +5.00V Y
Label B Low Level +0., 00V b4
Label C High Level -0.80vV Y
Label C Low Level -1.80V Y
Label D High Level +2.,h0v Y
Label D Low Level +0.80V Y
Charmel Configuration| All "not installed" Standard Y but as
*see NOTES 1 and 3 connectors deleted. If Config', for (3)
at end of table. display configuration would all "not
now be empty, then following installed
details will apply: connectors"
“"Channel 0-0 displayed, deleted.
BINary coded, Entry-YES" (see NOTELl at
end of table)
Channel Label ALL A Y
Channel Polarity ALL NORMAL Y
DATA PAGE
Top Address 0600
Address Code DEC Y
Channel Edit Cursors First channel of as for (3) as for (3)
Copy Macro F to Tor Address
Copy Macros J 0-F to Top Address
Insert and Delete Lin Top Address
Copy and Move Line Top Address to as for(3)
Last Address
Limit Address Lagt Address
Entry Mcde HORIZONTAL
MISCELLANEQUS PAGE
Autoexit OFF

3JR-4
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Mode] 8180/81A

HP-IB Commands Reset Status

Operation

Title At "Switch on If HP-IB Address changed
BSA 0000 0000
BTR t 1
BSC 0/Max 0/ Max
LIN 1 i
ISR 1 i
F5R 1 i
TLK 1 1
NOTES:

t. Standard Configuration details (maximum configuration of 64 channels shown):

Connector:
Channel
Labek

continued

FFFFEEEE DDDDCCCCBBBBAAAA 99998888
32103210 3210321032103210 32103210
AAADAALA  AMAAAAAAABAAAAAA AAAAAAAA

TTTT66665555L4uL 3333 2222 1111 0000
3210321032103210 3210 3210 3210 3210
AAAAAAAAAAAAAAAA AAAA AAAA AAAA  AAAA

First 4 Segments are configured in HEX. Last four Segments in BINARY All Segments Entry-YES

2. Change at HP-IB Address

A Change of the HP-IB Address Switch is accepted only if the 8180A is not in Remote, Listen or Talk

mode.

3. Explanation of installed and not installed connectors ete.

Installed connectors are those connectors which have channel groups connected to them, that is, the
corresponding boards are installed or Extenders connected, The minimum number of instailed connec-
tors in either an 8180A (or an 8181A) is 2. Therefore, in an 81 80A, 8 channels are always available,
even though not necessarily always used or displayed. Only installed connectors can be used (or

displayed.

“Not installed" connectors means those connectors {or channel Groups) not presently installed in, or
connected to, an 8180A or 8180A/8181A system. If, before last switch off, the configuration included
only channels from say Extender 1, which has since been switched off or disconnected, then the dis-
played configuration will revert to the "default" of Channel 0-0 etc.

3R-5
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Model 8180/81A

Qperation

PAGES - HOW TO USE THEM

The following section gives more information
concerning PAGE control and then detailed
descriptions of all PAGES. The descriptions
include:each PAGES main features, how to
access them and what they mean.

NOTE: The term "value entry, when used in the
PAGE descriptions, can mean either a numerical
value, 4 specific condition or a mode.

The words shown under "GIVES ACCESS."e.g,
"value entry", AUTO etc. show the condition
arrived at directly after KEY WORD selection.
The words within brackets { ) excluding (value
entry) show the result of further SOFTKEY
operations. ‘

NOTE. (Applicable to several PAGES) if DATA
keys are used for 4 numeric integer entry then
entry can be with or without all leading zeroes.
Without all leading zeroes ENTER NUMBER
must be pressed, eg. 0012 or 12 + ENTER
NUMBER.

A softkey label comprising all capitals (upper
case letters) e.g, INSERT CHNL, means that the
setting is available or operative immediately
after softkey operation. A label with only initial

capitals, e.g. Clock Level, indicates that further-

softkey operations are necessary to access the
required setting.

For each PAGE, a detailed block diagram show-
ing softkey distribution and an example of the
display (for a 16 channel 8180A including 8
timing) is included. Where the PAGE display
details will differ when 8181A’s are connected,
an additional display example is included. For
the TIMING, OUTPUT and DATA PAGES, these
are on a separate fold-out page at the end of the
MACRO DATA PAGE section,

NOTE: Abreviations are used on the block dia-
grams to indicate the types of entry etc, they are
explained as follows:

DS -~ means a Direct Select entry
INR~ means a Numeric Real entry
NI -~ means a Numeric Integer entry

The meaning of them is explained later under
"Types of Entry".

PAGE Exiting

Before continuing with more practise of page
usage, note that selection of another one can be
made at any time simply by pressing the front
panel (CALL) "PAGES" key. This results in exit
from the current page and redisplay of the
PAGE menu. It can be done irrespective of
8180A current operating status.

PAGE REPORT/SOFTKEYS Mixing

The two remaining keys within the "SETTING"
group are (CALL) "SOFTKEYS' and "RE-
PORTS". These enable the report of one PAGE
to be combined with the softkeys of another (or
just the recall of softkeys or reports to make
changes or check settings).use of this feature can
be shown by selecting the CONTROL PAGE,
pressing (CALL) "SOFTKEYS" and selecting the
STORE/RECALL SOFTKEYS. This enables you
to call up and check, by reference to the CON-
TROL PAGE REPORT, the details of the stored
Sets and using them as required. Obviously, any
combination that you want can be configured.

The following video print shows an example of

REPORT/SOFTKEYS mixing: (CONTROL RE-
PORT and STORE/RECALL SOFTKEYS).

3R-7
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STORE/RECALL

Example of Report/Softkeys Mixing

REPORT ENTRIES

Any of the 8180A menu items can be easily
accessed and changed. Upon PAGE selection, the
report displays only those items which, under the
current operating conditions, can be assigned
new values.

Types of Entry

There are two distinct types of REPORT entry
possible - Numerical and Direct Select. Numeri-
cal entries can be made either via the INCRE~
MENT/DECREMENT SOFTKEYS or the
DATA keys. Direct Select entries can be made
only via the SOFTKEYS (the DATA keys are
disabled).

NUMERICAL entries include:

"Real” Integer and output data (logic code).

Entry Level SOFTKEYS which include a specific
numerical value eg, Load Impedance: 50 ) (on
the OUTPUT PAGE), are considered to be a
direct select type rather than numerical since the
value is fixed. Examples of all the entry types
will now be shown together with how to make
them.

DIRECT SELECT

For an example of this type of entry, select the
CONTROL PAGE and press Cycle Mode. The
current mode is shown and direct selection of a
new one is made simply by pressing the ap-
propriate softkey. :

Direct Select Entry Example

IR-8
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Model 8180/81A

NUMERIC Entry - REAL:

(TIMING PAGE example)

An example of 2 Numeric~Real entry can be
shown by first selecting the TIMING PAGE and
pressing Freguency, the parameter title, operat-~
ing lumits and current value will now be seen in
the Entry Fields and also the "ENTER NEW
VALUE" prompt. To change the value, use either
the INCREMENT/DECREMENT SOFTKEYS
or the DATA keys. If the DATA keys are used,
at value entry completion a units SOFT KEY eg.,
MHz must be pressed. Failure to do this will
mean that the value will not be accepted.

~ Operation

Numeric entry REAL Example

NUMERIC Entry - INTEGER:
(CONTROL PAGE example)

An example of this type of entry has already -

beenn covered in the "GETTING STARTED"
section, - changing the First Address. The Last
Address is changed in a similar manner.

MNumeric Entry INTEGER Example

3R-9
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Qperation

NUMERIC Entry -~ Qutput data:

{DATA PAGE example)

For an example of this, press the PAGES key
then DATA. The REPORT area shows, in the
first column, the addresses, then the Strobe data
content and finally the actual output data (or
logic code). Control of the CURSOR and/or
PICTURE is best understood by making a few
practise moves, the main point to be remembered
is that PICTURETT shifts the current sixteen
displayed lines up and replaces them with the
next sixteen numerically higher group. (PIC-
TUREvv enables the opposite Sequence).

Model 8180/81A

Numeric Entry Output Data Example

To change the value, first move the cursor to the
required change position, note that as it is moved
across the screen, when it lies on a binary coded
data chanel, the channel number (connector and
channel} is displayed in the top right hand corner
of the REPORT area. Data can now be entered
by pressing the appropriate DATA keys. The
operative keys depend on which data entry code
has been selected, for example if binary, then
only Oand i, if octal then 0 -7 etc.

The Output data example shows the cursor posi-
tioned for changing the data at address 0014 in
a binary coded data channel. The arrows directly
below the last line of data, and to the left of the
word "Entry", indicate that data entry or change
is allowed in each channel. (Further details of
this and other relevant information is given in
the DATA PAGE description - blue register.

JR-10
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Model 8180/81A

KEY WORD

First Address

Last Address

Cycle Mode

Break Control

Clock Source

Inputs

Operation

CONTROL PAGE
GIVES ACCESS TO xxxx, DETAILS ARE:

{value entry)
address where data outputs start, enter value either via INCREMENT/
DECREMENT or DATA keys

{value entry) .
address where data generation completed, value entry as for First Address
above,

AUTO
data generated continuously from First to Last Address.

INIT + AUTO
data generated from address 0 to First Address, then continuously from First
to Last Address.

SINGLE
data generated once only from First to Last Address.

GATED

Data generation starts when RUN input goes logic true and remains active
onty while RUN true, When RUN goes false generation contines to Last Ad-
dress then stops.

INIT + GATED

Data generation starts when RUN input goes logic true and remains active
only while RUN true. Data generated once from address 0 to First Address
then continuously generated from First to Last Address. When Run goes false,
generation continues to Last Address then stops. NOTE: In both of the GAT-
ED modes, all "BREAK" related functions are disabled.

Strobe Breaks

if ON, then each time a 1 is present in the STROBE data a "BREAK" occurs in
data generation at that address. MAN CLOCK Kkeys can then be used to step
forward or back. Strobe output mode (DATA/CLOCK) not important

Clock in Break
enables CLOCK 1 to remain active during "BREAK".

Value Entry

selectable INTERNAL, EXTERNAL POS or NEG’ SLOPE or MANUAL
{(MANUAL via MAN CLOCK FWD Kev),

Clock Source see KEY WORD: Clock Source

RUN, §STOP, BREAK
explained in "STATES", selectable OFF or ON positive or negative slope.

3R-11
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Operation Model 8180/81A

Impedance
50 Ohm or 1068 kOhm selectable, common for all inputs

Threshold
common to all inputs, to enter new value via DATA keys, VOLT Softkey must
be pressed for completion. .

Strobe Outputs {value entry)
Data or Clock selectable. Strobe Output can be used either as an additional
NRZ data channel or as a reference clock output.

Outputs on/off (value entry) .
all outputs automatically off until enabled on. When enabled, then all Outputs
are on. Warning at top of screen goes off when Outputs enabled. NOTE: Recall
of any Parameter Set (including Standard) will also cause the Qutputs to be
disabled.

R-12



https://www.manualsplus.com/

g1-¥t

uBq 8q

Hia gndup yealg pue Yealq vl [ 31D sYealq 9qong Jonuo) yeaag Sutpnjour

S[2G B[ Aay1Jos pue sjrejap wate J1odal urpuodsalios sy g poiqesp

a1% SUONOUN] Pale]Al ealq, [{8 UAY} P3IJ23[as ST apO 9[24D ALV, T J
[exuo) yeaig (I %

3 T ¥ T K 3
smdepee| L oapm | | | | wowema || pochy | Pty yowag | [Tacmuztons | | aetuy o | | sommos woom |
N, rd

sa 50

, 3 L
e s || || P | i | [mmom| [mwex swoms |
LN 7

nw._ wﬂ_ m__a m% _ﬂ "
[ ssomo o | |adarosoms] | wmedm | [ somos woom | {romwo gwag | | opow omko | | ssempev aser | | smeappy 3ena |

Tyt
I3%27u] orrewmpN - IN SAHOMAIM

129y oudwnN ~ UN
399195 1990 - s

uotnerado

Y ) [ w— ) o
o O vy S s I s

CTHHEILNT

LR

ToELHGD -

VIR/0818 [9POW


https://www.manualsplus.com/



https://www.manualsplus.com/

S1-ue (7uo s8uT)3as Aelop 10J) PN VI8 18 J1 AUo A[dde s£a3jos Jopua)g,

7 pue | I2puaixy (¥ &

‘Juoseld oI® S[oGE] SAANIJOS YIPIM 9} BOY] JBULIOS

7 SBY [PUUEYS U0 3SBA] 8 SB SUO| SV WUB[G 29 [[IA SA3Y1j0s pajelal

YIPIA [PUURYD Y30q 3Y) Uyl ZYN 10 %S =7 Y2 §t Jeulog Yo 1V, 3

‘11 Joj arqissod §1

A3yua \Y3pim ou Tyl ‘[IUUBYD ¥ IO PO JeuwrIo] ZUN 10 %0S=ZY I9yHs ;i
Jururiy, 1oUURYD (€ 5

-a(qeotjdde eq j0u 218 2InfI] SAOQE UL SAIN1JOS

JO M0I WI0}30q PUE IGE[IBAE 3q [[I4 SUOIIUNY PAIBIT FUTWH} [aUUEBYD

ou uay} (70 uondQ) Siauueys Jutwin, Yita pajiy 30U s VR 18 AUl JI
Surur ], uuey) (7 4

“UR[Q 9q [[IM S[eqe[ A931J08 PlBID0SSE A [, [Ludis }20[0 Fuipuodsalioo

ay3 10 arqussod ST A13U9 Ipis OU UL ‘pajoelas §1 JBWI0) %0¢ =27 I1
Furwry, Y2012 (1 »

[Pra/an3a +) .ﬁuzm,m& +) (axoN/A934 +)
HN HN
x*z mﬂ_ m%‘ + + ‘
J@G_~§u [wom w e ] [sommaw v] | Avoa o v | | [ wem | [ wwwos || E&M
N\ —~
zﬂ mm aﬂ x+z - m»a . mﬂ _
surns ., [ : Wwlog THROL Avted THOT
Pl w/ s | | wew zwor | [smooa peotn] | mvraa oo ] { 1 [som oo ]
m i C | (Zmems |t e ] Com o | [emmpow | [ wims | [ soweten |
N " (v) » (€ez) » (0 « ~
"4
SAHOMAI

Jafajuy oulawinN - IN
jeay SlIsuwInN -~ MM *

s s O o
19013 19311 - S

s s s o

ZHU 0t
BHINT L e

uonjetado

"] Iapuejxy Ioj se 2 lapuainy
1adino JEOWLS 943 0] paousrajal ‘enfea
AB[op UOWIWIOY B USAIZ 9q UBG S[OUUBYD BIBD (JRPULIO] ZWUN) S VIR IR Yl jo IV
Keap ~(A11ua anjea) 1 lapuaixyy

(£0$=Z4 10J S 31 8¥) Pa3a[ap s uonouny A13ua YIipim
9} UDdY] PRIOIAS JeWIO] ZWN JI SANIJOS XXXX Y IV Buisn £q yipim pue
JeULIO ‘AB[3(] JWEBS U241T 3Q WD S[AUUEBYD [[® OV -o[qissod st jewriod 7Z¥N
pu® $A931J0s [auUURY) Ad1g ‘TPuuBY) IXaN BIA dn pofjeo Ajejeredes 9q uEd [au
~UBYs ora jdesxs SUIWLY, ¥501) 107 svale s[1e3ap 9y] ‘siajawreied 231Y] I 10
Yipim ‘reuniog ‘Aejeq Supuyy, juyd

‘sug

- potiad JO %06 SPRasYa Yipim JI A, Sululesm 10119 jnq 9]GEIIEA an[eA [IPTM

(Z 40 T %D} YIPIM

pelelep AJII0e] AI1U9 YIPIA }00[D ‘porrad
%0S=UIpla %OS=ZY I0] ‘[0IIU0D YIPIM DUR AR[ap SMmO[[® Z¥ ‘%0S=Zd o Zd
Z 10 1 AD) yeuLiog

sugy] - porrad ¥(g SpPasoxe Av[a(y waym §, SUILIBam IO yon
-9pduron o] passazd aq 1snwr A9y1jos Sjrun, B ndino YHOWUILS 01 pesuarajal
(Z 30 1 M1D) Aeppd Supuly yoo[D
019 YIPIM ‘AB]
- yiam Apgriedwion syo01D TYNYALXA furwiirjuos 0] [njasn poiag “Fo
sanjea TVNYTLNI PaAedsip a3 (po[qestp TYNYHALNI 210J21213) 9A1398 401D
IVNYILXT 3 ‘pouiag pue Asuanbarg yloq o4 ALON Adusnbaij 10] se
{Al1us anjea) poliag

‘uorjardwos

I03 pessaxd 9q snw £271JOS SITUMY, B SA9Y VI V(] BlA 2n]BA mou SULIFIUD UM

{fa1ue anjea) Adusnboxy

HAV STIVLAA *XXXX OL $SFDODV SIAID qdIoM AT

"Pa10duu0D a3 (Y [g g JT Ajuo Ajdde sprejap
T Pu® | ISPUINXY "TOO UOLdQ Yita polyy sjuawnnisur 03 Ajuo Ljdde sprejep Bununy [euueyd HLON

dOVd DNINWIL

V18/0818 13poIN


https://www.manualsplus.com/



https://www.manualsplus.com/

L1-4¢

{o/Ex pnm +)
R S
mﬁl‘ soana | | Aswwmpes || epeoens | [aoess sl
N,
m% u_vn
ﬁud.o.vﬁfﬁnnn | | [wmaooom | | vwer poom |
man ) m% wﬂ
| oo | [ bawoman | | awvod soms | | reesy ewoms |
N\
1afajuy oLIAWAN - IN wam0>>>mx
129y oIaWION -~ HN :
199198 30911 -~ S DB as

S o s

uonjerado

‘apis pueylja} o} winjel yornb sarqeus Layyjos
~p=p AL (I JI0 DDV - 540y v1v( 2qesiidde inoj ayj jo suo ssaad uay)
(JustaAoW 30SInD Aq) jouuryd pasinbal Ay 109198 ‘Jaqe] € ufIsse O, 'sjeqe]
Os[® pue INFWHTINOD 0 TVIAHON JO JUWUuIsse a]qeua 219y s4ay3Jos 2L

sjutod [BI9UBD

HOVd VIV 298

"Uoljouny SYealq 9q03S, I VO 3108])9 oU sBY
Arred ou) INTWATIWNOD 10 TVINYON 03 195 2g uB0 Ajlre[od aqons oy,
LINAWATINOD 0 TYINHON

‘(uoryes110ads 998) TDF 0 7[LL 0} 198 2q UBD [9AS7] 9QOJIS oYL
2Qod1s “TDE 10 "1LL

INTWITAWOD 30 TYWUON s Ajixefod pue xjaqe) eia [eudis
¥3012 Yyoea 03 (S{aqe] JO WIOJ ayj uTl) pauZIsse 9g 0] S[9A3] 98BIIOA [QBUS 8L
Aijaejod pue [eae]

SAMOM AHY Jeqe] (WD, pue sinding
¥20[D, 298 sIndino [SUUBYD PUE H0O[2 0} S[eqe] jo judwulisse Joqf -pesseid 2q
uay) snwl FLOAJDAX T Inq apewr aq ABW S[9A3] "IDF 30 "TLL o Sunndut 1oaa1p
Paysta J1 TINAWAHOAA/ INAWAUINI 10 (I'JOA Iequiamial) sAay VIvQ
JoU31a BIA 3Q Ued AIjUd anfeA ‘YSIH <> M0l ssoid (Juifuryo anfea Ioj) pad]
YSTH J0 Mo I9YJI J09[95 O] 'S[2AD] ST SUIJOP 03 [oqe ] LXZN ®ia dn pay[es
S T8qQ®] Yo SE Plald AIjug oY} Ul umoys Suiaq SITUII] [9A3] 9y} UYIIM ]9AT]
MO0 B PUE YSIH B JO SISISU0D [9QET ‘}1 0} Poufise [9QBT B 2ABY ISNW [SUUBYD
indino Yoea pue 9[QRIIEAT 948 (] PUR D ‘g YV S[aqBT J0 sired [9A3] 98B1[0A 1IN0

sjutod [BIIUID)

porqeua sindino waym jjo

5303 W9a10s Jo doj j® Sutuiem ‘U0 POJQEUI [Ijun JJo A[euniou are syndino [V
(A13uo dnen)

'S[IEI9p 107 UOLBILJI0AdS 99 'VOR 18 o)

jo Aniqedes [eas] 98210 Indino ay3 sefurys NAJQ 10 WY 0§ JO UOI09[ag
{Aua anjea)

HYV STHV.LAC ¥XXX OL SSADDV SHAID

HOVd LAdLNO

1sqeT 1uy)

31juo) juyy

1efod aqo3g

[2Aa7] 20138

syading yool)

[9AR]

3o /uo dng

souepadwy pro]

Jdaom AdA

VI8/0818 I9PON


https://www.manualsplus.com/



https://www.manualsplus.com/

Model 8180/81A

Operation

DATA PAGE

NOTE: If the "fast reload" feature is being used (when programming) and a clock signal is required
during BREAK, use the AUTO cycle mode, not SINGLE cycle.

The following CURSOR and PICTURE softkeys enable the CURSOR to be positioned as required for
change of data (logic code) value. Enter data by pressing DATA keys, auto~(movement) of CURSOR
after data entry is determined by Entry Mode SOFTKEY, see (KEY WORD:) Edit features.

KEY WORD

CURSOR T

CURSOR ¥

PICTURE ™M /¥

<« CURSOR ~»

Top Address

Edit

GIVES ACCESS TO xxxx, DETAILS ARE:

enables CURSOR to be moved vertically upwards, either "step by step" or hold
key down for continuous movement. When CURSOR at top of screen, further
operation causes roll of data and address display.

as for CURSOR 7 except when at bottom of screen, further operation causes
roll of data and address display.

operation causes currently displayed sixteen lines to be replaced by next sixteen
numerically higher (PICTURE 1) or lower (PICTURE vv} group.
Step by step or continuous operation possible.

enables horizontal movement of CURSOR left or right. When CURSOR — at
limit of travel it jumps to beginning of next lower line, <~ CURSOR jumps to
end of next higher line for same condition. )

{value entry)

enables the address at top of screen (and therefore complete group) to be
changed to any required value, either via INCREMENT/DECREMENT or
DATA keys. (This enables a new display of data to be quickly called up).

Address Code
enables the code for address selection and display to be chosen from OCT,
HEX, or DEC.

Clear & Set, includes:

(Clear and Set Data, Clear Strobe)

enables all channels whether currently displayed or not to be cleared and set
ie, all current data to be replaced by O’s or I’s. Strobe can be cleared.

NOTE: All following Channel Edit functions are active only between First and Last Addresses.

Channel Edit, includes:

(Clear, Set, Copy Channel)

enables discrete channels to be cleared and set, individual channels to be copied
simply by moving the two cursors to required positions and pressing EX-
ECUTE. The <= =» softkeys control the movement of Entry Field and RE~
PORT area cursors.

IR-19
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Operation

KEY WORD
Edit

{continued)

Edit

3R-20

Model 8180/81A

DATA PAGE (continued)
GIVES ACCESS TO xxxx, DETAILS ARE:
{Channel Edit continued)

{Channel PRBS)

P.R.B.S{Pseudo Random Binary Sequence) enables a different random binary
pattern to be set in each channel. The same pattern will always appear in a
channel whenever PR.BS. is enabled.

{Up Counter and Down Counter)
enables a count up or down sequence to be set on data segments.

Line Edit - includes:

{Copy-Macro)

enables discrete lines of data which have been set up on the MACRO DATA
PAGE to be copied to any DATA PAGE line. The Macro number can be en~
tered only via the DATA keys after pressing PREV FIELD to enable number
entry. The currently active number entry area is shown in inverse video
{black digits on white background). Operation of NEXT FIELD gives access to
Line number entry, this can be made via INCREMENT/DECREMENT or
DATA keys. EXECUTE must be pressed for completion of the copy function.

(Copy Macros)

this functions in a similar manner to Copy Macro, except that a group of two
or more Macros {limit sixteen} may be copied as a "block” to a group of con-
secutive addresses (e.g., 0001~00035). Here, the Macro numbers are entered {via
DATA keys) by using the PREV FIELD and NEXT FIELD softkeys as neces-
sary, to enable entry. Line number entry is enabled by NEXT FIELD and can
be via INCREMENT /DECREMENT or DPATA keys. Note that only the first
Line number of the group is entered, the others are automatically allocated
depending on the Macro group size. The other operating details are as for
Copy Macro.

(Insert Line} (See also "Limit Address")

this enables additional ("set to zero"} lines to be inserted (one by one} in front
of the address entered (remember that address 1021 for example, is in front of
1022). The data of the entered line number, and all successive ones, is therefore
"moved" forward one line when EXECUTE is pressed. Line number entry is
either via INCREMENT/DECREMENT or DATA keys. The number of lines
which may be inserted without loss of original data depends on how far behind
the Last Address the Limit Address is. E.g., if Last Address = 0160 and Limit
Address = 0170 then 10 lines may be inserted without original data loss. The
Limit Address can be used to ensure that certain lines of data (those behind the
limit line} cannot be destroyed by new line insertions.
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Model 8180/81A Operation

DATA PAGE (continued)

KEY WORD GIVES ACCESS TO xxxx, DETAILS ARE:
Edit Line Edit continued:

(Delete Line) (See also "Limit Address”)

this enables specific lines of data to be deleted so that the original subsequent
lines are all moved back to fill the vacant area. Line number entry is as for
"Insert Line". Note also the significance of Limit Address as a safeguard for
data when deleting lines; lines numerically higher than the limit cannot be
"moved back".

{Copy Line}
this enables lines to be copied to other addresses. The active entry area i
controlled by the NEXT FIELD/PREV FIELD softkeys.

{Move Line)

This enables a line of data be moved from one address to another. The moved
line will be transferred to the new line, and the original lines will therefore all
be "pushed forward or back" one line, depending on the "Move" direction. Eg.,
A data segment contains sequential decimal coded data, with 02 at address
0002 and 06 at 0006. Line 0002 is then moved to 0006, now 02 will be seen
at address 0006 and 06, 05, 04 and 03 will each have moved back one position.

{Limit Address)

This 1s normally used in conjunction with the Insert and Delete Line functions,
to safeguard data situated "behind" the Limit Address. When it is made
numerically greater than the Last Address, by for example, 10 lines, this is
then the number of Line insertions that are possible without loss of currently
active data.

Edit CHECKSUM
This enables a check to be made at any time on whether the data has been
changed. When the softkey is pressed, a number is displayed. If at any time the
current data is changed, the value of the number shown when the softkey is
again pressed, will be different.

Entry mode

This enables either, the direction in which the cursor automoves after data
entry or, whether it should be "held", to be selected.

3R-21
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Operation Model 8180/81A

DATA PAGE (continued)

KEY WORD GIVES ACCESS TO xxxx, DETAILS ARE:;
Edit ey
{continued) Chnl Config (also applicable to OUTPUT and MACRO DATA PAGES) B

This inludes various features which allow the following to be done:

Enables the displayed data  configuration {not the  actual

output configuration) to be arranged as wanted for best PAGE effect. The

cursor movements are controlled by the %~ -» softkeys. Change of Connector

or Channel numbers of each Data Segment (a segment consists of one or more

columns of data separated by blank columns) is made via the DATA keys. The
currently changeable segment is highlighted by one line being in inverse video

in the REPORT area. P

NOTE:See (Code/Entry) for explanation of T under data segments
The features available include the following:

(INSERT CHNL)

enables additional channels to be added to existing Data Segments by moving
the cursor to the required position and pressing INSERT CHNIL. Note the
difference between making an insertion within a segment or at the end.
Within the Segment the same connector number and “reduced by one" channel
number will occur e.g., if present configuration

is: and insert made
2222 here, then result is: 22222
3210 32110

The flashing warning: "Dupl Chnl in Segment" occurs due to double occurence
as shown. Channel and connector numbers can be changed if wished via the
DATA keys.

If insert made at end of segment e.g.,

2222 result is; 22221
3210 32103 and no warning.

Note difference in new channel (1) and connector numbers (3} in second
example.
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Operation

Model 8180/81A

Extender related display examples.
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Model 8180/81A

Programming

PROGRAMMING INFORMATION

P-1 General

The following provides useful information and
examples (based on the HP 9826A or 36A) in
BASIC, on programming the 8130A. A complete
list of HP-IB commands is given at the end of
the Programming Information Section.

Although all the examples are valid for either
calculator, the following point should be noted:
The HP9826A screen width is 50 characters
whereas a line of information from the 8180A
screen is 535, Therefore, for the "talker mode"
examples & 9836A is recommended.

The &180A can operate as a talker or a listener
and has 2 remote modes of operation, these are:

ASCIT Mode -in which data, parameter and
mode settings are transferred over the HP-
IB as serial ASCII bytes. The ASCII message
is then interpreted by the 818CA and exe-
cuted accordingly.

Binary Mode -for fast transfer of binary
data between the HP-IB system controller
and the 8180A or vice~versa.

A description of the listener and talker functions
in each of these modes will be given. This infor-
mation is generally restricted to 8180A specifics,
and for detailed bus information , the user
should refer to one of the following publications:

IEEE Interface Standard 488-1975
ANSI Interface Standard MC1.1

HP Publication 5940{-90030

HP Publication 5952-00358

P-2 Address Assignment

When operating on the HP-IB, two address must
be reserved for 8180A use; the first is for AS-
CII-byte transfer, and the second for binary data
transfer. Both addresses are determined as fol-
lows by the setting of the rear panel HP-IB
switch:

ASCIE address = the actual switch seiting,
(factory preset to decimal 07)

Binary address = the ASCI address + |
{decimal 08 for factory setting above)

At switch on , the 8180A checks address bits Al
through A5 of the rear panel switch, to deter~
mine its current addresses, and displays both on
the MISCELLANEQUS PAGE. Call it up to
check the value if wished.

If it is necessary to change the addresses and the
81894 is not connected to a controller, just
change the bit settings of the rear panel switch
as required. If it is connected to a controller,
first ensure that the 8180A is in local mode,
then procede as above. For both cases, the new
address will be activated instantly.

Table P-1 lists all possible addresses on the bus.
WNote: if the rear panel address switch is set to
decimal 30, no binary transfer can take place
since address 31 is not allowed. The message
"HP-IB Binary Address ILLEGAL" will then be
displayed on the MISCELLANEQUS PAGE.
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Table P-1. Available Addresses (ATN true)

Available Addresses (ATN true)

Data bus (D IO lines) Address in ASCIE

Fized
8 76

5

Selectable Talk Listen
4 3 2 1DEC

QOQLOOCOLOOLCOOLOLOOOLOTCCLOOCODOOOOODDO
] bed ed ped wed bed med oed wed o] e e ] b b ] o] o] we] aed be] bd b s b o] ] ] b o] o] o]
el ol el e o o S S S S e ol e vl Gl Gl el ol el il andl wall ol il il

ek kb et pmed P ps s s Bus pus bt e s b e DD O O O O OO OO OLOOOO

—t e s o ot s 2 D D DO OO OO i i e et i e DO DT OOD O

SPACE
t
#
$
%
&
&~ 8180A set to this address
{ at factory.
) {decimal 7)
* {binary address=8)
+

2OD 3 O L B 0 e O

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29 =

30 >

3t} _  ?<---Forbidden settings.

3

/
0
1
2
3
4
5 <-~=~Usually controller address
6
7
8
9

b ok pu bk (O3 (0300 ) o o e OO0 O O b ek e et (3D (DD e ek b = D OO
— et (O OO bed pee O8O o = DO e O (O e e (O D e e D b e O ) = OO
o (D b (T 0D o OO e D e (O e O R 0 O o (D e (O b O (D e (O b O e ()

>“"‘/'_'N'<M$<.‘d*imm,o*ﬁczgr"?c“w”m@”ﬁmUOW}(@

UNT, UNL commands.

L
T

ot pin

for listen address, O for talk address
for talk address, 0 for listen address

HP-IB address settings on 81 80A rear panel switch.
{factory setting of decimal 7 shown)
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P-3 Service Request {SRQ)

Briefly, if any of the "front panel operation” type
errors is made f{see Sectn.3} or, for one of the
following reasons, an attempt is made to put the
8180A into an error condition, it will respond by
making a service request. Reasons include:

an incorrectly formatted statement or syntax
error, 4 "not possible” command thardware re-
guired not installed), or operator action via the
SRQ softkey. Any of these will result in the SRQ
control line of the HP~IB being set true and the
warning: SRQ being displayed at the top of the
8180A display area. To acknowledge the SRQ
(and delete the warning from the display), the
8180A should be "polled" by using the serial poll
sequence or,for the $826A by typing:

SPOLL(707) and pressing EXECUTE.

The 81 80CA will then for either case, put a status
byte on the data bus (DIO 0-8) and a number
will be displayed on the 9826A. From this num-
ber the actual type of error condition can be
determined.

A list of all Service Request Messages and an
example of how to "decode" a displayed number
is given in the HP-IB Commands list.

P-4 Local, Remote and Local Lockout

To return the 8180A to local control (from
remote), several possibilities exist, they include,
sending the GTL command (SEND 7, CMD 901),
commands specific to the 9826A eg LOCAL
707, initiating the 8180A power-up reset cycle
etc. To avoid the possibility of data transmission
being interrupted, which can happen if the
8180A is returned to local via the front LOCAL
softkey, it is recommended that local lockout be
set to disable the softkey.

This can be implemented either by, using a
9826 A specific command e.g,

LOCAL LOCKOUT 707, or sending CMD
1 {HEX), (typed as decimal 17). Local Lockout
remains in effect until the 8180A is returned to
the local state by switching off and on, or by
sending a 9826A specific command.

Programming

P-5 Notes on Programming

The following paragraphs will demonstrate the
basic principles of programming the 8180A the
examples included are based on the HP 9826A
{desk top) computer and BASIC as the program-
ming language. The examples demonstrate the
operation of the 8180A in the listener and talker
modes. These are the modes in which it can be
operated once remote has been initiated. The
first examples will demonstrate the listener
functions. The list of HP-IB commands, and
related information, should be referred to as
necessary since they are an integral part of the
programming procedure.

P-6 Listener Functions

Each PAGE of the 8180A hasa command to call
it up - a2 Menu Select command. PAG1 for ex-
ample, identifies the Control PAGE. More sig-
nificant are each PAGE’S unique set of com~-
mands which enable all of the associated settings
{0 be made, these can be parameter, mode or data
settings depending on the particular PAGE. In
addition to the PAGE related commands, there
are Operation commands such as RUN, STP etc.
which control &8180A operating status, and
Universal commands. (All of these are detailed
in the list of HP-IB Commands)

P-3
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P-7 Programming Examples

With the &1 80A and the 9826A interconnected
(via an HP-IB cable), and the BASIC program
loaded, a simple example of a one line "program"
can be demonstrated by typing the following line
into the 9826A:

QUTPUT 707'PAG1 RSS"
EXECUTE)
Explanation:

(then press

oUTPUT
This prepares the 9826A to output data (any
command etc.)

707
This is the device selector, it includes the inter-

face select code for the internal HP-IB - 7. and
the 8180A ASCH address - 07.

"PAGL RSS

This calls up the Control PAGE and recalls the
Standard Parameter Set. The Control PAGE
report details will be set accordingly.

Example 1: Control PAGE Seitings

Model 8§180/81A

If the "program" does not work.ensure that the
HP-IB cable is properly connected

Any of the PAGES can be called up and stan-
dard settings made, by using the same type of
statement.

In practise, a proper program will include several
lines or statements and some examples to demon -~
strate how to use some of the commands will
now be given. As will be seen, actual printouts of
the programs are used to clarify format and
syntax required etc.

It is recommended that the programs be
"stepped" through first (via the STEP key on the
9826A) and the resulting changes in the 8180A
display details observed. Note, PAGE settings can
be changed without always first calling up the
PAGE as is done in the following examples.

This example shows how to call up the Control PAGErecall the Standard Parameter Set, and then

change the value of some settings.

10 Gen=707
20 OUTPUT Gen;"PAGT"
30 QUTPUT Gen;"RS5"

40 OUTPUT Gen;"FAD 0002 LAD 0010"
50 QUTPUT Gen;"CYMZ, CLKZ, OUTZ®

60 QOUTPUT Gen;"THR +0,887V"
70 END

Explanation of specific lines:

10 This enables the abreviation Gen to be used in the program lines instead of having to type 707.
(707 can of course be used instead if wished)

20 puts the 8180A in the remote listen mode and instructs it to display the Control PAGE.

30 recalls the Standard Pa“rameter Set

40 sets the First and Last Addresses values to 0002 and 9010 respectively.

50 CYM2 - sets the Cycle Mode to SINGLE CYCLE; CLK2 - sets Clock Source to EXTERNAL and
POS SLOPE; OUT2 - sets the Outputs ON. b

60 sets Input Threshold to +0.9 V {two significant digits only)
P-4
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Example 2: Timing PAGE Settings

This example shows how to call up the Timing PAGE, recall the Standard Parameter Set, and change
the value of some timing parameters.

10 Gen=707

20 QUTPUT Gen;"PAG2"

30 OUTPUT Gen:"RSS"

40 QUTPUT Gen;“DEL 1C 10NS, WID 2C 30NS"
Eg gggPUT Gen;"DEL 01 10NS, DEL 02 20NS"

Explanation:

10,20~as for previous example except Timing PAGE called up.

30 asfor ™ "

40 DEL IC - Clock 1| Delay (set to 10 ns), WID 2C - Clock 2 Width (to 30 ns).
50 DEL 0l - Channel 0-1 Delay (set to 10 ns), (Delay Channel 0-2 to 20 ns).
Example 3: Output PAGE Settings

This example shows how to change Label Level values, set up a new channel configuration, and assign

Labels and Polarity to connectors and channels.

10 Gen=707 '

20 QUTPUT Geni"PAG3"

30 OUTPUT Gen: "RS5™

40 QUTPUT Geni“HILA 4.3V, LOLA 0.4V"

50 DQUTPUT Gen:® CAS BY 03 02 01 00: ADS ON 13 12 11 144
ADS HY 23 22 21 z20°

60 OUTPUT Gen:"LBB 03 LBC 12"

70 DUTPUT Gern:"COM 03,COM 02,C0M 01.NOR 0O, COM 137

g0  END

Explanation:
40 HILA 4.3V - Label High Level set to 4.3V, (Low Level set to 0.4V)

50 CAS - all segments (data channels} deleted and, (BY) a new Binary coded segment added with data
entry allowed (Y) in it, the new segment will be:
03 02 01 00 - Connector 0, channels 0-3,
ADS ON - add a segment, octal coded (Q), data entry not allowed (N),
13 12 11 10 Connector I, channels 0-3,
ADS HY - add a segment, hex coded (H), data entry allowed (Y},
2322 21 20 - Connector 2, channels 0-3,
ADS HY 23.. - add a segment, hex coded etc.

60 LBB 03 - Label B assigned to Connector 0, channel 3;
LBC 12 ~ Label C assigned to Connector 1, channel 2.

70 COM 03 - channel 3 of Connector 0 is set to Complement polarity etc.,
NOR 00 - channel 0 of Connector 0 is set to Normal polarity. P-5
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Example 4: Data PAGE Settings

This example shows how to set up a new channel configuration (same principle as for Qutput PAGE
example} and then set up various data patterns

10 Gen=707

20 QUTPUT Gen:"PAG 4,CLD,CLS"

30 OUTPUT Gen:;"CAS BY 23 22 21 20:6DS BN 13 12 11 10:
ADS HY 03 02 01 400"

40 OUTPUT Gen:;"FAD 0016 LAD 0020

50 O0QUTPUT Gen:"TAD 0008"

60 OUTPUT Gen;"SCD 23 SCD 20 DNC 3*

/70 PAUSE

80 OUTPUT Gen;"TSA 0009 CHD 22 0 1 0 1 ™

90 OUTPUT Gen:™T5A 0014 FOR 1 1111 B®

100 END

Explanation:

20 PAG4CLDCLS ~ Data PAGE called and all channel and strobe data cleared, (including channels

30

40

50

60

70

80

not currently displayed).

all segments (data channels) deleted from display and a new configuration set up, see Output
PAGE example for explanation.

new address values set.
TAID 0008 - Top address of display set to 0008,

SCD 23 - set all data (between FAD and LAD) of Connector 2 channel 3;
SCD 20 - ! " o2t 0

PAUSE - if in RUN the CONTINUE key should be pressed, (in STEP ignore),

TSA 0009 - Transfer Start Address = 0009,

CHD 22 0101 - data entered into channel 2 of Connector 2.

g0

TSA 0014 - Transfer Start Address - 0014,

FOR 1 1111 B - This is a formatted entry, the data following "FOR" must correspond exactly
with the actual channel configuration, including Entry YES~-NO and the data code of each seg-
ment. The first 1 sets the Strobe channel at address 0014, the next 1111 group sets the data bits of
the first segment at address 0014 to binary 1111, the following B sets the third segment to hex B.
The second segment is not changed since NO Entey is defined.
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P-8 Fast Binary Transfer

This mode, also called the "fast reload data
mode", enables data to be transferred extremely
quickly to or from an 818CA/8181A and a
suitable high I/0 rate, controller. An example to
show how much faster this mode can be com~
pared to-the normal one is as follows:

Normal mode ~ formatted (HEX) data, 16 chan-
nels X 1024 bits: 105

FFast Binary ~ unformatted data, 16 channels X
1024 bits: 400 ms

Example of Fast Binary Transfer

The following program example illustrates fast binary data transfer both to and from the controller
and the 81 80A. For the transfer from controller to 8180A, examples of two different transfer connec=
tor configurations are given but with the same displayed connectors being maintained. To clarify the
transfer of data from the 8180A back to the controller, the program includes a statement to “print"
(display) the data, which is stored. Refer to BINARY TRANSFER commands (in HP-IB COMMANDS
list) for further information if necessary.

ing
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Example 5: Fast Binary Transfer Controller to 8180A and vice-versa,

10
20
30
40
50
60
70
50

90

100
110
120
130
140
150
160
170
180
130
200
210

Gen _ascii=707
Gen_binary=Gen_ascii+]i

QUTPUT Gen_ascii:"PAG4.CLD.CL
OUTPUT Gen_asciii"CAS DY 23 2
DIM Buffer3i15]

FOR N=t1 70 15
BufferSIiNI=CHRT (N}

NEXT N

OQUTPUT Gen_asciiy"BS5C 0/1,B58 4,BTR 1
QUTPUT Gen_binary:Buffer® END

PAUSE

OUTPUT Gen_asciiy"CLD,BSC 0/3,.BSA 0F
QUTPUT Gen_binary:Buffer® END

PALISE

DIM A%[15]

OBUTPUT Gen_asciii"BSC 0/1.BS5A 07

ENTER Gen_binary USING "-K,%,#" A%
FOR N=1 70 15

PRINT USING "5X,DD":NUM(ASIN:TI)

NEXT N

END

02

,1AD 0"
2 21 204ADS DY 03 02 01 00"

Explanatioh of transfer from controller to 81 80A

10,20

30,40

50,60,
70,86

90

100

p~8

Instead of defining separate ASCIH and binary address values (reason for binary address
explained in paragraph 3-23), line 20 enables the 9826A to fix the binary value, in accor-
dance with the ASCII one. Therefore, if the ASCII address is ever changed, the binary one is
automatically corrected. You can if wished, directly define the binary address as 708.

These types of statements have already been explained in previous examples. Note that the
top address in the display is 0 and the new displayed channel configuration consists of
channels of connectors 0 and 2, decimal coded. (see Display Result 1)

These statements allocate storage in the controller for the data which is to be trans-
ferred etc. The data consists of the numbers | - 15 converted into binary.

Defines the start and stop connectors {channels) for data transfer ~

BSC 0/1 - connectors 0 and 1, and at which address to start - BSA 0.

A transferred data byte is always eight bits, therefore a minimum of 2
connectors (each having 4 channels) must always be defined. Note that in
the example the transfer connectors differ frome the displayed ones.

Outputs data to 8180A, "END" causes the 8180A output data to change and the display to be
updated. Note that only connector 0 segments change, connector 2 is not included within the
transfer group. Also, in this example, even if connector 1 was displayed no change would occur in
its data since the second 4 bits of each byte transferred are always all 0. {See Display Resuit 1)
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110 PAUSHE is included to enable the user to observe the next step clearly. If only single transfer from
controller to 81 80A reguired then make line 1 10 "END",

120 This clears all data and sets up a new transfer connector configuration of connectors 0 and 3

130 data output and display updated.(See Display Result 3) Note the difference in the 8180A display,
compared to that for the previous transfer. Since connectors 0 and 3 specified in line 120, con-
nectors 1 and 2 are alsoby definition included within the group (see pageP-19 for further ex-
planation of BSC command if necessary).

The data transferred is now "distributed over” connectors 0 and 2 because the new transfer group

is now 16 bits wide (for previous case it was only 8) and the last 4 bits of each byte {all 0's) are at
connectors | and 3,

Display Result 1 Display Result 2 Display Result 3

(BSC 0/1) (BSC 0/3)
ADDR STR DATA ADDR STR DATA ADDR  STR DATA
pooog F oo 00 4o 6ooo F 6 00 0 aaoo £ o 02 04
000t 0 06 00 000 0 o0 o0z 0001 0 04 032
noG2 g 00 00 anoz g 00 03 go02 0 086 05
G003 0 00 00 3603 0 00 04 0oGg3 0 08 97
0004 0 00 00 0004 0 00 0% 0004 0 10 09
000s g 00 00 G005 0 00 06 0005 g 12 11
3006 g 00 00 0006 0 00 07 0006 g 1413
0067 0 00 906 0oo7 0 00 08 0007 g 00 15
0ooe g 00 00 008 0 00 093 0008 o 00 00
0009 0 060 00 0003 g 06 10 0009 i 00 00
0610 00 00 0010 o o0 1 0016 g 00 00
0011 0 00 00 0ot g 0012 0011 0 00 00
0012 0 00 090 0otz o 0013 0012 0 00 00
0013 g 00 00 0013 0 00 14 0013 g 00 00
0014 0 00 00 0014 0 00 15 0014 0 00 00
0015 0 00 a6 0015 0 60 00 0015 0 00 00

Note: in all 3 above Display Results, displayed connectors are 0 and 2.
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Example of Transfer back to ControHler (part of main program)

140 PALUSE Display Result 4
150 DIM ASI15] !
160 QUTPUT Gen_ascii:"BSC 0/1.BSA 0" 3
170 ENTER Gen_bimary USING "-K,%,#":A% 3
180 FOR N=1 T0 15 7
190 PRINT USING “5X,DD":NUM(ASIN:11) 9
200 NEXT N H
210 END 13
15
0
0
0
Explanation of transfer back. "]
0
150 as for line 50 0
0

160 defines from which connectors data to be transferred.

170 data transferred with required image specifiers, (refer to a BASIC manual} briefly, significance of
these is : K - Freefield Entry; ¥ - terminate on EOI (or end of file); # - Supresses all statement
terminators.

180, statements to enable data transferred back to controller to be displayed
190, on its screen. See Display Result 4 and note how the "contents" of
200 connectors 0 and 1 are transferred back.

P-9 Talker Modes

The 8! 80A can send data messages of various types when in remote and addressed to talk. A complete
description of the six available "Talker" modes is given in the list of HP-IB commands . Some actual
program examples of them follow. The first example is for Talker mode | {TLK 1) and the others fol-
low sequentially through from TLK2 to TLK6. Note: the comments/explanations for these examples are
included within the program lines but are identified by a preceeding ", they have no function in the
actual program operation.

Example 1: Status -~ (TLK 1)

10 PRINTER IS 1

20 Gen=707

30 OUTPUT Geni"TLKT™

40 ENTER Gen:iA%

50 PRINT A%

b0 END

70  PTLK1: ENTERS THE 8180A STATUS AS FOLLOWS:
80 THW XXXX,Y,Z., HW=0:STOP: W=1:RUN: W=2:BREAK

90  IXXXX=ACTUAL ADDRESS IN SELECTED CODE

100 VIF NO ADDRESS THEN -1 DISPLAYED

110 1Y=HIGHEST CONNECTOR

120 VZ7=NUMBER OF TIMING BOARDS (EACH BOARD HAS
30 14 R7Z CHANNELS

P-10
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Example 2: Learn Mode - {TLK 2)

10 FPRINTER IS5 1

20 Gen=707

30 OQUTPUT Germ;"TLKZ2®

40 DIM BB{(8y[701

50 FOR I=t 10 8

60 ENTER Gent!B®(I)

70 PRINT Bs{(I)

80 NEXT I

S0 END

100 tTLKZ: ENTERS ALL STORED PARAMETER SETTINGS
110 FINTO A STRING ARRAY BS(1) TO B%(8) EACH
120 t70 CHARACTERS DEEP,.

130 INOTE: THIS INMFORMATION IS COMPRESSED AND NOT
140 HINTERPRETABLE BY THE USER. IT IS ONLY FOR
150 FSTORAGE PURPOSE ON A MASS STORAGE DEVICE
160 1AND FOR FAST RESTORAGE INTO THE GENERATOR.
170 DO NOT CHANGE A CHARACTER OF THIS SEQUENCE,

Example 3: Display Information - (TLK 3)

10 PRINTER IS 1

20 Gen=707

30 DIM Cs[1001

40  QUTPUT Gen:"TLK3,LINT"

50 FOR J=t T0O 26

60 ENTER Gen:;(C%

70  PRINT C%I1,501

30 NEXT J

90 END

100 VYTLK3: ENTERS ALL DISPLAY INFORMATION OF A
110 'SELECTED PAGE. '

140 'LIN: DEFINES THE FIRST LINE (1-263.

Example 4: Formatted Data - (TLK 4)

10 PRINTER IS 1

20 Gen=707

30 QUTPUT Gen:"TLK4 TSA3"

40 FOR K=1 7O 5

50 DIM Dsi10061]

&0 ENTER Gen:D%

70 PRINT D%

80 NEXT K

90 END

100 VTLK4: READS THE DATA MEMORY FORMATTED I.E.
110 {ACCORDING TO THE ACTUAL CHANNEL CONFIGURATION
120 'AND THE CODING.

130 ITSA3:DEFINES THE TRANSFER START ADDR AS 0003
140 1IN THIS CASE DATA OF ADDRESS 0603 TO 0007
150 IS TRANSFERRED.

Programming
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Example 5: Data Page Format - (TLK 5}

10
20
30
40
50
60
70
80
30
100
110
120
130
140

PRINTER IS 1

Gen=707

OUTPUT Gen:" RSS TLKL"

FOR L=1 T0 5

DIM Es{1003

ENTER GentE%

PRINT ES%

NEXT L

END

PTLKS: THE GENERATOR TALKS A STRING FOR EACH
FCHANNEL SEGMENT. THE STRING CONTAINS CODING
PINFORMATION AND ENTRY YES/NO INFORMATION
'PLUS THE CHANNEL CONFIGURATION.

PANOTHER STRING CONTAINS ADDRESS COUNTER

Example 6: String Error Detection ~ (TLK 6)

10
20
30
40
50
60
/0
80
50
100
110
120
130

PRINTER IS 1

Gen=707

OUTPUT Gen;"FAD 10 LAD 100 CYM B CLK(™
OUTPUT Gen;"TLKB"

ENTER Gen:iF%

PRINT F$%

END

PTLKG: IF AN SRO OCCURS, TLEG WILL SEND A
IMESSAGE CONTAINING A NUMBER. THIS NUMBER
PINDICATES THE CHARACTER POSITION IN THE
FOUTPUT STRING WHICH CAUSED THE ERROR,
FIN THIS CASE THE NUMBER IS 20. THE 20TH
YCHARACTER IS 6. CYM 6 DOES NOT EXIST,.

Model §180/81A
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8180 A HP-IB COMMANDS

" HP-IB Addresses

. The 8180A has two HP-IB Addresses, the ASCII Address is selectable by the Rear-Panel-Switch, (factory.
setting is decimal 7) and the Binary Address is the ASCIH Address + 1. All commands have to be sent to the
+ ASCIl Address and binary data can be transfered through the binary Address. Both Addresses are dis-
- played on the Misceilaneous Page.

Device Commands Definition

. GENERAL: All Alphabetical characters may be sent upper or lower case. Commands may be separated by
a Blank, a Comma, a Semicolon, 2 <CR><LF> sequence, and End Message or nothing, unless otherwise
. noted. Commands are sent to the ASCII Address.

: DEVICE COMMANDS: Every device command consists of three letters which then, except for Type £ com-
 mands, must be followed by further information - a single digit or a numeric value plus, where applicable,
units.

STANDARD NUMBER FORMAT: The standard number has the following format:
<N spaces><sign><M spaces><J digits>< K digits><L spaces><E<sign><P digits>>

NMK,L = any positive value including zero

J = 0to99

HK = }t099

P = 1 toany value, but the value of <P digits> < 100

Not relevant digits of J+K are cut off (no rounding)

Type E DIRECT EXECUTING COMMANDS :
This message is executed without any following information.

Type § DIRECT SELECT COMMANDS :
This command must be followed by a numeric digit to select the subfunction.

Type I INTEGER COMMANDS :
The command must be followed by a number which can be only in standard number format
{Type 11); or, {Type I2) by a number in either standard format if the DEC function is se~
lected or a Hex. number if HEX is selected, or an Octal number if OCT is selected.

P-13
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NOTE :

If a command is shown with one or more full stops following it e.g, FAD.. , UPC..etc., this indicates that

one or more further characters (numeric or alphabetical) have to be included, depending on the Type of
. command.

Type R REAL COMMANDS :
This command must be followed by a number in standard number format and one of the
following units:
HZ, KHZ or MHZ (Type R1) ; value only pos.
NS, US or MS (Type R2) ; only pos.
A% (Type R3) ; value pos. or neg.

Type C CHANNEL COMMANDS :
This command must be followed by a channel number in the form
<Connector><Channel>

a) where for (TypeS$ C1, C2, and C3) Connector is a hex character defining the Connector, Channel is a
digit between 0 and 3 defining the channel,

b) or (only TypeS C2 and C3) Connector is a digit 1 or 2 defining the clock channel, Channel is the -
letter C

¢} or (only Type C3) Connector is a digit 1 or 2 defining the Extender (8181A), Channel is the letter X

Type M MACRO COMMANDS
This Command must be immediately followed by a hex character defining the Macro.

MULTIPLE COMMANDS :
If more than one Type is specified at a command, the command must be followed by all
Types separated with the letter between the Types.

.........
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- Commands of the CONTROL Page

. First Address (Type 12} includes STP, if not CYM1! and RUN

Last Address (Type £2) includes STP, if not CYM! and RUN

Cycle Mode (Type S) includes STP

Auto
Single
Gated.
Init+Gated
Init+Auto

Strobe Breaks {Type 5)

Off
On

Clock Source {Type S)

Internal
External pos. slope
External neg. slope
Manual

. Clock 1 in break.___{Type 8)

Off
On

Input Impedance._._{TFype S)

50 Ohm
100 kOhm

| Input Threshold {Type R3)

. Runinput______ (TypeS)

Off
On pos. slope
On neg. slope

. StopInput_____(Type §)
; Off

On pos. siope
On neg. slope

Break Input {Type S)

Off
On pos. slope
On neg. slope

. Strobe Output {Type S}

Data
Clock

Outputs ON/OFF (Type S)

Off
On

FAD..
LAD...

{CYM]
CYM1
CYM2
CYM3
CYM4
CYMS5

[sTB]
STB1
STB2

[CLK]
CLK1
CLK2
CLK3
CLK4

[CAB]
CAB1
CAB2

[MP]
IMP1
MP2

THR..V

[RUI]
RUI1
RUI2
RUI3

[SPI]
SPI1
SPI12
sPi3

[BRI}
BRI1
BRiI2
BRI3

[STO]
STO1
STO2

[oUT]
OUT1
ouUT2

Programming
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Commands of the TIMING Page

Clock Frequency (Type R1)changes PER also FRQ..
Clock Period {Type R2) changes FRQ also PER....
Delay of Clock or Extender or Channel (Type C3 R2) DEL...
2.8, DEL 12 17 ns = Delay Conn 1 chann 2 17 ns

DEL 2C 14 ns = Delay Clock 2 14 ns
Format of Clock or Channel (Type C2 8§) FMT..
e.g. FMT IC | = Format Clock | RZ

FMT 02 2 = Format Channel §-2 RZ=50%

Width of Clock or Channel {Type C2R2) - WID....

Commands of the OUTPUT Page

Load Impedance___{Type ) fLIM]
50 Ohm LIM1
Open LIM32
Qutputs On/Off foUT)
High Level {modified Type R3) HIL.V
eg. High Level Label A=4.3V HILA 4.3V
Low Level {modified Type R3) LOL..V o
eg. Low Level Label D= -2.00V LOLD -2V ‘
Select Label for Channel or Clock (Type C2) LBx
e.g. Label B on connector 6 Channel 2 LBB612
Normal Polarity for Channel or Clock (Type C2) NOR
Complement for Channel or Clock {Type C2) COM
Strobe Level {Type 8) isTL]
TTL ' STL1
ECL STL2
Strobe Polarity. .. (Type 8} [SPO]
Strobe Polarity Normal SPO1
Strobe Polarity Complement SPO2
Clear and add Data Segment { See DATA page ) CAS....
Add Data Segment { See DATA page ) ADS..
Set Standard Configuration { See DATA page ) SsC
Strobe Yes Entry  (Type E) SYE
Strobe No Entry {Type E) SNE

P-16
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Commands of the DATA Page

Start Address for Data Transfer (Type I2)

Formatted Data (Data must be in the same format as displayed

.8

on the data page with no "NO ENTRY" Segments)
FOR 0 A3 4DE3 SF C257 0011 0001 1010 1101

The FOR statement must be limited by 2 " or " or <CR><LF>
After the delimiter the TSA Counter is automatically incre~
mented, so that the next FOR Statement without a new TSA
Statement enters data at the next address.

Enter Channel Data (Type Cl+Data). Select Address with TSA and

eg.

then send CHD+Channel number + data (0 or 1) for one or more
addresses.
TSA123 CHDO03 00101

Set Standard Configuration (Type E)

This commands sets standard Configuration on the Data Page.

~ Clear and add Segment to Data Page (Special Type)

[m=1 to 16) This Statement deletes all data channels and makes a
new segment containing I to 16 channels. The channel numbers
must be separated by " ¥ and preceeded by two characters defining
Segment Coding and Entry.

1. Character must be B (binary), D (decimal), H (hex) or O (octal).

2. Must be N (no Entry) or Y (ves Entry). Every blank must be
followed by a valid channel number, the command must be termi-
nated witha " "" or <CR>.

Eg. CAS HY 43 42 41 40 30; = Clear Data Page and make one
segment containing whole connector 4 and channel 30, in hex
coding with Entry "YES".

 Add segment to Data page { Special Type )

Same as CAS, but configuration is not cleared, that means
the segment is added to the present configuration.

Programming

TSA..

FOR...

CHD....

S8C

CAS...

ADS...

P-17
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oCT

Programming
Commands of the DATA Page continued
Address Coding Octal (Type E)
Address Coding Hexademical (Type E)
Address Coding Decimal (Type E)
Mo entry on Strobe (Type E)
Entry on Strobe (Type E)
Copy Macro (Type M/12) Changes TAD too
Copy Macros (Type M/M/12) Changes TAD too
Data Page Top Address (Type 12)
Clear Data (Type E)
Set Data (Type E)
Clear Strobe (Type E)
Clear Channel Data (Type C1)
Set Channel Data (Type C1)
Up Counter (Type I1)
I = Segment number
Down Counter (Type 11)
I = Segment number
PRBS on Channel (Type Cl)
Copy Channel (Type C1/C1)

insert Line
Delete Line
Limit Address
Copy Line

Move Line

{Type 12) Changes TAD also
(Type 12) Changes TAD also
(Type 12/12) Changes TAD also
{Type 12/12) Changes TAD also

{Type 12/12) Changes TAD also

HEX

- DEC

SNE

SYE

‘CMA...

CMS....
TAD..
CLD
SED
CLS
CCh.
SCD..

UPCl

DNCI

PRB.
cocC./.
ILL..
DLI...
LMA..
COL../.

MOV../.

P
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Commands of the MACRO DATA Page

Macro Data (Type M + same data format as the FOR Command).
There is no automatic Incrementation of the Macro

Programming

MAC

Commands of the STORE/RECALL Page

Recall Standard Set

The RSS message does (x = all possibilities: STP, FADQ,
LAD1023, CYMI1, STB1, CLKI1, THROV, IMPI, RUIL, SPIi,
BRI1, STO1STL2, OUT!, PERICONS, DELICONS, FMTICI,
WID{C40NS, DEL2CSONS, FMT2C2, WID2C10ONS, DEL (all
Channels)ONS, FMT (all Channels)3, WID (all Channels) 50 NS,
DEL (all Extender) ONS; LIMI, HILA.25V, LOLA~.25V,
HILBSV, LOLBOV, HILC-.8V LOLC-1.8V, HILD2.4V,
LOLD.8V, LBAxx, NORxx, S5C

. Store to Parameter Set (Type S);Digit = Set Number (1 to 3)

Recall Parameter Set (Type S); Digit = Set Number (1 to 3}
' The stored parameters are recalled and STP, OUT1 is executed.

Store to Address Set (Type S); Digit = Set Number (1 to 9)

- Recall Address Set (Type 8); Digit = Set Number {1 to 9}
The stored addresses are recalled.

RSS

PSS,

PSR,

ASS,

ASR.

- Commands for BINARY TRANSFER

Select Connectors to transfer Binary Data Transfer (Type 5/5)
First Digit selects the start connector of the word Second Digit
selects the stop connector of the word odd and even digits are
the same (one Byte=two connectors) 2. Digit must be greater or
equal to 1. Digit Example: BSC 0/7 Word consists of 4 Bytes;
First contains Data of Connectors 0 and 1, fourth of Connectors
6and 7

- Start Address for Binary Data Transfer (Type 12)

BSC./.

BSA..

P-19
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Model 8180/81A

Select Binary Transfer (Type S) [BTR]
Transfer Data BTRI1
Transfer Strobe Data BTR2
The BSC, BSA and BTR Commands are send to the ASCH Ad-
dress. In the BTR1 Mode, Data coming in through the Binary
Address is stored in the Data Memory from the BSA Address to
the Bytes defined by the BSC Command. The transfer terminates
at Address Change, Remote Change or EQl received. (EOIT is
recommended ). Next transfer starts again at BSA. In the BTR2
Mode Data is stored in the Strobe Memory from Address 0 to
1023, where one byte contains data for 8 addresses (DI01 of the
first word goes to Address 0, DIOS to Address 7 and so on). The
. transfer terminates under the same conditions as BTR!. Data at
the Ouiputs and on the Data page changes in both modes after
transfer termination.
A Binary Transfer has to contain at least 2 bytes.
Commands of the REMOTE MESSAGE Page
Select Line to display [4-23] or talk [1-26] (Type I1) LIN..
Display Text in Remote Message Page until <CR>. DsP...
After the DSP command the LIN value will be automatically
incremented. Information will be lost with next PAG or REP
command.
OPERATION Commands
Run {Type E) RUN
Stop {Type E} sTP
Break (Type E) BRK
Manual Clock Forward (Type E) FWD
Manual Clock Back (Type E) BCK
Stop and Run {Type E) SRU
Update Status and Address information (Type E) UPD

P-20
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MENU_Selecting Commands

Programming

Select Page (Type 8) {PAG]
: Control Page PAG1H
Timing PAG2
Output Page PAG3
Data Page PAG4H
Store/Recall Page PAGS
Miscellaneous Page PAGS
Macro Datz Page PAG7T
Select Report (Type S). [REP]
: Same as PAG, but will not effect the Softkeyset after
returning to local. :
Remote Message Report (Type S) REPS
Select Softkeyset (Type S). [KEY]
: Same as PAG, but will only effect Softkeyset after
returning to local.
UNIVERSAL Commands
' NOTE: For all of these commands the attention bus line {ATN) must be "true".
- Goto Local GTL(30D)
" Selective Device Clear (same as STP) SDC($04)
Group Exzecute Trigger (same as RUN, but execution within GET{30%8)
: 10 us, if impossible then SRQ 1§ will occur).
" Loc¢al Lockout LLOSE)
Device Clear (same as STP) DCL($14)
© Serial Poll Enable SPE(818)
* Serial Poll Disable SPD($19)

P-21
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SERVICE REQUEST Messages (Status Byte)

STATUS BYTE TITLE
(DIO line high significance)

DIC § Status is Break {updating every 50 ms or at UPD)

DIO 7 Request Service

DIO 6 Hardware or Compatibility Error

DIC 3 Status is Run (updating every 50 ms or at UPD)

DIO 4-1 Last Error Message (see list below for details)
4321

0 (0000) User Service Request from the SRQ Key

I (0G01) Syntax Error

2 {0010) Unexpected Unit

3 (0cln Statement not complete (missed number or unit)

4 (0100) String not terminated

5 (0101) Range Overflow

6 (0110) Hlegal Sign

7 (0111) fllegal Unit

g8 (1000) - Hardware not installed

9 (1001 Iliegal Channe!l Number

10 {1010) Entry not allowed

11 (1011) Formatter Error

12 {1100} Farameter Set Destroyed

13 (1101) Timing Incompatibility Error

14 (1110} Level Incompatibility Error {Swing Error)

15 (1111) GET either not at all, or not immediately executed

Exampie of SRQ interpretation:

Model 8180/81A

if, after polling, the number 99 is displayed by the controller, this can be related to the status bytes DIO ¢
to DIO B8 as shown below. The data input/output lines {DIO 1 to DIO 8) equate to an 8 bit binary number.
it is only necessary to convert the number displayed after polling to its 8 bit binary equivalent to enable

the high DIO lines to be identified.

99 = 64 + 32 + 3 = 01100011; this identifies the following high DIO lines:

% * % *
DIO8 DIO7 DIO6 DIOS DIO4 DIO3 DIO2 DIOI
¢ 1 1 0 0 0 1 1

In effect, the 4 least significant bits identify the actual error as:
3 - Statement not complete (missed number or unit)

Incompatibility Service Request Control
Enable SRQ 13 and 14, set SRQ if Error at command
Disable SRQ 13 and 14

Front Panel Service Request Control

Enable SRQ 0
Disable SRQ 0

pP-22
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TALKER Modes
Six ASCH Talker Modes are available {selected by the TLK (Type 8)) command:

8180A Status
81 80A Output: wiixx,v,Z
w is Status; 0=s5TOP, 1=RUN, 2=BREAK
xxxx% is Actual Address in the selected Address Code
v is Hex digit, defining the highest Connector
z is number of Timing Boards

Learn Mode .

Arrange a String Array of (8) [70] and fill this by sending TLK2
to the 8180A and then reading eight times from the 8180A. By
sending this array without modification and in the same order,
you can re-store the parameter setting, which was current at the
time of reading the string. By re-storing the data, Parameter
Set 3 will be loaded with this setting (old information lost).
Don't change any parameters while reading the actual
information,

Display Information
Select the first Line with the LIN command, then the display is
sent line by line. Channel Labels are sent in lower case letters, if
channel is Complement.

Formatted Data
8180A Qutput: TSA 0000 ; FOR 0 45 6AFE 3A FDIB 0000
1100 110G 0019 This Output can be used to directly restore the
data, if there are no "NO ENTRY" Segments in the Data Page:

Data Page Format
The 8180A talks first a CAS Segment, then a ADS Segment for
every additional segment, and at last OCT, DEC or HEX and
SYE or SNE.

Number of Character in String, where Error was detected
8180A Output: SRQ 013 (valid for Strings with max. 255 Ch.)

TLK1

TLKZ

TLK3

TLK4

TLKS

TLKG6

Programming

Binary Talking
Fast binary stimulus data transfer
Fast binary strobe data transfer

the inverse function of Binary listening. The 8180A must be
configured with the BSA, BTR and BSC commands and then
outputs, or talks, data or strobe data. The last data byte of ad-
dress 1023 is sent with EOL

[BIR]
BTE1
BTR2

P-23
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INTERFACE Functions

The following Interface Functions are implemented:

SH1 AH1 L4 SR1 RL! T6 PPODC1 DT1 CO E2

ALPHARETIC INDEX of Commands

ADS,
BCK ,
CAB,
CMA,
DCL,
FAD,
GET,
HEX ,
ILI,
KEY
LAD,
MAC,
NOR
OCT,
PAG ,
REP,
SCD,
SRU ,
TAD,
UPC,
WID

VEBOZZURSIQTMY OW»

g€cH

P-24

ASR ,
BRI,
CAS,
CMS,
DEC,
FMT,
GTL
HIL

IMP

LBxx
MOV

OUT
PER ,
RSS,
spC,
SSC,
THR ,
UPD

ASS

BRK ,
CCD,
CcocC,
DEL,
FOR ,

ISR

LIM,

PRB,
RUI,
SED,
STB,
TLK ,

BSA,
CHD,
COL,
DLI,
FRQ,

LIN,

PSR ,
RUN
SNE ,
STL,
TSA

BSC,
CLD,
COM,
DNC,
FSR,

LLO,

PSS

SPD,
STO,

BTR

CLK,

CYM
DSP
FWD

LMA,

SPE ,
STP,

Model 8180/81A

CLS,

LOL

SPI, SPO
SYE
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Performance Test

LS

SECTION 4

PERFORMANCE TESTS

4-1 INTRODUCTION

4-2 The test procedures detailed in this section
are for electrical performance of 8] 80A and
£181A units using the instrument specifications
of Table 1-2 as performance standards. Access
to the interior of the instruments is not neces~
sary for any of the following tests.

4-3 EQUIPMENT REQUIRED

-4~4 Equipment necessary for performance
testing is listed in Table 1~1, Recommended Test
Fauipment. Alternative test equipment may be
substituted for recommended models, provided
that it satisfies the critical specifications given in
the table.

4-5 TEST RECORD

4-6 When carrying out the performance tests, a
tabulated record of all the tested specifications
and their acceptable limits should be maintained
by the operator.

Test results recorded at incoming inspection will
provide a reference for periodic calibration,
troubleshooting and after-repair testing.

4-7 PERFORMANCE TESTS

4-8 During any performance test, all shields
and connecting hardware must be in place. All
tests are designed to verify the published
specifications. It is recommended that tests be
performed in the sequence given, and that all
data be recorded on a test record.

4-9 Each test is arranged in the order that its
specification appears in Table 1-2. Note that
the instrument should be given a 30 minute
warmup period before the commencement of any

of the following tests.
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4-10 CYCLE MODES / RUN / STOP / BREAK / FWD / BACK TESTS
DESCRIPTION

For testing the different cycle modes a low frequency (10Hz) is used to be able to follow the address
changes in the 81 80A display.

The external gate signal is simulated by changing the threshold level of the RUN (GATE) input.

First and last address detection at maximum speed is tested separately.

1. Program 8180A STANDARD SET (PAGES > Store/Recall > Rel Std Set > Execute)

2. CLOCK TREQUENCY 10 Hz (PAGES > Timing > Frequency > 10 > Hertz}
3. LAST ADDRESS 100. (PAGES > Control > Last Address » 100 > Fnter Number)

AUTO CYCLE TEST

4, Press RUN and check that the 8180A starts with address 0000 (upper right corner of the display}
counts up to address 0100 and continues with address 0000.

BREAK: FWID; BACK; STOP TEST
5. Press BREAK. The 81 80A should switch to Break.

6. Increment and decrement addresses by pressing FWD and BACK. Note: Addresses can be decre~
mented up to the first address.

7. Press RUN, The 8180A should start one address after the Break Address.
8. Press STOP and RUN. The 8180A should start with the First Address.

SINGLE CYCLE TEST

9. Program 8180A SINGLE CYCLE {PAGES > Control » Cycle Mode > Single)
10. Press RUN and check that the 8180A starts at address (000 and stops at addréss 0100

GATED CYCLE TEST

i1, GATED CYCLE; RUN (GATE) INPUT ON; THRESHOLD +5V (PAGES >
Control > Cycle Mode > Gated > Exit > Inputs > Run Input > On_/" > Exit > Threshold > § >
Volt}

12, Set threshold voltage to =5V (-5 > VolIt) The 8180A should run between address 0006 and 0100
as in auto cycle.

13. Set the threshold voltage back to +35V (5 > Volt) The 81&0A should complete the last cycle and
stop at address 0106

INIT + GATED CYCLE TEST
14. Program INIT + GATED (PAGES > Control > Cycle Mode > Init + Gated)

15. FIRST ADDRESS 30 (PAGHES > ( ntrol > First Address ~ 30 > Enter Number)
4-2 ‘
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16, INPUT THRESHOLD +5V (PAGES > Control > Inputs > Threshold > § > Voit)

17. Program the threshold voltage to =5V {~ 5 > Voit) and check that the §8180A starts with address
G000 runs up to address 0100 and continues cycling between address 0030 and 8100

18 Set threshold voltage back to +5V ( 5 > Volt) The 8180A should complete the last cycle and stop
at address 0100.

INIT + AUTO CYCLE TEST
19, Program INIT + AUTO (PAGES > Control » Cycle Mode > Init + Auto)
20. RUN INPUT OFF (PAGES > Control > Inputs > Run Input > Off)

21, Press RUN and check that the 8§180A starts at address 0000, runs up to address 010G and con-
tinues cycling between address 0030 and 0100,

Note: To repeat the whole sequence press STOP and RUN again.

4-11 LAST ADDRESS (ADDRESS DIFFERENCE COUNTER) TEST
DESCRIPTION

This test insures correct programrability of the address difference counters and proper operation up to
50 MHz.

I.  Program 8180A STANDARD SET (PAGES > Store/Recall > Rcl 5td Set > Execute)
2. CLOCK FREQUENCY 50 MHz {PAGES > Timing > Frequency > 50 > Megahertz)
3. SINGLE CYCLE (PAGES > Control > Cycle Mode > Single)

4, LAST ADDRESS 1 (PAGES > Control > Last Address > 1 > Enter Number)

5. Press RUN and check that the 8180 stops at address 0001,

6., Change Last Address to 2 (2 > Enter Number) press RUN and check cycle length.

7. Repeat single cycle test with following Last Address seftings:
8 16;32; 128 256;and 512,

4-3
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4-12 STROBE BREAK (STROBE DIFFERENCE COUNTER) TEST

DESCRIPTION

Correct programmability and proper strobe dafference counter function at 50 MHz is ensured with this
test. After setting the strobe breaks, the mnstrument is stepped from Break to Break.

I.  Program 8180A STANDARD SET (PAGES > Store/Recall > Rel Std Set > Execute)
2.  CLOCK FREQUENCY 50 MHz (PAGES > Timing > Frequency > 50 > Megahertz)‘
3. CLEAR STROBE (PAGES > Data > Edit > Clear & Set > Clear Strobe > Execute)
4.  STROBE BREAKS ON (PAGES > Control > Break Control > Strobe Breaks > On)

5. ENTRY MODE VERTICAL; HOLD CURSOR (PAGES > Data > Edit > Entry Mode > Vertical >
Hold Cursor > Exit > Exit)

6. TOP ADDRESS 0000. STROBE BIT to 1 (Top Address > 0 > Enter Number > Exit > 1)

7. Using the Cursor softkey move cursor to address 06001 and set strobe bit high by pressing the 1
key in the DATA entry field.

8. Set strobe bits to high in following addresses as described in step 7: 1; 2; 4; & 16; 32; 64; 128; 256;
and 51..

9. Press STOP and RUN. The 8180A should be in Break at address 0000.
10. Press RUN again and the 8180A should Break at address 0001,

I1. Check that the 8§180A breaks at addresses 2; 4; & 16; 32; 64; 128 256 and
512 and O each time after pressing RUN again.

4-13 INTERNAL CLOCK FREQUENCY TEST

SPECIFICATION

Accuracy: +/-5% of programmed value.

DESCRIPTION

The strobe output signal programmed as clock is used to measure the internal clock generator accuracy.

Clock timing errors coming up with standard set programmed and 50 MHz have no influence on the
strobe output. :

4-4
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B180n

EQUIPMENT

Universal Counter
Plug-on BNC Adapter

Clock and Strobe Cable Set

Counter

500w C O

A B £

15405
154228 from Strobe ot '

Figure 4-1 Clock Frequency Test Setup

INTERNAL CLOCK FREQUENCY TEST

1

HP §335A
HP [540%A
HP 15422A

Set counter trigger level to #1.2V and channel A input (z) to 50 Ohm.

Performance Test

2. Program &180A STANDARD SET (PAGES > Store/Recall > Rel S5td Set > Execute)
3. STROBE LEVEL TTL {(PAGES > Qutput > Strobe Level > TTL)
4.  STROBE QUTPUT CLOCK; OUTPUTS ON (PAGES > Control > Strobe Output > Clock > Exit >
Outp on/off > On) '
5. FREQUENCY 50 MHz (PAGES > Timing > Frequency > 50 > Megahertz)
6. Connect equipment as shown in figure 4-1 and press RUN,
7. Check 8180A internal clock generator at following frequencies for specifications.
8§180A Min. Max.
programmed to
50.0 MHz 47,50 MHz 52.50 MHz
25.0 MHz 23.75 MHz 26,25 MHz
10.0 MHz 9.59 MHz 10.50 MHz
9.99 MHz 9.49 MHz 10.49 MHz
3.0 MHz 2.85 MHz 3.15 MHz
1.0 MHz 0.95 MHz 1.05 MHz
1.05 Hz 1.00 Hz 1.10 Hz

4-5
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4-14

CLOCK AND DATA SKEW TEST

SPECIFICATION

Skew: <= 2 ns for clock and data channels.

DESCRIPTION

The test uses the least significant bit pattern (copied to all data channels) of a2 down counter to measure
the skew in reference to the strobe clock output. Clock and Data Delay are set to zero independent of
the instalied timing channels. This test uses TTL levels for all outputs and is valid also for the 8181A
NRZ data channels.

Stroba Oat

81808

Clock 1,2 or Data

Figure 4-2 Skew Test Setup

EQUIPMENT

Oscilloscope (275 MHz) HP 1725A
Plug~on BNC Adapter (2ea) HP 154094
Clock and Strobe Cable Set HP 15422A

Data Cable Set HP 15423A

L.

5

Set oscilloscope channel A and B to .5V/DIV; 50 Ohm; Timebase [0ns/DIV x 10;
ALTERNATE,; Trigger Channel B. '

Program 8180A STANDARD SET (PAGES > Store/Recall > Rel Std Set > Execute)

LABEL A TTL; STROBE TTL (PAGES > Output > Level > TTL Levels > Execute > Exit > Strobe
Level > TTL)

CLOCK | FORMATRZ = 50% CLOCK 2DELAY O ns FORMATRZ = 50%
(PAGES > Timing > Clock Timing > Clock 1 Format > RZ =50% > Exit >
Clock2 Delay > 0 > Nanosec > Exit > Clock 2 Format > RZ = 50%)

POWN COUNTER
(PAGES > Data > Edit > Channel Edit > Down Counter > -> [until the cursor is on least signifi-

cant data segment] > Execute > Exit)

6.

4-6

Press Copy Channel, move gray shaded cursor with the left -> to channel 00 and press Execute
softkey.
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7. Move bright cursor by using the right -> softkey to the next channel, then press Execute to copy
the high~low pattern of channel 00 to the next channel.

8. Repeat step 7 until all channels show the high~low pattern of channe] 00.

9. Program STROBE QUTPUT CLOCK,; OUTPUTS ON (PAGES > Control > Strobe Cutput > Clock >
Exit > Qutp on/off > On)

10. Connect equipment as shown in Figure 4-2 and press RUN,
1. Connect in turn Clock 1,Clock 2 and all Data channels to oscillocope channel B input. Then check
skew for +/~ lns referenced to the positive going edge of the Strobe Clock, measured at 50¥% of

amplitude.

Note: Take possible oscilloscope interchannel delay into account.

4-17
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4-15 CLOCK 1, CLOCK 2 DELAY TEST
SPECIFICATION
Accuracy: +/-5% of programmed value +/-1 ns

DESCRIPTION

The clock delays are referenced to the strobe clock output signal. Up to 10ns delay seftings are mea~
sured with a calibrated oscilioscope. Differences between scope and counter measurement results at 10
ns are compensated by offsetting the counter. [2] = Clock 2

Counter
2=50 otm 50 Ot
41808 (? Q Q Q
; i = 154094
i
Cleck 1 or Clock 7 Out }I
Figure 4-3 Clock Delay Test Setup
EQUIPMENT
Universal Counter HP 5335A
Oscilloscope HP 1725A
Clock, Strobe Cable Set HP 15422A
Plug-on BNC Adapter (2ea) HP 15409A

Time Mark Generator
Set Counter to:

Trigger level Aand B+ 1.2V
Time A~ B

Auto Trigger OFF

Gate Mode MIN

Channel Aand B_/, Z = 50 Ohm
Statistics MEAN

1. Program 8180A STANDARD SET
(PAGES > Store/Recall > Rcl Std Set > Execute)

2. PERIOD ! us (PAGES > Timing > Period > 1 > Microsec)

3. LABEL A TTL; STROBE TTL (PAGES > Qutput > Level > TTL Levels > Execute > Exit > Strobe
Level > TTL)

4, CLOCK 1 FORMAT RZ=50% CLOCK 2 DELAY Ons FORMAT RZ=50%
(PAGES > Timing > Clock Timing > Clock 1 Format > RZ=50% > Exit > Clock 2
Format > RZ=50% > Exit > Clock 2 Delay > 0 > Nanosec)

4-8
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5. STROBE OUTPUT CLOCK; OUTPUTS ON (PAGES > Control > Strobe Output > Clock > Exit >

OQutp on/off » On)

6. CLOCK 1 [2] DELAY IN SOFTKEY AREA (PAGES > Timing > Clock Timing > Clock 1 {2]

Delay)

7. Using the time mark generator, first check the oscilioscope time base accuracy in the 10 ns / DIV

x 10 range and note time base error, Take time base error and possible interchannel delay error

into account.

8. Connect equipment as shown in figure 4-3 press RUN and trigger the oscilloscope to channel A

(strobe clock).

9.  Using the increment softkey check step linearity up to 10.0 ns.

10. At 10.0 ns delay setting measure the delay between strobe and clock signal {at 50% of amplitude)

and note value.

11. Connect Strobe and Clock to the counter as shown in figure 4-3.

12. Program counter offset so that the value measured in step 10 is displayed.

Example: Measured delay (step 10} is 9.3 ns. The counter shows 10.5 ns. Press OFFSET > CHS >

[.2 > EEX > CHS > 9 > ENTER. The counter should display 9.3 ns.

1 3. Check clock delay programming at following settings:

Delay Setting Min. Max.

30.0 ns 27.5 ns 32.5ns
89.9 ns 84.4 ns 95.4 ns
90.0 ns 84.5 ns 95.5 ns
300 ns 284 ns 316 ns

14. Change 81 80A CLOCK PERIOD to 200ms and check delay at;
(PAGES > Timing > Period > 200 > Millisec > Exit > Clock Timing > Clock 1 [2] Delay)

Delay Setting Min. Max.
989 ns 938.5 ns 1039.5 ns
100 ms 95 ms 105 ms

15. Repeat steps 6 to 14 with Clock 2 connected and check for the same specifications.

4-9



https://www.manualsplus.com/

Performance Test

4~16 CLOCK 1 , CLOCK 2 WIDTH TEST
SPECIFICATION
Accuracy: +/-5% of programmed value +/=1 ns

DESCRIPTICN

Model 8180/81A

The clock width is measured at 50% of amplitude. To get accurate results in width ranges from 10ns to
100ns an oscilloscope with calibrated time base is used. Higher width ranges are tested with the counter.

{2]=Clock 2
Counker
R I
81808 Q0 Q0
] éls«m
[
i
y)
Ciock 1 or Clock 2 Out
Figure 4-4 Clock Width Test Setup
EQUIPMENT
Universal Counter HP 5335A
Oscilloscope HP 17254
Clock, Strobe Cable Set HP 15422A
Plug-on BNC Adapter HP 15409A

Time Mark Generator
Set Counter to
Trigger Level A and B +1.2V
Time A -> B
Gate Mode MIN
Common A; Z=50 QOhm
Channel A _/~
Channel BT\_
1. Program 81 80A STANDARD SET
(PAGES > Store/Recall > Rl Std Set > Execute)
2. Period lus (PAGES > Timing > Period > 1 > Microsec)
3. LABEL A TTL (PAGES > Qutput > Level > TTL Level > Execute)

4. QUTPUTS ON {PAGES > Output > Qutp on/off > On)

5. CLOCK | WIDTH 10 ns (PAGES > Timing > Clock Timing > Clock 1 Width > 10 > Nanosec)

4-10
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6. Using the time mark generator check first the oscilioscope time base accuracy in the 10 ns/DIV x
I[9and 10 ns/DIV rangs. Note error and take time base error into account.

7. Connect Clock 1 [2] output to the oscilloscope A input as shown in figure 4.4 and press RUN,

8. Measure the clock width at 50% of amplitude. Limit: 8.5 nsto [ 1.5 ng

9. Setthe irailing edge of the clock pulse to the left horizontal graticule line and check step linearity

when incrementing the width to 20 ns.

10. Check clock width at following settings:

Width Setting Min. Max.

30.0 ns 17.5ns 32.5ns
99.0 ns 93.0 ns {05 ns
100 ns 94.0 ns 106 ns

11. Change 8180A CLOCK PERIOD to 200ms

{PAGES > Timing > Period > 200 > Millesec > Fxit > Clock Timing > Clock 1

[2] Width)

12. Connect Clock output to counter channel A and check:

Width Setting Min, Max.
300 ns 284 ns 316 ns
399 ng 948 ns 1050 as
100 ms 95.0 ms 165 ms

13. Repeat steps 7 to 12 with Clock 2 connected and check for the same

specifications. :

Performance Test
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4-17 OPTION 002 TIMING CHANNEL DELAY TEST
SPECIFICATION

Accuracy: +/- 5% of programmed value +/-1 ns.

Counter
2450 Chin 50 Ghm
A B A [:§
S180R QQ Q Q
i i = 154000
it
t 3}
Strobe Out PR
3
OPT.002 Data Chamels  }

Figure 4-5 Delay Test Setup

EQUIPMENT

Universal Counter HP 5335A
Oscilloscope HP 1725A
Clock, Strobe Cable Set HP 15422A
Plug-on BNC Adapter (2ea) HP 15409A
Data Cable Set HP 15423A

Tims Mark Generator
Set Counter to:

Trigger Level Aand B +1.2V
Time A -> B

Auto Trigger OFF

Gate Mode MIN

Channel A and B _/, Z=50 Ohm

1. Program 3180A STANDARD SET
(PAGES > Store/Recall > Rel Std Set > Execute)

2. PERIOD lus (PAGE > Timing > Period > | > Microsec)

Model 8180/81A

3. LABEL A TTL.STROBE TTL (PAGES > Qutput > Level > TTL Levels > Execute > Lxit > Strobe

Level > TTL)

4. SET DATA (PAGES > Data > Bdit > Clear & Set > Set Data > Fxecute)

5. STROBE OUTPUT CLOCK; OUTPUTS ON (PAGES > Coatrol > Strobe Output > Clock > Exit >

Outp on/off > On)

6. Using the time mark generator check first the oscilloscope time base accuracy in the 10ns/DIV x
10 and 10ns/DIV range. Note error and take time base error and possible interchannel delay error

into account.
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7. Connect equipment as shown in Figure 4-5 and press RUN.

NRZ FUNCTION TEST

8. Check all OPT. 002 channels (timing channels) listed on the timing page for a static TTL high
fevel (>+2V),

9. Set AL_L CHANNEL FORMAT RZ (PAGES > Timing > Channel Timing > All Ch Format > RZ)
DELAY TEST

10, ALL CHANNEL DELAY 10 ns (PAGES > Timing > Chnl Timing > Al Ch Delay > 10 >
Nanosec)

1L, Vary ALL CHANNEL DELAY as listed below and check in turn all OPT. 002 channels for
specifications after each delay change.

All Channel Delay Setting Min. Max.

10.0 ns 8.5 ns 11.5 ns
30.0 ns 27.5ns 32.5 ns
89.9 ns 84.4 ns 95.4 ns
90.0 ns 84.5 ns 95.5 ns

12. Change CLOCK PERIOD to 200ms, connect counter and measure delay for all
channels at:

(PAGES > Timing > Period > 200 > Millisec > Exit > Chnl Timing > All Ch

Delay)

All Channel Delay Min. Max.

300 ns 284 ns 316 ns
989 ns 938.5 ng 1039.5 ns
100 ms 95 ms 105 ms
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4-18 OPTION. 92 TIMING CHANNEL WIDTH TEST
SPECIFICATION

Accuracy: +/~5% of progammed value +/-1 ns

Coumter
7 » 50 oim 30 O
A A A B
81468 Q (@] Q O
[ 154094
i
OP.002 Channels v

Figure 4-6 Width Test Setup

EQUIPMENT

Universal Counter HP 5335A
Oscilloscope HP 1775A
Data Cable Set HP 154234
Plug-on BNC Adapter HP 15409A

Time Mark Generator

Set Counter to:

Trigger Level A and B +1.2V
Time A ~-> B

Auto Trigger OFF

Gate Mode MIN

Common A; Z=50 Ohm
Channel A _/

Channel BT\_

1.  Program 8180A STANDARD SET
(PAGES > Store/Recall > Rel §td Set > Execute)

2. PERIOD 1 us (PAGES > Timing > Period > 1 > Microsec)

Model 8180/81A

3. LABEL A TTL; OUTPUTS ON (PAGES > Output > Level > TTL Levels > Execute > Exit > Outp

an/off > On)

4. SET DATA (PAGES > Data > Edit > Clear & Set > Set Data > Execute)

5. ALL CHANNEL WIDTH 10 ns

(PAGES > Timing > Chnl Timing > All Ch Format > RZ > Exit > All Ch Width >

10 > Nanosec)
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6. Using the time mark generator check first the oscilloscope time base accuracy in the 10ns/

DIVx10 and 10ns/DIV range and note error. Take time base error into account.

7. Connect equipment as shown in Figure 4-6 and press RUN.

8. Measure the WIDTH at 50% of amplitude and check, in turn, all OPT.002 Channels for each

width setting as listed below.

All Channel Width Setting Min. Max.

10.0 ns " 8.5ns 11.5 ns
30.0 ns 27.5 ns 32.5ns
99.0 ns 93.0 ns 105 ns
100 ns 94.0 ns 106 ns

9. Change 8180A CLOCK PERIOD to 200 ms

(PAGES > Timing > Period > 200 > Millisec > Exit > Chnl Timing > All Ch
Width)

10.Connect counter as shown in Figure 4-6 and check width for all OPT. 002 channels as listed.

All Channel Width Setting Min. Max.
300 ns 284 ns 316 ns
999 ng 948 ns 1050 ns
100 ms 95.0 ms 105 ms
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4-19 DATA HIGH / LOW LEVEL ACCURACY TEST
SPECIFICATION

Level aceuracy: +/- 0.5% of level +/- 60mV (add +/- 60mV for amplitudes < 1.5V)
DESCRIPTION

High and low level accuracy is measured with a digital voltmeter. All data channels are set to NRZ.
For measuring the high level all data are set 1o high. Low level is measured with data cleared (low)

Digital Voltmeter

B180R Q Q

= 1251~1277
154094

Figure 4-7 Level Accuracy Test Setup

Tata Channal

R

EQUIPMENT

Digital Voltmeter HP 3456A
BNC (f} to dual banana Plug PN 1251-2277
Plug-on BNC Adapter HP 15409A
Data Cable Set HP 15423A

HIGH LEVEL ACCURACY TEST

[.  Program 8180A STANDARD SET (PAGES > Store/Recall > Rel 5td Set > Execute)

2. SET DATA (PAGES > Data > Edit > Clear & Set > Set Data > Execute)

3. LOAD IMPEDANCE OPEN (PAGES > Output > Load Imp > Open )

4.  OUTPUTS ON (PAGES > Output > Qutp on/off > On)

5. LABREL A 1.OW LEVEL -2V, HIGH LEVEL -1V
(PAGES > Qutput > Level > Low <-> High [to low] > -2 > Volt > Low <-> High
[to highl > -1 > Volt)

6. Connect equipment as shown in Figure 4-7 and press RUN
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7. Measure output voltage with following high level seitings:

High level Setting Min. Max

-1.00 ¥V -0.875V -1.125v
0.00V ~0.060V +0.060 V
+1.00V +0.875V +1125V
+5.00V +4.375V +5.085V
+17.0V +16.86 V +17.15V

8. Repeat step 7 for all data channels.

LOW LEVEL ACCURACY TEST

9. CLEAR DATA (PAGES > Data > Edit > Clear & Set > Clear Data > Execute)

Performance Test

10, Set LABEL A HIGH LEVEL +17V, LOW LEVEL -2V (PAGES > Output > Level > Low <-> High

fto highl > 17 > Volt » Low <-> High {to low] > -2 > Volt)

11. Measure output voltage with following low level settings:

Low Level Setting Min. Max.

~2.00V -1.930V 20790V
~-1.00V ~0.935V ~-1.065V
goov ~0.060V +0.060V
+1.00V +0.875V +1.125V
+i60V +15.86V +16.14V

12. Repeat step 11 for all data channels

4-17
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4-20 20 MHz MEMORY TEST

DESCRIPTION

The 8180A memory can be tested with a Signature Multimeter up to 20 MHz. Start/ Stop conditions
for the 5005A are established with a high bit in the strobe channel. A pseudo random binary sequence Lo
which can be generated for each channel is used as test pattern.

Strobe Out Signature Multimeter
Fotock Love )
- o
81B0A
Q i
Start
; Timing Pod
G

Figure 4-8 Memory Test Setup

EQUIPMENT

Signature Multimeter HP 50GSA

Data Cable Set HP 15423A

Clock Strobe Cable Set HP 154224
Solder~in Receptacle ' HP 15412A

1. Program 81 80A STANDARD SET {PAGES > Store/Recall > Rcl §td Set > Execute)

2. CLOCK 1 FORMAT RZ 50 % DELAY 25 ns; CLOCK 2 DELAY 0 ns (PAGES > Timing > Clock
Timing > Clock 1 Format > RZ = 50 % > Exit > Clock 1 Delay > 25 > WNanosec > Exit > Clock 2
Delay > 0 > Nanosec)

. 3. PERIOD 50 ns (PAGES > Timing > Period > 50 > Nanosec)

4. LOAD IMPEDANCE OPEN; LABEL A TTL (PAGES > Output > Load Imp > Open > Exit > Level
> TTL Levels > Execute)

5. STROBE LEVEL TTL; OUTPUTS ON (PAGES > Output > Strobe Level > TTL > Exit > Cutp on/
off > Ony)

6.  CLEAR STROBE (PAGES > Data > Edit > Clear & Set > Clear Strobe > Execute)

7. PRBS CHANNEL 00 {PAGES > Data > Edit > Channel Edit > Channel PRBS > ~> {until PRBS
channel 00 is displayed] > Execute > Exit)

3.  COPY CHANNEL Press Copy Channel and using the -> softkey in the right half of the display
move cursor until Copy Channel 00 to 00 is displayed.

4-18
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9. COPY CHANNEL 00to ALL OTHER CHANNELS Press ( <-{right half of display] > Execute)
10. Repeat step 9 until all other channels are loaded with the PRBS pattern.

11, Set STRORE BIT to HIGH in address 0000 (PAGES > Data > Top Address > 0 > Enter Number >
Exit > 1)

12. Connect eguipment as shown in Figure 4-8 and press RUN,

13. Check all data channels for 46F9 signature.
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-4-21

SPECIFICATION

Threshold Accuracy: +/- 3 % of programmed value +/~ 50 mV

DESCRIPTION

Model 8180/81A

EXT. CLOCK, RUN, BREAK AND STOP HYSTERESIS/THRESHOLD TEST

A low frequency triangle signal is used to stimulate the 8180A external inputs. When the actual input
threshold level is reached, one or more clock pulses are generated or clock generation is stopped by the
8180A. Both signals, the triangle signal and the clock output signal are displayed on the oscilloscope.
The triangle level where clock generation is stopped or started is the actual input threshold.

Cable A connected tot
Break or Stop Input

Ciock,

Cable A
Cable B Pulse Gensrator _
o Run Inp Tee 56 Obwa
A -1
8180 Q Q@
. ,_’ J 154094
. e
1250~D080
2 Cable £lock 1 Ot
Figure 4-9 External Input Test Setup
EQUIPMENT

Pulse Generator

Oscilloscope

BNC TEE (2 ea)

Plug=-on BNC Adapter

BNC to BNC Cable Assy (2 ea)
BNC to BNC Cable Assy (2 ea)
Clock /Strobe Cable Set

BNC (f) to BNC (f) Adapter

HP 8007B

HP 1725A

P.N. 1250-0781
HP 154094

HP 1 1170C

HP 11170A

HP 15422A
PN. 1250-0080

1. Program 81 80A STANDARD SET (PAGES > Store/Recall > Rcl Std Set > Execute)

2. CLOCK | WIDTH 20 ns; CLOCK 2 DELAY 0 ns (PAGES > Timing > Clock Timing > Clock 1
Width > 20 > Nanosec > Exit > Clock 2 Delay > 0 > Nanosec)

3. LABEL A TTL; OUTPUTS ON (PAGES > Qutput > Level > TTL Levels > Execute > Exit > Outp

on/off > On)

4. INPFUT IMPEDANCE 100 K OHM
(PAGES > Control > Inputs > Impedance > 160 X Ohm)

5. CLOCK SOURCE EXTERNAL /™
(PAGES > Control > Clock Source > External _/")
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6. Set Pulse Generator to

Period approx. i{ms

Width .3 ms

Transition Susto 250 us
Amplitude 250 mVpp (into open)
Offset ON

7.  Adjust leading edge and trailing edge for a triangle waveform on the oscilloscope.

EXTERNAL CLOCK TEST

8. Connect equipment as shown in Figure 4~9 and press RUN. (BNC Cable A connected to Ext. Clock
Input)

9. Set oscilloscope channel A to 50 mV/DIV, and using the pulse generator offset vernier, set the
triangle waveform symmetrical to 0 Volt (center graticule line).

10. Set oscilloscope time base to 100 us and trigger to channel B (clock ).
The trace should start between - 50 mV and + 50 mV vert. deflection.
1l. Change EXTERNAL CLOCK SLOPE to \_
(External™_ )
The trace should start again between - 50 mV and + 50 mV vert. deflection.
EXTERNAL RUN AND BREAK TEST
12. Connect cable A to the Break input {cable B to Run input)

13, Set 8180A to CLOCK SOURCE INTERNAL; RUN INPUT _/7BREAK INPUT-\“
(PAGES > Control > Inputs > Clock Source > Internal > Exit > Run Input

> On _/ > Exit > Break Input > On"\_)
14, Set oscilloscope to ALTERNATE and trigger to channel A.

15, Measure the level of the triangle waveform at the point where clocks are generated (Run Input
Threshold) and at the point where clock generation is stopped (Break Input Threshold).

Threshold Limit: +/~ 50 mV
16. Set RUN INPUT \_; BREAK INPUT _/
(Exit > Run Input > On™ \_ > Exit > Break Input > On _/")
17. Measure the level of the triangle waveform where clock generation is stopped and started.

Threshold Limit: +/- 50 mV
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EXTERNAL STOP TEST
1 8. Connect cable A to the Stop mput (cable B to Run input).

19. Check threshold levels of the Stop input fer both slopes as described in steps 15 to 17 for the
Break input.

20. Set pulse generator triangle signal to approx. 8 Vpp amplitude symmetrical to 0 V. Check Clock,
Run, Break and Stop input thresholds at + 2 Volt and - 2 Volt threshold settings as described in
steps 5 and 7 to 19, (PAGES > Control > Inputs > Threshold > 2 [~2] > Volt)

Limits: L85 Vio 2,15V

Note: Check inputs only at one slope setting.
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4-22

TRANSITION TIME/OVERSHOOT TEST

SPECIFICATION

Transition Time: < 3.0 ns + lamplitudel x 0.2 ns
Preshoot, Overshoot, Ringing < +/- 10 % of amplitude

Bampling Scope

]

B140A

50 Ohm

Strobe Data Out

Figure 4~10 Transition Time/Overshoot Test Setup

EQUIPMENT

Sampling Oscilloscope with Accessories

Pulse Generator HP 8007R
Clock Strobe Cable Set HP 15422A
Data Cable Set HP 15423A
BNC Cable Assy HP 11170C

L.

2.

Program 81 80A STANDARD SET {(PAGES > Store/Recall > Re¢l Std Set > Execute)

ADDRESS 0000 all bits HIGH; ADDRESS 0001 all bits LOW. {PAGES > Data > Top Address > 0
> Enter Number > Exit > 1..funtil strobe and all data in address 0000 are set to highl > 0..[until
strobe and all data in address 300! are set to low])

LAST ADDRESS 000! (PAGES > Control > Last Address > | > Enter Number)

QUTPUT ON (PAGES > Qutput > Quip on/off > On)

LABEL A HIGH LEVEL ~1 V; LOW LEVEL -2 V (PAGES > Qutput > Level > Low <-> High
[High] > -1 > Voit > Low <-> High [Low] > -2 > Volt)

Connect equipment as shown in Figure 4~10 and press RUN.

Measure transition time from 10 % to 90 % of amplitude at all data channels. Specification; tr = <
Ins

Change LABEL A HIGH LEVEL to + 2 V; LOW LEVEL to 0 V (PAGES > Output > Level > Low
<-> High [High] > 2 > Volt > Low <-> High [Low] > 0 > Volt)

Measure preshoot, overshoot and ringing at all data channels.

Specification: < +/~ 10 % of amplitude.

Performance Test
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CANADA

Alberta

Hewlett-Packard {Canada) Lid.
3030 3rd Avenue N.E.
CALGARY, Alberta T2A 677
Tei: (403} 235-3100
ACHEME" MSP*
Hewlell-Packard (Canada) Lid.
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Tel: {403) 486-6666
A,CH,CM,CS,E MS.P

British Columbia
Hewiett-Packard {Canada) Ltd.
10691 Shelibridge Way
RICHMOND,

Sritish Columbia VBX 2W7Y
Tek: (804) 270-2277

Telex: 810-922-5059
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Manitoba

Hawleit-Packard {Canada) Lid.
380-550 Century Street
WINNIPEG, Manitoba R3H 0Y1
Tel (204} 786-6701
ACHOMEMS P

Nova Scotia

Hewlett-Packard (Canada) i1d.
P.0. Box 931

800 Windmill Road

BARTHOLTH, Nova Scotia 82Y 378
Tel: {902} 469-7820

CH,CM,CS.E* MS.p*

Ontario

Hewlett-Packard {Canada) Lid.
3325 N. Service Rd., Unil 6
BURLINGTON, Ontaric P3A 2A3
Tel: {416) 335-8644

CSM”

Hewlett-Packard {Canada) Lid.
552 Newbold Sireet

LONDCH, Ontario NBE 255

Tet: {518) 686-9181
A,CH,CME™ MS,P*
Hewlet-Packard {Canada) Lid.
6877 Goreway Drive
MISSISSAUGA, Ontario L4V M8
Tal: (416) 678-9430
A,CH,CM,CS,EMP,P
Hewleft-Packard (Canada) Ltd.
2670 Queensview Dr,
OTTAWA, Ontario K28 8K1
Tel: {613) 820-6483
ACH,CM,CS.E* MSP*
Hewlett-Packard (Canada) Lid.
220 Yorkiand Blvg., Unit #11
WILLOWDALE, Onfario M2J 1R5
Tel: (416) 499-9333

CH

Quebec

Hewlett-Packard (Canada) Lid.
17500 South Setvice Road
Trans-Canada Highway
KIRKLAND, Quebec HOJ 2M5
Tel: {514) 687-4232
ACH,CM,CS.EMP.P*
Hewlett-Packard (Canada) L1d.
Les Gateries du Valion

2323 Du Versont Nord

STE. FOY, Guehec G1IN 452
Tel: {418) 68T-4570

CH

CHILE

Jorge Calcagni y Cia. Lida.
Av. italia 634 Santiago
Casifla 16475

SANTIAGO @

Tel: 222.0222

Telex: Public Booth 440001
ACMEM

Clympia (Chite) Lfda.

Av. Rodrigo de Araya 1045
Casilla 256-V

SANTIAGD 21

Tel: (02} 22 55 044

Telex: 240-565 OLYMP CL
Cable: Olympiachite Sanliagochile
CHES,P

CHINA, People’s Republic of
China Hewletl-Packard Rep. Office
F.C Box 418

1A Lane 2, Luchang St

Beiwei Ad., Xuanwu Districl

BEIING

Tel: 33-1947, 33-7425

Felex: 22601 CTSHP CN

Cable: 1920

ACHCM,CS.EP

COLOMBIA
Insirumentacion

H. A Langebaek & Kier S.A.
Carrera 44 No. 524-26
Apartado Aeren 6287
BOGOTA 1, D.E.

Tel: 212- 1466

Telex: 44400 INST CO
Cable: AARIS Bogota
CMEM

Casa Humboldf Lida,
Carrera 14, No. 98-60
Apartado Aereo 51283
BOGOTA 1, D.E.

Tel: 256- 1686

Telex: 45403 CCAL CO,
A

COSTA RICA

Cientifica Costarricense S.A.
Avenida 2, Calle &

San Pedro de Montes de Oca
Apartado 10159

SAK JOSE

Tel: 24-38-20, 24-08-19
Telex: 2367 GALGUR CR
CMEM

CYPRUS

Telerexa Lid,

P.0. Box 4809

140 Stassinos Avenue
KICOSIA

Tel: 62698

Telax: 2894 LEVIDO CY
EMP

BENMARK
Hewiett-Packard A/S
Datavej 52

DK-3460 BIRKEROD
Tet {02) 81-86-40
Telex: 37409 hpas dk
A,CH,CM,CS EMSP
Hewlett-Packard A/S
Rolighedsvei 32
DK-8240 RISSKOV, Aarhus
Tel: (06) 17-60-00
Telex: 37408 hpas dk
CHE

DOMINICAN REPUBLIC
Microprog 8.4,

Juan Tomds Mejia y Cotes No. 60
Arroye Hondo

SANTO DOMINGO

Tel: 565-6268

Telex: 4510 ARENTA DR (RCA} P

ECUADOR

CYEDE Dia. Lida.
Avenidla Efoy Alfaro 1749
Casilla 6423 GO

aurre

Telr 450-975, 243-052
Telex: 2548 CYFDE ED
CHEP

Hospitalar 5.A,

Robles 625

Casila 3590

QuTo

Tel: 545-250, 545-122
Telex: 2485 HOSPTL. ED
Cable: HOSFITALAR-Quito
M

EGYPT

International Engineeting Assoclales
24 Hussein Hegazi Sireet
Kasr-el-Aini

CAIRO

Tel: 23829, 21641

Telex: {EA UN 93830
CHES.EM

EGYPOR

P.0.Box 2558

42 Fl Zabraa Sireel
CAIRO, Egypt

Tel: 65 00 21

Telex: 83 337

P

EL SALVADOR
IPESA de £1 Salvador 5.A.
29 Avenida Norte 1216
SAN SALVADOR

Tel: 26-6858, 26-6868
Telex: 20539 IPESASAL
ACHCMCSEP

FINLAND
Hewiett-Packard Oy
Revortulentie 7

PL 24

SF-G2101 ESPOO 10
Tel: (90} 4550211
Telex: 121563 hewpa sf
CHCM,CS.P
Hewlett-Packard Oy
{Otarinluoma 7}

Pt 24

02101 ESPOO 10
Tel: {90} 4521022
AEMS
Hewlelt-Packard Oy
Aatoksenkaty 10-C
SF-40720-72 JYVASKYLA
Tel: (941) 216318
CH

Hewlelt-Packard Oy
Kainvuntie 1-C
5F-80140-14 QULY
Tel: (981) 338785
CH

FRANCE
Hewlett-Packard France
Z|. Mercure B

Rue Bertheiot

F-13763 Les Milles Cedex
AX-EN-PROVENCE

Tel: 16 (42 59-41-02
Telex: 410770F
ACHEMSP*
Hewlett-Packard France
84, rue Marchand Saifian!
F-61000 ALERCON

Tel: 16 (33} 25 04 42

Hewleit-Packard France
Boite Postale 563
F-25026 BESANCON

28 rue de la Republique
F-25000 BESANCON
Tel: 16 (81) 83-16-22
CH.M

Hewletl-Packard France
13, Place Napoleon l
F-29000 BREST

Tel: 16 (98) 03-38-35
Hewlett-Packard France
Chemin des Mouilies
Boite Postale 162
F-69130 ECULLY Cedex (Lyon}
Tel: 16 (78) 833-81-25
Telex: 310617F
ACH,CSEMP
Hewlett-Packard France
Tour Lorraine
Boutevard de France
F-81G35 EVRY Cedex
Tel: 16 6§ 077-96-60
Telex: 6923 15F

E

Hewlett-Packard France

Parc d'Activite du Bois Briard
Ave, du lac

F-81C40 EVRY Cedex

Tel: 16 6 Q77-8383

Telex: 6823 15F

E

Hewlett-Packard France

§, avenue Raymond Chanas
F-38320 EYBENS (Grenobie}

Tel: 16 (76) 25-81-41

Telex: 980124 HP GRENOB EYBE
CH

Hewlett-Packard France
Centre d'Affaire Paris-Nord
Batiment Ampére 5 étage
Rue de la Commune de Paris
Boite Postale 300

F-93153 LE BLANC MESNIL
Tel: 16 (1) 865-44-52
Telex: 211032F

CH,CS,E,MS

Hewlell-Packard France

Parc d'Activités Cadera
Quartier Jean Mermoz
Avenue du Présiden! F Kennedy
F-33700 MERIGNAC (Bordeaux)
Tel: 18 {56) 34-00-84
Telex: 550105F

CH.EMS

Hewietl-Packard France
immueble “Les 3 B"
Nouveau Chemin de la Garde
ZAC de Bois Briand
F-44085 NANTES Cedex

Tel: 16 (40} 50-32-22

CH*
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FRANCE (Cont'd)
Hewletl-Packard France

125, rue du Faubourg Sannier
F-45000 ORLEANS

Tel: 16 (38) 68 G1 63

Hewleti-Packard France
Zone Industrielie de Courtabosuf
kvenue des Tropigues
F-81947 Les Ulis Cadex ORSAY
Tek {6) G07-78-25

Telex, 600048F
ACHCM.CSEMPP
Hewlett-Psckard France
Pans Porte-Mailiot

15, Avenue de 1" Amiral Bruix
F-75782 PARIS CEDEX 16
Tel: 16 (1 502-12-20
Telex: 613663F

CH,MS,P

Hewlett-Packard France
124, Boulevard Tourasse
F-84000 PAU

Tel: 18 (53) 80 38 02
Hewlell-Packard France

2 Aliée de la Bourgonnetie
F-35100 REMNES

Tel: 16 (99) 51-42-44
Telex: 740812F
CH,CM,E.MS,P*
Hewlett-Packard France
98 Avenue de Bretagne
F-76100 ROUEN

Tel: 16 {35} 6§3.57.66
CH* " CS

Hewieit-Packard France

4 Rue Thomas Marnn

Boite Postale 56

F-87033 STRASBOURG Cedex
Tel: 16 {88) 28-56-46
Telex: 890141F
CH.EMS,P*
Hewletl-Packard France

Le Péripole

20, Chemin du Pigeonnier de fa
Cépigre

F-31083 TOULOUSE Cedex
Tel: 16 (61) 40-11-12
Telex: 531639F
ACHCSEP®
Hewleti-Packard France

9, rue Baudin

F-28000 VALERCE

Tel 16 (75) 42 76 16
Hewlett-Packard France
Caroior

ZAC de Bois Briand
F-67640 VIGY Metz}

Teh 1648) 77120 22

CH

Hewiett-Packard France

immeuble Péricentre

F-59658 VILLENEUVE D'ASCQ Cedex
Tel: 16 (20} 81-4%-25

Telex: 16G124F

CHEMS,P*

GERMAN FEDERAL
REPUBLIC
Hewleti-Packard SmbH
Geschifisslelle
Keithstrasse 2-4

-1000 BERLIN 30

Tel: (030} 24-90-86
Telex: 018 3405 hpbin d
ACHEMP

Hewleti-Packard GmbH
Geschiftsslefie
Herrenbearger Strasse 130
D-7030 BOBLINGEN

Tek {7031) 14-0

Tefew:

A CHCM.CSE MP.P
Hewieti-Packard GmbH
Geschiftssielle
Emanuel-teutze-Slrasse 1
D-4000 BUSSELDORF

Tel: (0211) 587 1-1

Telex: G85/66 533 hpdd d
ACHCSEMSP
Hewlett-Packard GmbH
Geschiftssielle

Schieefslr. 28a

D-4600 DORTMUND-Aplerbeck
Tel: (0231} 45001

Hewlett-Fackard GmbH
Vertriebszenlrale Frankfun
Berner Strasse 117
Postfach 560 140
D-B00G FRANKFURT 56
Tek {0B11) 50-04-1
Tetex: (4 13248 hpfim d
ACH,CM,CSEMP,P
Hewleti-Packard GmbH
Geschifissielle
Aussenstelle Bad Homburg
Louisenstrasse 115
[-6380 BAD HOMBURG
Tel: {08172} 108-0
Hewleit-Packard GmbH
Geschiiftsstelle
Kapstadiring 5

£-2000 HAMBURG 60
Tel: (040) 638041
Telex: 621 63 032 hphh d
A,CHCSEMS,P
Hewlett-Packard GmbH
Geschifissielle
Heidering 37-39
D-3000 HANKOVER 61
Tel: (06511} 5706-0
Telex: 092 3258
ACH.CMEMS P
Hewlett-Packard GmbH
Geschifisstelle
Rosslauer Weg 2-4
D-6800 MANNHEIM

Tel; {0621} 70050
Telex: (462105

ACE

Hewlett-Packard GmbH
Geschiitssiele
Messerschmitistrasse 7
D-7810 HEU UM

Tek 0731-70241
Telex: 0712816 HF ULM-D
ACE"

Hewiett-Packard GmbH
Geschiflsstelle
Ehhericherstr, 13
D-8500 NURNBERG 10
Tel: (0911) 5205-0
Telex: 0623 860
CH,CM,EMS P
Hewlett-Packard GmbH
Geschifisstelle
Eschenstrasse 5
[3-8028 TAUFKIRCHEN
Tel: (088} 6117-1
Telex: 0524985
ACHCMEMS P

ALES & SUPPORT OFFICES

Arranged siphabetically by country

GREAT BRITAIN
See United Kingdom

GREECE

Kosias Karaynnis S.A.

8 Omirou Strect
ATHENS 133

Tef: 32 30 303, 32 37 371
Telex: 215962 RKAR GR
A CHOMOS EMP
PLAISIO 8.4

G. Gerardos

24 Stowrnara Street
ATHENS

Tel: 36-11-160

Telex: 221871

P

GUATEMALA

IPESA

Avenida Reforma 3-48, Zona §
GUATEMALA CITY

Tel: 316627, 314786

Telex: 4192 TELTRO GU
ALHCMOSEMP

HOMG KONG
Hewleit-Packard Hong Kong, Lid.
G.P.0. Box 785

th Floor, Sun Hung Kai Centre
3G Harbour Road

HORG KORG

Tel: 5-8323211

Telex; 66678 HEWPA HX
Cabie: HEWPACK HONG KONG
E,CHCS P

CET LI,

1402 Tung Wal Mansion
199-203 Hennessy Rd.
Wanchia, HONG KONG

Tel: 5-728376

Telex: 85148 CET HY

CM

Schmict & Co. {Hong Kongi Lid.
Wing On Cenire, 28th Floor
Connaught Road, C.

HONG KONG

Tel: 5-455644

Telex: 74766 SCHMX HX

AM

ICELAND

Elding Trading Company ine.
Hafnarnvoli- Tryggvagoty
P.0, Box 895
IS-REYKJAVIK

fel: 1-58-20, 1-63-03

M

INDIA

Compuier products are sold through
Blue Star Lid. Al compsster repairs and
maintenance service is done through
Computer Maintenance Corp.

Blug Star Lid,

Sabri Complex Il Floor
24 Residency Rd.
BANGALORE 560 025
Tel: 55660

Telox: 0845-430
Cable: BLUESTAR
ACH* CMCS*F

Blue Star Lid

Band Box House
Prabhadevi

BOMBAY 200 025

Tel: 4223107

Telex: 011-3751

Cable: BLUESTAR

AM

Bie Star Lid.

Sahas

414/2 Vir Savarkar Marg
Prabhadeyi

BOMBAY 400 025

Tel, 422-6155

Felex: 011-4083

Cable: FROSTBLUE

ACH CMUS EM

Blue Star Lid.

Kalvan, 18 Vishwas Colony
Alkcapuri, BORODA, 390 005
Tel: 65235

Cable: BLUE STAR

A

Blue Star Lig.

7 Hare Street
CALCUTTA 700 061
Tel: 12-01-31

Telex: 021-7655
Cable: BLUESTAR

AM

Blue Star Lid,

133 Kodambakxam High Road
MADRAS 600 034

Tel: 82057

Telex: 041-376
Cable: BLUESTAR

AM

Blue Star Lid.
Bhandari House, 7ih/8th Floors
871 Nehru Place

NEW DELHI 110 024
Tel: 682547

Telex: 031-2463
Cable: BLUESTAR
ACH" CM.C8" EM

Bive Star Lid,

15/16:C Wellesley Rd.
PUNE 411011

Tel: 22775

Cable: BLUF STAR

A

Biue Star Lid.
2-2-47/1108 Belgrum Rd,
SECUNDERABAD 500 (003
Tel: 72057

Telex: 0155-459
Cable: BLUEFROST
AF

Blue Star Litd.

T.C. 7/603 Poornima
Maruthankuzhi
TRIVANDRUM 695 013
Tel: 65799

Telex: 0B84:259
Cable: BLUESTAR

3

Compurter Maintenance Corporafioh
Lid. :

118, Sargjini Devi Boad
SECUNDERABAD 500 003

Tel: 310-184, 345.774

Telex: 031-2960

oo



https://www.manualsplus.com/

SALES & SUPPORT OFFICES

sa Arranged alphabetically by country
@

INDONESIA

BERCA Indonesia P.T.
P.0.Box 496/Jk!.

J. Abdut Muis 82
JAKARTA

Tel: 21-373009

Telex: 46748 BERSAL A
Cable: BERSAL JAKARTA
P

BERCA Indonesia P.T.
P.O.Box 2497/ ikt

Anlara Bldg., 17th Floor
J. Medan Merdeka Selatan 17
JAKARTA-PUSAT

Tel: 21-344-181

Telex: BERSAL 1A
ACSEM

BERCA Indonesia P.T.
P.0. Box 174/5BY.

J. Kutei No. 17
SURABAYA

Tel: 68172

Telex: 31146 BERSAL SB
Cabie: BERSAL-SURABAYA
A EMP

IRAG

Hewlett-Packard Trading S.A.
Service Operation

Al Manscor City 9B/3/7
BAGHDAD

Tel: 551-49-73

Telex: 212-455 HEPAIRAQ K
CH,CS

IRELAND
Hewlgli-Packard keland Lid.
82/8% Lower Leeson Street
puBLIN 2

Tel: G001 08800

Telex; 30439
A,CH,CM,CS.EMP

Cardiac Services Lid.
Kilmore Hoad

Arlane

DUBLIN &

Tel: (01} 351820

Telex: 30439

M

ISRAEL

Eidan Elacironic Instrument Lid.
P.0Box 1270

JERUSALE¥ 91000

16, Ohaliav St.

JERUSALEM 94467

Tel: 533 221, 553 242

Telex: 25231 AB/PAKRD K.

A

Eiectronics Engineering Division
Molorola lsrael Lid,

16 Kremenelski Street

P.C. Box 25016

TEL-AYIV 67899

Tal- 3 88 388

Telex: 33569 Motil Il

Cable: BASTEL Tel-Aviv
CHCM.CS.EMFP

ITALY

Hewiett-Packarc lialiana S.p.A
Traversa 99C

Via Givlio Petroni, 18

I-70124 BARI

Tel: (080} 41-07-44

M

Hewlet!-Packard ltafiana S.p.A.
Via Martin Luther King, 38/l
I-40132 BOLOGNA

Tel: (051} 402394

Telex: 541630

CH,EMS

Hewlell-Packard Italiana 8.p.A.
Via Principe Nicola 43G/0
95126 CATAMIA

Tel: {095) 37-10-87

Telex; 970291

CP

Hewleti-Packard ltaliana S.p.A.
Via G. I Vitlorko 9

|-20063 CERNUSCO SUL NAVIGLIO
{Milano)

Tek: (02) 523601

Telex: 334632
ACH.CM,CS.EMP 2
Hewlelt-Packard Halizna S.p.A.
Via C. Colombo 49

1-20080 TREZZARO SUL NAVIGLIO
{Mitano}

Tel: (02} 4458041

Telex: 322116

C.M

Hewietl-Packard liafiana S.p.A.
Via Nuova San Rocco a
Capodimonte, 82/A

[-80131 HAPOL

Tel: (081) 7413544

Telex: 710698

ACHE

Hewletl-Packard Italiana S.p.A.
Viaie G. Modugno 33

16156 GENOVA PEGLI

Tel: {010) 68-37-07

Telex: 215238

EC

Hewlsti-Packard Haliana S.p.A.
Via Pelizzo 15

[-35128 PADOVA

Tel: (049; 664888

Telex: 430315

ACHEMS

Hewielt-Packard Haliana S.p.A
Viale C. Pavese 340

1-00144 ROMA EUR

Tel: {C6) 54831

Telex: 610514
A,CHCM,CS E MS,P*
Hewletl-Packard liefiana S.p.A.
Via di Casellina 57/C

[-50018 SCANDICCI-FIRENZE
Tel: (055} 753863

Hewlett-Packard itafiana S.p.A.
Corso Svizzera, 185

1-10144 TORING

Tel: {011) 74 4044

Telex: 221079

CHE

JAPAN
Yokogawa-Hewletl-Packard Lid.
152-1, Onna

ATSUGH, Kanagawa, 243

Tel: (0462) 28-0451

CM.C* £
Yokogawa-Helweli-Packard Lid,
Meiji-Seimei Bidg. 6F

3-1 Hon Chiba-Cho

CHIBA, 280

Tel: 472 25 7701

E,CH.CS

Yokocgawa-Hewlelt-Packard Lid.
Yasuda-Seimei Hroshima Bidg,
6-11, Hon-dori, Naka-ku
HIROSHIMA, 730

Tel: 82-241-0611

Yokogawa-Hewlett-Packard Ltd,
Towa Building

2-3, Kaigan-dori, 2 Chome Chug-ku

KOBE, 650

Tek {078) 352-47¢1

CE

Yokogawa-Hewiett-Packard Ltd.
Kumagaya Asahi 82 Bldg

3-4 Tsukuba

KUMAGAYA, Saitama 3680

Tl (0485) 24-6563

CH,.CM,E
Yokogawa-Hewlett-Packard 116,

Asahi Shinbun Daiichi Seimel Bldg.

4-7, Hanabala-cho
KUMAROTO,860

Tel: (0963) 54-7311

CHE
Yokogawa-Hewlelt-Packard Lid.
Shin-Kyoto Center Bldg.

914, Higashi-Shiokoji-cho
Karasuma-hishiire

Shiokofji-dori, Shimogyo-ku
KYQTQ, 60C

Tel: 075-343-G921

CHE
Yokogawa-Hewiett-Packard Ltd.
Mito Mitsui Bidg

4-73, Sanno-mary, 1 Chome
MITQ, tharaki 310

Tel: {0292) 25-7479

CH,CM,E
Yokogawa-Hewlett-Packard Lid.
Sumilomo Seimei 14-9 Bldg.
Meieki-Minami, 2 Chome
Nakamura-ku

NAGOYA, 450

Tel: (052} 571-5171
CH,CM,CS,EMS
Yokogawa-Hewlett-Packard Lid.
Chuo Bldg.,

4-20 Nishinakajma, 5 Chome
Yodogawa-ku

OSAKA, 532

Tel: (08) 304-6021

Telex: YHPOSA 523-3624
ACH.CM.CS.EMP P
Yokogawa-Hewleli-Packard Lid.
27-15, Yabe, 1 Chome
SAGAMIHARA Kanagawa, 229
Tel: 0427 59-1311
Yokogawa-Hewlett-Packard L.id.
Daiichi Seimei Bidg.

7-1, Nishi Shinjuku, 2 Chome
Shinjulca-ku, TOKYD 160

Tel: §3-348-4611

CHE
Yokogawa-Hewiett-Packard Lid.
29-21 Takaido-Higashi, 3 Chome
Suginami-ku TOKYQ 168

Tek: (03) 331611

Telex; 232-2024 YHPTOK
ACHCM,CS.EMP P
Yokogawa-Hewleti-Packard Lid.
Dafichi Asano Bullding

2-8, Qdori, 5 Chome
UTSUNOMIYA, Tochigi 320

Tel: {0286) 25-7 155

CH,CSE

Yoxogawa-Hewiel-Packard 1id.
Yasuda Selmei Nishiguchi Bidg.
30-4 Tsuruya-cho, 3 Shome
YOKOHAMA 221

Tel: {345) 312-1252

CH,CM.E

JORDAN

Mouasher Cousing Company
P.0. Box 1387

AMHAN

Tel- 24907, 39307

Talex: 21456 SABLO JO
CHEMF

KENYA

ADCOM Lid., Inc., Kenya
P.O.Box 30070
NAIROBI

Tel: 331955

Telex: 22639

EM

KOREA

Samsting Elgctronics HP Division
12 Fl. Kinam Bidg.

San 75-31, Yeoksam-Dong
Kangnam-Ku

Yeongdong P.0. Box 72

SEOQUL

Tel: 555-7555, 555-5447
Telex: K27364 SAMSAN
ACHCMCSEMP

KUWAIT

Al-Khaldiya Trading & Contracting
P.0. Box 830 Safat
KUWAIT

Tei: 42-4910, 41-1726
Telex: 22481 Areag ki
CHEM

Photo & Cine Equipment
P.0. Box 270 Safat
KUwaAITY

Tel: 42-2646, 42-3801
Telex: 22247 Malin ki
I

LEBANON
G.M. Dolmadfian
Achrafieh

P.O. Box 165.167
BEIRUT

Tel: 290293
MR

Computer Information Systems
P.0. Box 11-6274
BEIRUT

Tel: 89 40 73
Telex: 22259

c

LUXEMBOURG
Hewlet!-Packard Beigium S.A/NY.
Blvd de la Woluwe, 100
Woluwedal

B-1200 BRUSSELS

Tel: {02) 762-32-00

Telex: 23-484 paloben bry
ACH,CM,CS.EMP.P

MALAYSIA -
Hewlelt-Packard Sales (Malaysia)
Sdn. Bhd.

1st Floor, Bangunan British
American

Jalan Semanian, Damansara Heights
KUALA LUMPUR 23-03

Tel: 943022

Telex: MA310t1

ACHEMPF*
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MAYLAYSIA {Cont’d)
FProtel Engingering

PO Box 1917

Lof 6624, Section 64

23/4 Pending Road
Kuching, SARAWAK

Tel: 36299

Telex: MA 70904 PROMAL
Cable: PROTELENG

AEM

MALTA

Philip Toledo Lid.
Notabite Rd.

MRIEHEL

Tel: 447 47, 455 68
Telex: Media MW 648
EP

MEXICO

Hewlett-Packard Mexicana, S.A.
de C.V.

Av. Periferico Sur No. 8501
Tepepan, Xochimilco

16020 MEXICO B.F.

Tel: 6-76-46-00

Telex: 17-T74-507 HEWPACK MEX
ACHLSEMS P
Hewielt-Packard Mexicans, S.A.
de C.V.

Ave. Colonia del Valle 409

Col. del Vake

Municipio de Garza Garcia
HMONTERREY, Nuavo Leon

Teh 78 42 41

Teiex: 038 410

CH

ECISA

José Vasconcelos No. 218

Col. Condesa Deleg. Cuauhtémoc
HEXICO D.F. 06140

Tel: 553-12086

Telex: 17-72755 ECE ME

L

MORQCTO
Dolbeau

81 rue Karatchi
CASABLANCA

Tel: 3041-82, 3068-38
Telex: 23051, 22822
E

Gerep

2 rue d'Agaci

Bolle Postale 156
CASABLANCA

Tel: 272093, 272095
Telex: 23 739

P

NETHERLANDS
Hewlett-Packard Nederlang B.V.
Van Heuven Goedharflaan 121
NL 1181KK AMSTELVEEN

P.0. Box 687

ML 1180 AR AMSTELVEEN

Tel: {020} 47-20-21

Telex: 13 216 HEPA WL
ALCHCMCSEMPP
Hewlett-Packard Nederland B.Y,
Bongerd 2

NL 2906VK CAPELLE A/D JSSEL
P.0. Box 41

NL 2900AA CAPEELE A/D) IJSSEL
Tel: (10) 51-64-44

Telex: 21261 HEPAC NL
ACHCSE

Hewlelt-Packard Nederland B.Y.
Pastoor Pelerssiraat 134-136
NL 5612 LV EINDHOYEHN

P.0O. Box 2342

NL 5601 CH EINDHOVEN

Tet {0403 326611

Tetex: 51484 hepae nl

ACH"* EM

HNEW ZEALAND
Hewlett-Packard (N.Z.) Lid.

5 Owens Road

£.0. Box 26-189

Epsom, AUCKLAND

Tel: 687-159

Cable: HEWFACK Auckland
CH,CMEP®

Hewlett-Packard {N.Z.) Ltd.
4.12 Cruickshank Street
Kilbirnie, WELLINGTON 3

P.0. Box 9443

Courtenay Place, WELLINGTON 3
Tel: 877-198

Cable: HEWPACK Weliiagton
CH.CMEP

Norlbrop Instruments & Systems Lid.
369 Khyber Pass Road

P.0. Box 8602

AUCKLAND

Tel: 794-091

Telex: 60605

AM

Northrop Instruments & Systems Lid.
170 Mandeville 51

P.0. Box 8388

CHRISTCHURCH

Tel: 486-928

Telex: 4203

AM

Northrop Inskruments & Systems Lid.
Sturdee House

85-87 Ghuznee Street

F.0. Box 2406

WELLINGTON

Tel: 850-091

Telex: NZ 3380

AM

NORTHERN IRELAND
See United Kingdom

NORWAY
Hewielt-Packard Norge A/S
folke Bernadoties vei 50
£.0. Box 3558

N-B033 FYLLINGSDALEY {Bergen)
Tel: 0047/5/16 55 40
Telex: 18621 hpnas n
CH,CSE,MS
Hewiett-Packard Norge A/
Osterndalen 16-18

P.C. Box 34

N-1345 OSTERAS

Tel: 0047/2/47 11 80
Telex: 16621 hpnas n
ACHCMCSEMP

OMAN

Khimiil Ramdas

P.0. Box 18

MUSCAT

Tel: 722225, 745601

Telex: 3289 BROKER MB MUSCAT
P

Suhail & Saud Bahwan
P.0.Box 169

MUSCAT

Tel: 734 201-3

Telex: 3274 BAHWAN MB

SALES & SUPPORT OFFICES [

Arranged alphabetically by country ﬁéﬂ]

PAKISTAN

Mushio & Company Lid,
1-B, Street 43

Sector F-8/1

ISLAMABAD

Tel: 51071

Cable: FEMUS Rawalpindi
AEM

Mushko & Company Lid,
Oosman Chambers
Abduliah Haroon Road
KABACHI 0302

Tel: 524131, 524132
Telex: 2894 MUSKO PK
Cable: COOPERATOR Karachi
AEME"

PANAMA

Electronico Balboa, S.A.
Calle Samuel Lewis, Fd. Alla
Apartado 4929

PANAMA 5§

Tel: 63-6613, 3-6748
Telex: 3483 ELECTRON PG
ACMEMP

PERU

Cia Electro Médica 5.4,

Los Flamencos 145, San lkidre
Casilla 1030

LitgA 1

Tel: 41-4325, 41-3703

Telex: Pub. Booth 25308
CMEMFP

PHILIPPINES

The Online Advanced Systems
Catporation

Rico House, Amorsolo Cor, Herrera
Streat

Legaspi Village, Makati

P.O. Box 1510

Melrc MARILA

Tel: 85-35-81, 85-34-91, 85-32-21
Telex: 3274 ONLINE

ACHESEM

Ejectronic Specialists and Proponenis
Ine.

890-8 Epifanio de los Santos Avenue
Cubao, QUEZON CITY

P.O. Box 2649 Manila

Tel: 58-86-81, 98-96-82, 98-96-83
Telex; 40018, 42060 ITT GLOBE
MACKAY BOOTH

P

PORTUGAL

Munidinter

Intercambio Mundlial de Comércio
SARL.

P.0. Box 2761

Av. Anlonio Augusto de Agular 138
P-LISBON

Tel: (19} 53-21-31, §3-21-37
Telex: 18681 munter p

M

Soguimica

Av. dg Liberdade, 220-2

1288 LISBOA Codex

Tel: 56 21 817273

Telex: 13316 SABASA

P

Telecira-Empresa Técnica de
Equipmentos Eléclricos S.ARL.
Rua Rodrige da Fonseca 103
F.0. Box 2531

P-LISBON 1

Tel: {18} 68-60-72

Telex: 12598

CHESEP

PUERTO RICO
Hewlett-Packard Pueric Rico
Ave. Mufioz Rivera #101
Esq. Calle Ochoa

HATO REY, Puerto Rico 00918
Tei: (809) 754-7800

Hewlett-Packard Puerto Rico
Cafle 272 Edificio 203

Urb. Country Club

RIQ PIEEDRAS, Puertc Rico

P.G. Box 4407

CAROLINA, Puerto Rico 00628
Tel: (BO9) 782-7255
ACHCS

QATAR
Computearbia

P.0. Box 2750
DOHA

Tel: 883555

Telox: 4806 CHPARB
F

Eastern Technical Services
P.0.Box 4747

DOKA

Tel: 329 693

Telex: 4158 EASTEC DH

Nasser Trading & Contracling
FP.0.Box 1563

DOHA

Tel: 22176, 23589

Telox: 4439 NASSER DH

M

SAUDI ARABIA
Modern Flectronic Establishment
Hewlelt-Packard Division
P.0. Box 22015

Thuobah

AL-KHOBAR

Tel: 895-1760, 895-1764
Telex: 671 106 HPMEEK 54
Cable: ELECTA AL-KHOBAR
CHEOSEM

Modern Efgctronic Establishment
Hewleit-Packard Divisioh
RO, Box 1228

Redec Plazs, 6ith Fioor
JEDDAH

Tel: 644 38 48

Telex: 4027 12 FARNAS SJ
Cable: ELECTA JEDDAH
CHOS.EM

Modern Flecironic Establishment
Hewlett-Packard Division
F.0.Box 22015

RIYADH

Tel: 491-97 15, 461-63 87
Telex: 202049 MEERYD SJ
CHCSEM

Abdid Ghani El Aoy

P.O. Box 78

RIYADH

Tel: 4041717

Telex: 200 832 FL AJOU
F

SCOTLAND
See United Kingdom

SINGAPORE

Hewlett-Packard Singapore {Sales)
Pie. Ltd.

#08-00 Inchcape House

450-2 Alexandra Road

£.0, Box 58 Alexandra Rd. Post Cifice
SINGAPORE, 9115

Tel: 631788

Telex: HPSGSO RS 34208

Gable: HEWPACK, Singapore
ACHCS.EMS P
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SALES & SUPPORT OFFICES

Arranged alphabetically by country

SINGAPORE (Cont’d)
Dynamar internationai Lid.
Unit 05-11 Block 6

Kolam Ayer Industriagl Estale
SINGAPORE 1334

Tel: 7476188

Telex: RS 26283

oM

SOUTH AFRICA

Hewiett-Packard So Africa (Pty.) Lid.

P.0. Box 120

Howard Place CAPE PROVINCE 7450
Pine Park Center, Forest Drive,
Pinefands

CAPE PROVINCE 7405

Tel: 53-7954

Telex: 57-20006

ACH,.CM.EMS,P

Hewlelt-Packard So Africa (Pty.) Lid.

P.0. Box 37089

92 Overport Drive

DURBAN 4067

Tel: 28-4178, 28-4179, 28-4110
Telex: 6-22654

CH,CM

Hewlett-Packard So Afriga (Ply.) Lid.

6 Linjon Arcade

511 Cape Road
Linton Grange

PORY ELIZABETH 6000
Tel: 041-302148

CH

Hewleti-Packard So Africa (Fly.) Lid.

P.0.Box 32345

Glenstantia 0010 TRANSYAAL
1sl Floor East

Conslania Park Ridge Shopping
Centre

Constantia Park

PRETORIA

Tel: 982043

Telex; 32163

CHE

Hewlett-Packard So Africa (Piy.) Lid.

Private Bag Wendywood
SANDTON 2144

Tel: 802-5111, 802-5125
Telex: 4-20877

Cabie: HEWPACK Johannesburg
ACH.CM,CS EMS,F

SPAIN

Hewleti-Packard Espaficla S.A.
Calle Entenza, 321
E-BARCELONA 29

Tel: 322.24.51, 321.73.54
Telex: 52603 hpbee
A,CHCSEMSP
Hewlett-Packard Espafiola S.A.
Calle San Vicenie S/No

Edificio Atbia K

E-BH.BAQ 1

Tel: 423.83.08

A CHEMS

Hewleti-Packard Espafiola S.A.
Cria. de fa Corufia, Km, 16, 400
Las Rozas

E-MADRID

Tet {1} 637.00.11

CH,CS.M

Hewlell-Packard Espafiola S.A.
Avda. 8. Francisco Javier, S/no
Piarda 10. Edificio Sevilla 2,
E-SEVILLA &

Tei: 64.44.54

Telex: 72933

ACSMS P

Hewletl-Packarg Espafiola S.A.
Caile Ramon Gordito, 1 (Entlo.3}
E-VALENCIA 10

Tel: 361-1354

CH,P

SWEDERN

Hewlett-Packard Sverige AB
Sunnanvagen 14K

S-22226 LUND

Tel: (046) 13-69-79

Telex: (854} 17886 (via Spénga
office)

CH

Hewlett-Packard Sverige AB
Ostra Tultgatan 3

S-21128 MALMO

Tek: (040) 70270

Telex: (854} 17886 (via Spdnga
office)

Hewlett-Packard Sverige AB
Vastra Vinlergatan 9

§-70344 QREBRO

Tel: (18) 10-48-80

Telex: (854} 178886 {via Spanga
office)

CH

Hewlett-Packard Sverige AB
Skatholisgatan 9, Kista

Box 1§

516393 SPANGA

Tel: (08) 750-2000

Telex: {B54) 17888

Telefax: (08} 7527781
ACHCMCSEMSP
Hewlelt-Packard Sverige AB
Fritafisgatan 30
S-42132 VASTRA-FROLUNDA
Tel: {031} 49-09-50

Telex: (854} 17886 (via Spanga
office)

CHEP

SWITZERLAND
Hewlell-Packard (Schwelz} AG
Ciaraslrasse 12

GH-4058 BASEL

Teh: (81) 33-59-20

A

Hewleli-Packard {Schweiz) AG
7, rue du Bois-cu-Lan

Case Postale 365

CH-1217 MEYRIN 2

Tel: (9041) 22-83-11-11
Telex:27333 HPAG CH
CH.CM,CS

Hewlell-Packard (Schweiz)} AG
Allmend 2

CH-8967 WIDEN

Tel: (0041) 57T 3121 11
Telex: 53933 hpag ch

Cable: HPAG CH
ACH.CM,CS.E MS,P

SYRIA

General Fleclronic Inc.

Nuri Basha Afinaf Ebn Kays Street
P.0. Box 5781

DAMASCUS

Tei: 33-24-87

Telex: 411 215

Cable: ELECTROBOR DAMASCLS
E

Middie East Electronics
P.0.Box 2308

Abu Rumnaneh
DAMASCUS

Tel- 334582

Telex: 4171 304

M

TAIWARN

Hewlett-Packard Far Easi Lid.
Kaahsiung Office

2/F 68-2, Chung Cheng 3rd Read
KAOHSIUNG

Tel: (07} 241-2318

CHCSE

Hewlelt-Packard Far £ast Lid.
Taiwan Branch

8th Floor

337 Fu Hsing North Road
TAIPEt

Tel: (02) 712-0404

Telex: 24439 EEWPACK
{able:HEWPACK Taipei
ACH,CM,CS.EMP

ing Lih Trading Co.

3rd Floor, 7 Jen-Ai Road, Sec. 2
TAIPET 100

Tel (02) 3948191

Cable: INGLIF TAIPE!

A

THAILAND

Unimesa

30 Paipong Ave., Suriwong
BANGKOK 5

Tel: 235-5727

Telex: 84439 Simonco TH
Cable: UNIMESA Bangkok
ACHCSEM

Bangkok Business Equipment Lid.
5/5-8 Dejo Road

BANGKOK

Tel: 234-8670, 234-8671
Telex: 87668-BEQUIPT TH
Cable: BUSIQUIPT Bangkok
P

TRINIDAD & TOBAGO
Caribbean Telecoms Lid.
S0/4 Jerningham Avenue

P.O. Box 732
PORT-OF-SPAIN

Tel: 62.44213, 62-44214
Telex: 235,272 MUGCO WG
CMEMP

TUNISIA

Tunisie Electronigue

31 Avenue de la Liberte
TUNIS

Tel: 280- 144

EP

Corema

1 ter. Av. de Carthage
TUNIS

Tel: 253-821

Telex: 12319 CABAM TN
M

TURKEY

Teknim Company LI,
Iran Caddesi No. 7
Kavaklidere, ANKARA
Tel: 275800

Telex: 42155 TKNM TR
E

EMA

Medina Eldem Sokak No.41/6
Yuksel Caddesi

ANKARA

Tel: 175 622

Telex: 42 591

M

UNITED ARAB EMIRATES
Emitac Lid.

£O. Box 2711

ABU DHABI

Tal: 82 04 18-20

Cable: EMITAC ABUDHAB!
Emitac Lid.

F.0. Box 1641

SHARJAH

Tal: 591 181

Telex: 68136 Emitac Sh
CHCS.EMP

UNITED KINGDOM

GREAT BRITAIN
Hewlett-Packard Lid.
Trafalgar House
Navigation Road
ALTRINCHAM

Cheshire WA14 1NU

Teh 0681 928 6422

Telex: 668068
A,CH,CS.E M MS,P
Hewleft-Packard Lid.
Elstree House, Elstree Way
BOREHAMWOOD, Herts WD6 135G
Tek G1 207 5000

Tetex: 8952716
E.CHLSP
Hewlett-Packard Lid.
Cakfield House, Qakfieid Grove
Clifton BRISTOL, Avon BS8 2BN .
Tel: 0272 7368086

Telex: 444302

CHESEP
Hewlelt-Packard Lid.
Bridewell House

Brigewell Place

LONDON ECAV 6BS

Tel: 0t 583 6565

Telex: 298163

CHLSP

Hewlett-Packard Lid.
Fourier House

257-263 High Street
LONDON COLNEY

Herts. ALZ 1HA, Si. Albang
Tei: 0727 24400

Telex: 1-8952716

CHCS

Hewleti-Packard Lid.
Poniefract Road
NORMANTON, West Yorkshire WFS 1AM
Tel: 0924 835566

Telex: 557355

CH,CS,P

Hewleti-Packard Lid.

The Quadrangle

106-118 Station Roac
REDHILL, Surrey RHt 1PS
Tel: 0737 68655

Telex: 947234

CHCSEP
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GREAT BRITAIN (Cont'd)
Hewlett-Fackard Lid.
Avon House

435 Stralford Road
Shirley, SOLIHULL, West Midiands
Bu0 4BL

Tel: 021 745 8800
Telex: 339105
CHLSEP
Hewlett-Packard Lid.
West £nd House

41 High Slreet, West End
SOUTHAMPTON
Hampshire S03 30G

Tel: 04218 6767

Telex: 477138

CHLS P

Hewlett-Packard Lid.
£skdale Rd.

Winnersh, WOKINGHAM
Berkshire RG11 5DZ

Tel: (734 696622

Telex: 848884

£

Hewlet!-Packard Lid.
King Street Lane
Winnersk, WOKINGHAM
Berkshire RG11 5AR
Tel: G734 784774
Telex: 847178
ACH.C8.EMMPP
Hewleft-Packard Lid.
Nine Mile Rids
Easthampstead, WOKINGHAM
Berkshire, 3RG11 3LL
Tel: 0344 773100
Telex: 848805
CH.CSEF

IRELAND

NORTHERMN IRELAND
Hewlett-Packard Lid.
Cardiac Services Buliding
85A Finaghy Road South
BELFAST BT 10 OBY

Tel: 0232 625-565

Telex: 747626

CH,CS

SCOTLAND
Hewledt-Packard Lid.
SOUTH QUEENSFERRY
Wesi Lothian, EH30 91G
Tel: 031 331 1188
Telex: 72682
CH,CMCSEMP

UNITED STATES

Alabama
Hewielt-Packard Co.
70G Century Park South, Suite 128
BIRBINGHAM, AL 35226
Tel: (205} 822-6802
ACHM
Hewlelt-Packard Co.
42C Wynn Drive
HUKTSVILLE, AL 35805
£.0. Box 7700
HUNTSVILLE, AL 35807
Tel: (208} 830-2000
CH.CM.CSEM*

Arizona

Hewlalt-Packard Co.

8080 Pointe Parkway West
PHOENIX, AZ 85044

Tek (602) 273-8000
ACHCMCSEMS

Hewlett-Packard Co.
2424 £ast Aragon Road
TUCSON, AZ 85708
Tel: (602) 889-4631
CH.EMS""

California
Hewleti-Packard Co.

G99 South Hill .
BRISBANE, CA 84005
Tel: (415) 330-250C
CH,CS

Hewlell-Packard Co.
P.0. Box 7830 (83747)
5060 E. Clinton Avenue, Suite 102
FRESNO, CA 83727

Tet: {208) 252-9652
CH,CS,MS
Hewlett-Packard Co.
P.0. Box 4230

1430 East Orangethorpe
FULLERTON, CA 92631
Teb: {714) 870-1000
CH,Ci,CS EMP
Hewlett-Packard Co.
320 $. Kellogg, Suite B
GOLETA, CA 93117

Tel: (805) 967-3405

CH

Hewletl-Packard Co.
5400 W. Rosecrans Boulevard
LAWNDALE, CA 90260
£.0. Box 92105

LS ANGELES, CA 90009
Tek (213) 570-7500
Telex: §10-325-6608
CH,CM,C8 MP
Hewlett-Packard Co.
3155 Porter Caks Drive
PALO ALTO, CA 94304
Tel: {418} 857-8000
CHOSE :
Hewleti-Packard Co.
4244 S0, Market Cowl Sude A
P.G. Box 15978
SACRAMENTO, CA 95852
Tel: (916) 929-7222

A" CHCSEMS
Hewleli-Packard Go.
G608 Aero Drive

P.C. Box 23333

SAN DIEGO, CA 92139
Tei: (619 279-3200
CH,CM,CS.E MP
Hewlell-Packard Co.
2305 Camino Ramon “C”
SAN RAMON, CA 54583
Tel {415) 838-5800
CH,CS

Hewlelt-Packard Co.
3005 Scott Boulevard
SANTA CLARA, CA 9505C
Tek {408) 988-7000
Telex: 810-338-0586
ACH.CM,CS EMP
Hewlett-Packard Co.
5703 Corsa Avenue
WESTLAKE VILLAGE, CA 91382
Tel: {213) 706-68C0
£*,CH" CS™

Colorado
Hewlet-Packard Co.

24 Inverness Place, East
ENGLEWOQOD, GO 80112
Tel: (303) £49-5000
A,CH,CM.CS.EMS

SALES & SUPPORT OFFICES
Arranged alphabetically by country

Conneclicut
Hewlett-Packard Co.

47 Barnes industrial Road South
P.0. Box 5007

WALLINGFORD, CT 06492

Tek (203) 265-7801
A,CH.CM,CS.EMS

Florida

Hewlett-Packard Co.

2001 NW. 62nd Street

P.O. Box 24210

FORT LAUDERDALE, FL 33307
Tel; {305} 973-2600
CH.CSEMP

Hewlett-Packard Co.

6177 Lake Ellenor Drive

P.O. Box 13919

ORLANDO, FL 32859

Tel: (305} 859-2800
ACH.CM,CS EMS
Hewleff-Packard Ce,

5750B N. Hoover Blvd., Suite 123
P.0. Box 18200

TAMPA, FL 33614

Tek (813) 884-3282

A* CH,CM,CSE* M~

Georgia
Hewleti-Packard Co,
2000 South Park Place
P.0. Box 105005
ATLANTA, GA 30348
Tel: (404) 955-1500
Telex: 810-766-4890
AGH,CM,CS E MP

Hawall

Hewilelt-Packard Co,
Kawalahao Plaza, Suile 180
567 South King Street
HGNOLULY, Hi 96813

Tel; (B0B) 526-1555
A,CH,E.MS

liHinois

Hewlett-Packard Co.

304 Eldorade Road

P.0. Box 16807
BLOOMINGTON, £ 617¢1
Tel: {309) 662-0411
CHMS" "

Hewleti-Packard Co.

1100 31st Streed, Suite 160
BOWNKERS GROVE, IL 80515
Tel: {312) 960-5760

CHCS

Hewletl-Packard Co.

5201 Tollview Drive
ROLLING MEADOWS, I 80008
Tel: (312} 255-9800

Telex: $10-687-1066
A,CH,CM,CS E MP

Indiana

Hewlett-Packard Go.

7301 No. Shadeland Avenue
2.0, Box 50807
INDIANAPOLES, IN 46250
Tel: (317) 842-100C
A,CH,CM,C5.E MS

fowa

Hewigti-Packard Co.

1776 22nd Street, Sufte 1
WESY DES MOINES, 1A 50265
Tel: (515} 224-1435

CH M3

Kansas

Hewlet!-Packard Co.

7804 Easi Funston Road, #203
WICHITA, KS 67207

Tel: (316) 684-8491

CH

Kentucky

Hewlett-Packard Co.

16309 Linn Station Road, #1900
LOBISVILLE, KY 46223

Tel: (502) 426-0100
ACH.CS MS

Louisiana
Hewletl-Packard Co.
160 James Drive East
ST, ROSE, LA 70087
£.0. Box 1449
KENNER, LA 70063
Tel: (504) 467-4100
ACH.CSEMS

Maryland
Hewletl-Packard Co.
3701 Koppers Street
BALTIMORE, MD 21227
Tel: (301) 644-5800
Telex: 710-862-1943
A,CH,OM,CSEMS
Hewleit-Packard Co.

2 Choke Cherry Road
ROCKVILLE, ME} 20850
Tel: (301) 948-6370
A,CH,CM,CS.E MP

Massachuseiis
Hewleti-Packard Co.
1775 sinuteman Roag
ANDOVER, MA 01810
Tek {617) 862-1500
ACCHCS,CMEMP P
Hewlett-Packard Co.
32 Hartwell Avenue
LEXINGTON, MA 02173
Tek: {617 861-8860
CHCSE

Michigan
Hewlelt-Packard Co.
4326 Cascade Road S.E.
GRAND RAPIDS, Mi 49506
Tel: (618) 957-1470
CH,CS MS
Hewlett-Packard Co.
1771 W. Big Beaver Road
TROY, Mi 48084

Tel: (313) 643-6474
CH,CS

Minnesota
Hewleit-Packard Co.
2025 W. Larpentewr Ave.
ST. PAUL, MN 55113
Tel: (812} 644-1100
ACHOM,CSEMP

Missouri
Hewiett-Packard Co.
11131 Colorado Avenue
KANSAS CITY, MO 64137
Tet: {818) 763-8000
ACH,CM,CS E,MS
Hewlett-Packard Co.
13001 Hollenberg Drive
BRIDGETON, MO 63044
Tel: (314) 344-5100
A,CH.CS,E MP
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SALES & SUPPORT OFFICES

Arranged alphabetically by country

UNITED STATES ({Cont'd)

Nabraska
Hewlet!-Packard

10824 Oid Mill Rd., Suite 3
OMAHA, NE 68154

Tel: (402) 334-1813
ChEMS

Mew Jersey
Hewlell-Packard Co.
120 W. Century Road
PARAMUS, N 07652
Tel: {201) 268-5000
A,CH,CM,CS.E.MP
Hewlett-Packard Co.

60 New England Av. West
PISCATAWAY, NJ 0B854
Tel: {201) 681-1189
ACHCM,CS.E

Mew Mexico
Hewlefi-Packard Co.
11300 Lomas Bivd. M.E.
P.O. Box 11634
ALBUQUERQUE, NM 87112
Tel: (508} 292-1330
CH,CSEMS

New York
Hewlett-Packar¢ Co.

5 Computer Drive South
ALBANY, NY 12205

Tel: {518) 458- 1550
ACHEMS
Hewleit-Packard Co.
9600 Main Street

P.0. Box AC

CLARENCE, NY 14031
Tel: {(716) 759-8621

CH

Hewlet-Packard Co.
200 Cross Keys Office Park
FAIRPORY, NY 14450
Tel: (716) 223-9850
CH,CM,CS,EMS
Hewleft-Packard Co.
7841 Henry Clay Bivd.
LIVERPOOL, NY 13088
Tel: {315) 451-1820
ACH.CME MS
Hewlelt-Packard Co.

Ne. 1 Pennsylvania Plaza
55th Floor

34th Street & Bth Avenue
MANHATTAN NY 10119
Tek: (212) 971-0800
CHCSE* M*
Hewleti-Packard Co.
250 Westchester Avenue
WHITE PLAINS, NY 10604
Tek {914) 684-6100
CM,CH.CS E
Hewleit-Packard Co.

3 Crossways Park West
WOODBURY, NY 11797
Tel: (516) 921-0300
ACHCM.CSEMS

North Carolina
Hewlett-Packard Go.
5605 Roanne Way

£.0. Box 26600
GREENSBORO, NC 27420
Tel: (919) 852-1800

A CH,CM,CS EMS

GChio
Hewlett-Packard Co.
9920 Carver Road
CINCINNATI, OH 45242
Tel: (513) 891-9870
CH,CS,M8
Hewlelt-Packard Ca.
16500 Sprague Road
CLEVELAND, OH 44130
Tel: {216) 243-7300
ACH.CM,CSEMS
Hewlett-Packard Co.
962 Crupper Ave,
COLUMBYS, OH 43229
Tel: {614} 436-1041
Lif: Noy. 25, 1983
675 Brooksedge Bivd.
WESTERVILLE, OH 43081
CH,CM,CS E”
Hewlett-Packard Co.
330 Progress Rd,
DAYTON, OH 45449
Tei: (513) 858-8202
A,CH.CM.E* MS

Oklahoma
Hewletl-Packard Co,

304 K. Meridian, Suite A
P.0. Box 75609
OKLAHOMA CITY, 0K 73147
Tel: {405) 946-8488

A* CHE® MS
Hewlett-Packard Co.

3840 8. 103rg £, Avenue, #100
P.C. Box 35747

TULSA, OK 74153

Tel: {918) 665-3300

A*® CHCSM*

Oregon
Hewlelt-Packard Co.
9255 5. W. Pioneer Court
2.0, Box 328
WILSONVILLE, CR 97070
Tel: {503) 682-8000
ACHCSE" MS

Pennsylvania
Hewlelt-Packard Co.
111 Zeta Drive
PITTSBURGH, PA 15238
Tel: {412} 782-0400
ACHCS,EMP
Hewleit-Packard Co.
2750 Monroe Bodlevard
P.O. Box 713

VALLEY FORGE, PA 19482
Tel: (2185) 666-9000
A,CH,CM.EM

South Carolina
Hewie#l-Packard Co.
Brookside Park, Suite 122
1 Harbison Way

P.C. Box 21708
COLUMBIA, SC 29221

Tel: (803) 732-04G0
CHLEMS

Hewlett-Packard Co.
Koger Executive Center
Chesterfield Bidg., Suite 124
GREENVILLE, SC 29815
Tel: {8C3) 297-4120

Tennessee
Hewlelt-Packard So.

224 Pelers Road, Suite 102
P.0. Box 22480
KNOXVILLE, TN 37922

Tek (615) 691-2371
A*.CHMS

Hewlett-Packard Co.
307G Directors Row
MEMPHIS, TN 38131
Tet: {801) 346-8370
A,CHMS

Texas
Hewlatt-Packard Co.
4171 North Mesa

Suite C-110

EL PASO, TX 79802

Tel: (915) 533-3555
CHE" MS*™
Hewlett-Packard Co.
10535 Harwin Drive
P.0. Box 42818
HOUSTON, TX 77042
Tel. {713) 776-8400
ACH,CM,CS.E uiP
Hewlelt-Packard Co.
930 £, Campbell Rd.
P.0. Box 1270
RICHARDSON, TX 75080
Tel: (214) 2316101
ACHCMCS.ENMP
Hewlett-Packard Co.
1026 Ceniral Parkway South
P.0. Box 32993

SAN ANTOMIO, TX 78216
Tel: {512) 494-5336
CH.CS,E.MS

Utah

Hewlett-Packarg Co.

3530 W. 2100 South
SALT LAKE CITY, UT 84119
Tek (801} 974-17C0
A,CH,CS,EMS

Virginia
Hewiell-Packard Co.
4305 Cox Road

GLEM ALLEN, VA 23060
P.G. Box 9668
RICHMOND, VA 23228
Tel: (804} 747-7750
ACHCSEMS

Washington
Hewlelt-Packard Co.
15815 S.E. 3Tth Street
BELLEVUE, WA 98006
Tel: (206) 643-4000
A,CH,CM,CS.EMP
Hewlelt-Packard Co.
Suite A

708 North Argenne Road
SPOKANE, WA 99212
Tel: {509) §22-7000
CH.CS

West Virginia
Hewiett-Packard Co.
4604 MacCorkle Ave.
P.0. Box 4297
CHARLESTON, WY 25304
Tel: {304) 925-0492
AMS

Wisconsin
Hewleit-Packard Co.

150 S. Sunny Siope Road
BROOKFIELD, Wi 53005
Tel: (414) 784-8800
ACHCSE" MP

URUGUAY

Pablo Ferrande 8A.C. e,
Avenida flakia 2877
Casilia de Correo 370
MONTEVIDEG

Tel: 80-2586

Telex: Public Booth 801
A CMEM

VENEZUELA

Hewleti-Packard de Venezuela C.A.
3BA Transversal Los Ruices Norle
Edificio Segre 1,2 & 3

Apartade 50833

CARACAS 1071

Tel: 238-4133

Telex: 251046 HEWPACK
ACH.CS.EMBP

Hewlett-Packard de Venezuela C.A.
Cafle-72-Enire 3H y 3Y, No. 3H-40
Edificio Ada-Evelyn, Local B
Apartado 2646 .

4001, MARACAIBD, Estade Zulia
Tet: {061} 80.304

CE"

Hewlatt-Packard de Venezuela C.A.
Calle Yargas Rordon

Edificio Seguros Carabobe, Piso 10
VALENCIA

Tel: (041) 51 385

CH.CS,P

Binelecironica Medica C.A.

Calle Buen Pastor

Edit. Cola Mil-Piso 2 y Semj Solano 1
Boleita Norlg

Apartado 507 10 CARACAS 10504
Tel: 239 84 41

Telex: 26518

ZIMBABWE

Field Technical Sales
45 Kelvin Road, North
P.B. 3458
SALISBURY

Tel: 705 231

Telex: 4-122 RH
CEMP

July 1883
Indicates main office
HFP distribuiors are printed In Halics,

5852-6900
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